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2.3 Délka a změna délky vektoru . . . . . . . . . . . . . . . . . . . . . . . . 19
2.4 Faktory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

3 Matice a pole 23
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4 Datové tabulky a seznamy 35
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Úvod

R je volně dostupný jazyk použ́ıvaný zejména v akademické a vědecké sféře. Jedná se
o prostřed́ı pro statistickou analýzu dat a jejich grafické zobrazeńı. Standardńı distri-
buce R obsahuje množstv́ı funkćı pro manipulaci s daty, výpočty a grafické výstupy,
široká škála daľśıch funkćı je součást́ı mnoha podp̊urných baĺıčk̊u. Jedná se o progra-
movaćı prostřed́ı umožňuj́ıćı definovat rovněž své vlastńı funkce a skripty.
Bezesporným kladem jazyka R je jeho grafika. Ta je založena na systému high-level
a low-level funkćı, jejichž vhodnou kombinaćı může uživatel dosáhnout grafického
výstupu přesně dle své představy.

Následuj́ıćı studijńı text seznamuje studenty se syntax́ı jazyka R, jeho datovými struk-
turami, funkcemi pro tvorbu grafiky stejně jako se základy programováńı. Text je do-
plněn o množstv́ı jak ukázkových př́ıklad̊u, tak př́ıklad̊u určených pro samostatné řešeńı
a je vytvořen pro práci v prostřed́ı klasické př́ıkazové řádky jazyka R. V současné době
je ovšem možnost využ́ıt r̊uzných nadstaveb a uživatelsky př́ıvětivěǰśıho prostřed́ı, např.
RStudio, RKWard apod.
Program je volně dostupný na webových stránkách projektu (http://www.r-project.
org, [19]), kde jsou k dispozici i podrobné manuály ([17], [10]) a online nápověda.
Srozumitelným a velmi přehledně zpracovaným materiálem s množstv́ım názorných
př́ıklad̊u a doplňkových otázek je skriptum P. Drozd: Cvičeńı z biostatistiky [3], z an-
glické literatury stoj́ı za zmı́nku studijńı materiály Theresy A. Scott [11], [12], [13],
[14]. Velmi př́ınosné jsou dokumenty srovnávaj́ıćı př́ıkazy v R s ekvivalentńımi př́ıkazy
v MATLABu [5], [4].

Někdy se syntaxe či chováńı R a MATLABu výrazně lǐśı. V těchto př́ıpadech
je v textu na tyto odlǐsnosti upozorněno a pro zvýrazněńı a snadněǰśı orientaci
je na okraj́ıch stránek použita ikonka MATLABu [20].

Kateřina Konečná, Jan Koláček

http://www.r-project.org
http://www.r-project.org
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Kapitola 1

Prvńı setkáńı s jazykem R

Základńı informace

R je volně šǐritelný programovaćı jazyk, který umožňuje špičkové zpracováńı dat včetně
grafických výstup̊u. Jeho široké spektrum využit́ı zahrnuje možnost doplněńı základńıch
funkćı ohromným množstv́ım baĺıčk̊u s funkcemi pro r̊uzné typy analýz.
V této kapitole poṕı̌seme, jak prostřed́ı R vypadá, nauč́ıme se zde orientovat, zaměř́ıme
se na základńı syntaxi a pravidla pro práci s proměnnými a funkcemi. Ćılem neńı znát
všechny argumenty funkćı zpaměti, ale dobře jim porozumět a vědět, kde tyto informace
naj́ıt. Důležitou součást́ı kapitoly je proto naučit se pracovat s nápovědńım systémem
jazyka, popř. vědět, kde naj́ıt podrobněǰśı manuály vhodné zejména pro začátečńıky.
Jazyk R pracuje nad datovými strukturami - těm nejčastěji použ́ıvaným je stručně
věnována posledńı část kapitoly.

Výstupy z výuky

Studenti

• se seznámı́ s prostřed́ım jazyka R a jeho základńımi př́ıkazy,

• umı́ využ́ıvat nápovědńıho systému,

• se orientuj́ı v pracovńım prostoru a př́ıkazech s ńım spjatých,

• rozlǐsuj́ı datové typy objekt̊u, dokáž́ı popsat jednotlivé datové struktury.
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1.1 Základńı ovládáńı

R je volně dostupný programovaćı jazyk a softwarové prostřed́ı pro statistické výpočty
a grafiku, který je možný provozovat na operačńıch systémech UNIX, Windows i Ma-
cOS. R je skutečně

”
jen“ programovaćı jazyk - žádné grafické rozhrańı, které by se

dalo ovládat myš́ı, zde neńı. Pro grafické rozhrańı (GUI) je potřeba vyzkoušet některé
grafické nástavby (Poor Man’s GUI, Rcommander, . . . ). Program lze źıskat z webových
stránek projektu (http://www.r-project.org, [19]).

Po spuštěńı programu se objev́ı okno s konzolou (R console), ve kterém se daj́ı
spouštět funkce, vkládaj́ı se objekty, provád́ı se výpočty a zobrazuj́ı se i základńı
výstupy. Dále se můžeme setkat i s daľśımi typy oken:

• okno nápovědy - volá se po zadáńı př́ıkazu help()

• grafické okno - při spuštěńı grafické prezentace

• editor programu - zobraźıme ho v menu File → New Script. Toto okno je
určeno k tvorbě programů. (U deľśıch zdrojových kód̊u je výhodné mı́t k dispozici
editor s č́ıslovanými řádky, kontrolu syntaxe R a závorek - jako freeware PSPad,
http://www.pspad.com , nebo shareware WinEdt, http://www.winedt.cz )

To, že je konzole připravena k použ́ıváńı, symbolizuje prompt >, za ńımž následuj́ı
jednotlivé př́ıkazy. Pokud nezměńıme základńı nastaveńı, řádky, do nichž vepisujeme
př́ıkazy, jsou odlǐseny červenou barvou. Výstupńı řádek je psán modrým ṕısmem,
v př́ıpadě hodnot zač́ıná pořadovým č́ıslem dané hodnoty. Př́ıkaz v konzole spust́ıme
klávesou ENTER. Takto provedený př́ıkaz nelze opravit př́ımo, ale v již napsaných
př́ıkazech můžeme listovat pomoćı kláves ↑ ↓ , jež umožňuj́ı pohyb v historii př́ıkaz̊u.
Historii př́ıkaz̊u můžeme uložit v menu File → Save History. Konzole se všemi př́ıkazy
může být uložena v menu File → Save to File . . . .

Jednotlivé př́ıkazy jsou vkládány na nový řádek, v př́ıpadě v́ıce př́ıkaz̊u za se-
bou jsou navzájem oddělovány středńıkem. Složitěǰśı př́ıkazy, které maj́ı být spuštěny
bezprostředně po sobě, jsou seskupovány pomoćı složených závorek. Každý př́ıkaz je
následován kulatými závorkami s argumenty v př́ıpadě, že jsou požadovány. Argumenty
lze uvádět ve stejném pořad́ı, v jakém byly definovány, nebo je možno je uvádět v libo-
volném pořad́ı ve tvaru nazev.argumentu=hodnota. Argumenty je často možné zkra-
covat (jestliže zkratka nemůže znamenat jiný argument), např. round(x, digits=2)

má naprosto stejný význam jako round(x, d=2) (jedná se o funkci zaokrouhleńı na 2
desetinná mı́sta).

Př́ıkazem <- (popř. =, ten se ovšem nedoporučuje) vlož́ıme daný výraz do proměnné.
K jej́ımu zobrazeńı muśı být v konzole z př́ıkazové řádky zavolán jeho název. Daľśı
možnost́ı je zadáńı celého př́ıkazu do kulatých závorek.

6

http://www.r-project.org
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http://www.winedt.cz
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> a <- 2

> a

[1] 2

> (a <- 2)

[1] 2

Pro neúplné př́ıkazy se na následuj́ıćım řádku objev́ı prompt + , který dává možnost
dodat chyběj́ıćı část př́ıkazu, a pokračuje dál ve čteńı.

> a <- (2+3

> + ) * 5

[1] 25

Symbol # na př́ıkazové řádce zp̊usob́ı ignoraci zbytku řádky (komentář).

> a <- 2 # komentar

> a

[1] 2

Při zadáváńı názvu jednotlivých proměnných či objekt̊u bychom měli dodržovat
určitá pravidla. Názvy se mohou skládat z ṕısmen (a–z, A–Z), č́ıslic (0–9), tečky a
podtrž́ıtka. Název muśı zač́ınat ṕısmenem, nesmı́ zač́ınat č́ıslićı, tečka rovněž neńı do-
poručována. Matematické operátory (+, -, *, /), mezera a jiné daľśı speciálńı znaky
také nejsou povoleny. Chceme-li použ́ıt v́ıceslovný název, rozděleńı názvu na dvě části se
provád́ı pomoćı tečky (např. pr̊uměrnou výšku chlapc̊u můžeme nazvat chlapci.prumer),
popř. pomoćı podtrž́ıtka (chlapci prumer). Rovněž bychom se měli vyvarovat použ́ıváńı
názv̊u vestavěných proměnných. R je case sensitive, tzn. rozlǐsuje malá a velká ṕısmena.

> a <- 2

> a

[1] 2

> A

Error: object ’A’ not found

Běž́ıćı program může být zastaven klávesou ESC ve Windows, CTRL + C v Linuxu.
Konzoli můžeme vymazat klávesovou zkratkou CTRL + L nebo v menu Edit → Clear
Console.

Pro ukončeńı programu se použ́ıvá př́ıkaz q().

1.2 Nápověda

Př́ıkazem help() je vyvoláno daľśı okno – okno nápovědy. V levé části můžeme naj́ıt
abecedně seřazený seznam objekt̊u, poklikáńım na některý z nich se v hlavńım okně
zobraźı popis objektu. Pro zobrazeńı nápovědy ke konkrétńım objekt̊um či funkćım
slouž́ı př́ıkaz help(tema), alternativou může být rovněž ?tema nebo v menu Help→ R-

7
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functions (text) . . . . Chceme-li znát argumenty př́ıkazu, můžeme použ́ıt funkci
args(nazev funkce).

Pro vyhledáváńı témat v kontextu (tzn. ne pouze v názvech a zkrácených popi-
sech funkćı a objekt̊u, ale i v kĺıčových slovech) slouž́ı př́ıkaz help.search("tema"),
v menu Help → Search Help nebo v okně nápovědy pod záložkou Vyhledávat.
Př́ıkazem apropos("nazev") zobraźıme př́ıbuzné př́ıkazy k př́ıkazu nazev, pro př́ıklady
k nějakému tématu použijeme př́ıkaz example(tema).

K dispozici jsou rovněž PDF manuály, které obsahuj́ı základńı manuály a refe-
rence o funkćıch. Spoušt́ı se přes menu Help → Manuals (in PDF). HTML nápovědu,
obsahuj́ıćı manuály, seznamy funkćı, apod. zobraźıme př́ıkazem help.start() nebo
přes menu Help → Html help.

Jazyk R nab́ıźı i několik funkćı, které uživatel̊um usnadňuj́ı pochopeńı některých
př́ıkaz̊u. Funkce demo je uživatelsky př́ıznivé prostřed́ı, ve kterém běž́ı demonstrace
(ukázkové programy) R skript̊u. Př́ıkaz demo() vyṕı̌se seznam všech dostupných de-
monstraćı. Argumenty funkce demo:
topic téma, které má být demonstrováno
package název baĺıčku, ze kterého má být spuštěno topic

> demo(persp) v novém okně spust́ı ukázky použit́ı funkce persp

V MATLABu je analogickým př́ıkazem funkćı help(funkce) a ?funkce př́ıkaz
help funkce.

1.3 Workspace (pracovńı prostor)

Program R nač́ıtá data z jakéhokoliv adresáře. Nejjednodušš́ı pro manipulaci s nimi je
ukládat si data do tzv. pracovńıho adresáře (workspace). Chceme-li zjistit, ve kterém
adresáři se právě nacháźıme, použijeme př́ıkaz getwd(). Ten zobraźı kompletńı cestu
do aktuálńı složky. Pro změnu pracovńıho adresáře použijeme př́ıkaz setwd(), jehož
argumentem je cesta k adresáři v jednoduchých apostofech (’) nebo uvozovkách (”).
Změna adresáře je rovněž možná přes menu File → Change dir . . . .

> (setwd("C:/Documents and Settings/PC/Plocha/R")) nastav́ı za pracovńı ad-
resář složku R umı́stěnou na ploše a vyṕı̌se cestu složky, ze které jsme vycházeli.
[1] "C:/Documents and Settings/PC/Dokumenty"

O tom, že se opravdu nacháźıme v adresáři R, se můžeme přesvědčit př́ıkazem

8
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> getwd()

[1] "C:/Documents and Settings/PC/Plocha/R"

Př́ıkazy dir() nebo list.files() zobraźıme názvy soubor̊u v aktuálńım nebo za-
daném adresáři.

> dir() výpis soubor̊u v aktuálńım adresáři
[1] "cviceni" "prednasky" "data"

> dir("C:/Documents and Settings/PC/Plocha/R/cviceni")

[1] "cviceni 1" "cviceni 2" "cviceni 3" "cviceni 4"

[5] "cviceni 5" "cviceni 6"

> list.files("C:/Documents and Settings/PC/Plocha/R/cviceni")

[1] "cviceni 1" "cviceni 2" "cviceni 3" "cviceni 4"

[5] "cviceni 5" "cviceni 6"

Všechny objekty, které v pr̊uběhu práce vytvoř́ıme, se ukládaj́ı do paměti a můžeme
s nimi kdykoliv manipulovat. Vytvořené objekty tvoř́ı tzv. workspace (pracovńı pro-
stor), chceme-li je uchovat pro pozděǰśı práci, celý workspace ulož́ıme pomoćı File →
→ Save Workspace . . . . T́ımto zp̊usobem vytvoř́ıme soubor s koncovkou .R, který se
při daľśım spuštěńı ze stejného adresáře automaticky nahraje spolu s historíı př́ıkaz̊u.
V př́ıpadě, že zavřeme program R bez uložeńı, při daľśım spuštěńı už dř́ıve definované
objekty nejsou k dispozici. Vı́ce o ukládáńı jednotlivých objekt̊u viz odstavec 6.2.

Daľśı užitečné př́ıkazy:
objects(), ls() vyṕı̌se všechny názvy objekt̊u, které jsou momentálně definovány
v aktuálńım adresáři
ls(name, pattern, all.names=T) vyṕı̌se ty objekty, které jsou omezeny volitelnými
parametry:

name výpis konkrétńıho objektu podle č́ısla nebo názvu prostřed́ı
pattern vyhledávaćı výraz (např. objekty zač́ınaj́ıćı na ”a”)
all.names nastavený na hodnotu TRUE vyhledává také objekty zač́ınaj́ıćı tečkou

rm() maže vybrané objekty
rm(list=ls()) maže všechny objekty

> ls(pattern="v")

[1] "v" "vec" "vector"

> ls(pattern="v", all.names=T)

[1] ".vec" "v" "vec" "vector"

> rm(v,vec) př́ıkaz analogický př́ıkazu rm(list=c("v","vec"))

> ls()

[1] ".vec" "vector"

9
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1.4 Datové typy objekt̊u

Jazyk R použ́ıvá následuj́ıćı datové typy:

• numerické hodnoty vypisujeme klasickým zp̊usobem, k odděleńı desetinných mı́st
použ́ıváme desetinnou tečku, tzn.

> 1.234

• komplexńı - numerická hodnota je doplněna o komplexńı jednotku i, např.

> 1 + 2i

[1] 1 + 2i

> 3 + 1i Pozor! Komplexńı jednotka muśı být vždy doplněna o numerickou
hodnotu
[1] 3 + 1i

> 3 + i

Error: object ’i’ not found

• logické hodnoty - hodnoty TRUE, T a FALSE, F (Pozor! Jazyk R je citlivý na velká a
malá ṕısmena, proto logické hodnoty nelze psát jinak než uvedeným zp̊usobem.)
Logické hodnoty se použ́ıvaj́ı pro některé argumenty funkćı, jsou výsledkem tes-
továńı výraz̊u, např.

> 2.3 > 3

[1] FALSE

• řetězec - použ́ıvá se pro textové hodnoty, pro popisky os, název grafu, . . . . Řetězec
muśı být zadán do jednoduchých apostrof̊u (’) nebo dvojitých uvozovek (”):

> r <- "retezec"

[1] "retezec"

> r <- ’retezec’

[1] "retezec"

K dispozici jsou rovněž speciálńı hodnota NA (”Not Available”), která reprezentuje
chyběj́ıćı nebo neznámou hodnotu, a daľśı speciálńı konstanty: NULL, odpov́ıdaj́ıćı
prázdnému objektu, Inf, odpov́ıdaj́ıćı nekonečnu (např. 1/0) a NaN (”Not-a-Number”),
která je výsledkem numerických výpočt̊u, jež nejsou definovány (např. 0/0 nebo Inf -
Inf).

1.5 Datové struktury

Vedle datových typ̊u objekt̊u, jazyk R poskytuje i množstv́ı datových struktur, které
umožňuj́ı v́ıcero hodnot specifikovat jako samostatný objekt. Mezi základńı datové
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struktury patř́ı vektor, faktor, matice, pole, tabulka dat a seznam. V následuj́ıćıch
kapitolách se dozv́ıme, jak jednotlivé datové objekty definujeme, jak s nimi pracujeme.
Protože každý objekt má svá specifika, následuj́ıćı tabulka souhrnně uvád́ı základńı
datové struktury a odpov́ıdaj́ıćı datové typy, kterými mohou být tvořeny.

datová struktura datový typ možnost v́ıce
typ̊u dat
současně

vektor numerický, komplexńı, logický, řetězec ne
faktor numerický, řetězec ne
matice numerický, komplexńı, logický, řetězec ne
pole numerický, komplexńı, logický, řetězec ne
tabulka dat numerický, komplexńı, logický, řetězec ano
seznam numerický, komplexńı, logický, řetězec,

funkce, výraz, . . .
ano

Tab. 1.1. Přehled datových typ̊u objekt̊u

Př́ıklady k procvičeńı

1. Několika zp̊usoby zobrazte nápovědu funkce mean a stručně ji popǐste.

2. Vyhledejte př́ıklad použit́ı funkce dim.

3. Spust’te ukázku použit́ı funkce image.

4. Vypǐste cestu k adresáři, ve kterém se nacháźıte.

5. Definujte následuj́ıćı proměnné:

• proměnnou a s textovou hodnotou "pokus"

• proměnnou a1 s hodnotou 1-i

• proměnnou b s hodnotou TRUE

• proměnnou c s hodnotou -1.333

• proměnnou d s hodnotou ∞

a) Vypǐste seznam všech definovaných proměnných.
b) Vypǐste seznam všech proměnných zač́ınaj́ıćıch na ”a”.
c) Smažte proměnnou c a vypǐste nový seznam definovaných proměnných.
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6. Jakou datovou strukturu byste volili pro zobrazeńı:
a) údaj̊u o nadmořské výšce dané obdélńıkové oblasti,
b) informace o provedeném experimentu obsahuj́ıćı jeho stručný popis v textové
podobě, vstupńı data a porovnáńı výsledk̊u pro r̊uzné metody,
c) pohlav́ı respondent̊u,
d) údaj̊u pro 100 respondent̊u, u nichž známe jméno, př́ıjmeńı, věk, výšku a váhu.

Řešeńı.

1. help(mean), ?mean nebo v menu Help → Search help . . . , mean - funkce pro
výpočet aritmetického pr̊uměru

2. example(dim)

3. demo(image)

4. getwd()

5. a <- "pokus" nebo a <- ’pokus’,
a1 <- 1-1i,
b <- TRUE nebo b <- T,
c <- -1.333,
d <- Inf

a) ls() nebo objects()

b) ls(pattern="a")
c) rm(c), ls()

6. a) matice,
b) seznam,
c) vektor, faktor,
d) datová tabulka.
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Kapitola 2

Vektory

Základńı informace

V této kapitole uvedeme nejjednodušš́ı datovou strukturu – vektor. Vektory jsou po-
sloupnosti hodnot s jistou informačńı hodnotou – mohou udávat hmotnosti kapr̊u
v kádi, koncentrace mikroorganismů v ovzduš́ı během určitého časového obdob́ı či počty
krtinc̊u na několika sousedńıch zahradách. Seznámı́me se s několika možnostmi, jak de-
finovat vektory r̊uzných datových typ̊u a pracovat s nimi, a s některými speciálńımi
př́ıklady vektor̊u poměrně často využ́ıvanými v praxi – s posloupnostmi a vektory
náhodných č́ısel.
Závěr kapitoly je věnován daľśımu speciálńımu př́ıkladu vektor̊u – faktoru. Tyto struk-
tury umožňuj́ı jednoduše a přehledně definovat a efektivně pracovat s vektory no-
minálńıch nebo ordinálńıch znak̊u.

Předpokládá se znalost práce s poč́ıtačem a základy lineárńı algebry.

Výstupy z výuky

Studenti

• ovládaj́ı základńı př́ıkazy pro tvorbu vektor̊u,

• umı́ vytvářet posloupnosti a generovat vektory náhodných č́ısel,

• dokáž́ı pracovat se subvektory,

• umı́ definovat, vytvářet a použ́ıvat faktory.
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2.1 Základńı př́ıkazy, tvorba vektor̊u

Jazyk R pracuje nad datovými strukturami. Nejjednodušš́ı takovou strukturou je vek-
tor. Např. jednoduchá hodnota (logická hodnota TRUE, numerická hodnota 2, . . . ) je
vektor délky 1. Vektory jsou 1-dimenzionálńı struktury, skládaj́ıćı se z posloupnosti
prvk̊u. Všechny prvky vektoru muśı být stejného datového typu (modu) – numerický,
komplexńı, logický nebo typu řetězec.

Některé prvky vektoru ovšem nemuśı být známy – v těchto př́ıpadech je na mı́sto
př́ıslušného prvku vektoru umı́stěna speciálńı hodnota NA (

”
Not Available“). Všechny

operace nad NA vraćı hodnotu NA. Funkce is.na(x) vraćı hodnoty TRUE na těch po-
zićıch vektoru x, na kterých maj́ı prvky hodnotu NA, na ostatńıch pozićıch vraćı hodnotu
FALSE. Rovněž některé prováděné operace nemuśı dávat smysl (např. 0/0, Inf - Inf),
v těchto př́ıpadech vraćı př́ıkaz hodnotu NaN (

”
Not a Number“).

Pro vytvořeńı numerického vektoru x o hodnotách -1.2, 31.8., 10.7, 5.6, 9.22 použijeme
př́ıkaz x <- c(-1.2, 31.8, 10.7, 5.6, 9.22). Analogicky můžeme použ́ıt př́ıkazu
assign("nazev", c()), v našem př́ıpadě tedy assign("x", c(-1.2, 31.8, 10.7,

5.6, 9.22)). Přǐrazeńı může být rovněž provedeno v opačném směru: c(-1.2, 31.8,

10.7, 5.6, 9.22) -> x.
Naprosto analogickým zp̊usobem můžeme zadávat komplexńı vektory, např. y <-

c(1+2i, 3, 5i), vektory logických hodnot, např. z <- (x<12 & x>-1), nebo vektory
textových hodnot, např. ovoce <- c("banan", "broskev", "jablko", "pomeranc").

Funkce c() sv̊uj výstup zobrazuje jako řádkový vektor, ovšem je s ńım nakládáno
jako s vektorem sloupcovým.

> c(2, 4, "v", F) jedna z hodnot je znak, vektor tedy bude textový
[1] "2" "4" "v" "FALSE"

Př́ıkaz vector(mode, length) vytvoř́ı vektor daného typu mode a dané délky
length s nulovými hodnotami.

> vector(mode="logical", length=3)

[1] FALSE FALSE FALSE

> vector(m="character", length=5)

[1] "" "" "" "" ""

Nejjednodušš́ım zp̊usobem ke generováńı posloupnost́ı č́ısel je použ́ıt operátoru :.
Př́ıkaz a:b vygeneruje aritmetickou posloupnost prvk̊u od a do b s krokem 1, resp.
−1. Funkce sequence(n) slouž́ı ke generováńı posloupnosti hodnot od č́ısla 1 do č́ısla
(vektoru hodnot) uvedeného v argumentu funkce.

> 4:10

[1] 4 5 6 7 8 9 10
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> 2.4:7

[1] 2.4 3.4 4.4 5.4 6.4

> sequence(6)

[1] 1 2 3 4 5 6

> sequence(c(3,5))

[1] 1 2 3 1 2 3 4 5

Ke generováńı posloupnost́ı s daným krokem MATLAB použ́ıvá funkci
a:krok:b. R tuto syntaxi nezná, je proto třeba použ́ıt jiných funkćı.

Pro generováńı složitěǰśıch posloupnost́ı se použ́ıvá funkce seq(), která má 5 argu-
ment̊u, ale pouze některé z nich mohou být specifikovány současně při jednom voláńı.

• Prvńı 2 argumenty specifikuj́ı počátečńı a koncový bod posloupnosti, př́ıkaz
seq(2,10) je ekvivalentńı př́ıkazu 2:10. Argumenty mohou být rovněž volány
pomoćı from=a, to=b.
Př́ıkazy seq(1,30), seq(from=1, to=30) a seq(to=30, from=1) vraćı stejný
výsledek.

• Argument velikosti kroku: by=krok.

• Argument délky posloupnosti: length=delka.

• V př́ıpadě, že je použit argument along.with, muśı být jediným argumentem
funkce. Argument along.with=v generuje posloupnost poč́ınaj́ıćı hodnotou 1
a délkou shodnou s délkou vektoru v.

> seq() vytvořeńı prázdné posloupnosti
[1] 1

> seq(from=2, to=10)

[1] 2 3 4 5 6 7 8 9 10

> seq(from=2, to=15, by=3)

[1] 2 5 8 11 14

> seq(length=6)

[1] 1 2 3 4 5 6

> seq(from=3, length=6)

[1] 3 4 5 6 7 8

> (k <- seq(to=13, length=6))

[1] 8 9 10 11 12 13

> seq(along.with=k)

[1] 1 2 3 4 5 6

> 7 + seq(along.with=k)

[1] 8 9 10 11 12 13
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Pro vytvořeńı vektoru, v němž se opakuje určitý objekt (hodnota nebo vektor), se
použ́ıvá funkce rep(x). Jej́ımi argumenty jsou:

times=pocet udává počet, kolikrát má být objekt za sebe poskládán
each=pocet udává počet opakováńı každé složky objektu
length.out udává délku výsledného vektoru

> x <- 2:5

> rep(x, times=3) stejný výsledek dává i rep(x, 3)

[1] 2 3 4 5 2 3 4 5 2 3 4 5

> rep(x, each=3)

[1] 2 2 2 3 3 3 4 4 4 5 5 5

> rep(x, length.out=10)

[1] 2 3 4 5 2 3 4 5 2 3

> rep(rep(x, each=2), times=2)

[1] 2 2 3 3 4 4 5 5 2 2 3 3 4 4 5 5

Náhodná č́ısla generovaná v R (a obecně ve všech softwarech) nejsou ve skutečnosti
zcela náhodná, ale jsou generována na základě specifických algoritmů tak, aby se
náhodným č́ısl̊um podobala (tzv. pseudonáhodná č́ısla). Podle pravděpodobnosti výskytu
jednotlivých hodnot můžeme generovat č́ısla z r̊uzných typ̊u rozděleńı:
runif(n, min=a, max=b) Náhodně vygeneruje n náhodných č́ısel z intervalu (a, b),
každé č́ıslo má stejnou pravděpodobnost výskytu.
rpois(n, lambda) Náhodně vygeneruje n celých č́ısel z Poissonova rozděleńı s pa-
rametrem lambda.
rnorm(n, mean=mi, sd=sigma) Náhodně vygeneruje n reálných č́ısel z normálńıho
rozděleńı se středńı hodnotou mi a směrodatnou odchylkou sigma.

> runif(10, min=2, max=8)

[1] 3.468575 2.006183 5.151939 4.864977 5.117221 5.981666

[7] 6.186421 6.470627 7.230629 7.726394

> rpois(10, 5)

[1] 7 11 1 4 3 5 6 3 1 5

> rnorm(10, mean=5, sd=2)

[1] 3.880884 5.902384 9.645860 3.955287 3.923085 3.763641

[7] 1.782563 6.003977 7.512364 4.685642

Daľśım užitečným př́ıkazem ke generováńı vektor̊u je funkce sample(). Funkce
sample(x, size, replace=FALSE, prob=NULL) vytvoř́ı náhodnou permutaci prvk̊u
objektu x. Objekt x může být vektor (č́ıselný, komplexńı, logický nebo vektor znak̊u)
nebo přirozené č́ıslo. Argument size je přirozené č́ıslo udávaj́ıćı délku výsledného vek-
toru. Argument replace=TRUE umožňuje opakováńı vybraných prvk̊u, zat́ımco impli-
citńı nastaveńı replace=FALSE opakováńı nepovoluje. Argument prob umožňuje na-
staveńı pravděpodobnostńıch vah výběru jednotlivých prvk̊u.

16



KAPITOLA 2. VEKTORY

> x <- c(1, 3, 5, 7, 2, 6)

> sample(x, 3)

[1] 6 7 2

> sample(x, 3, replace=TRUE)

[1] 3 3 2

> x <- letters[1:15] vektor prvńıch 15 ṕısmen abecedy (a–o)
> sample(x, 4, prob=c(1, rep(0.1, 13), 1))

[1] "a" "o" "d" "l"

> sample(x, 8, prob=c(1, rep(0.1, 13), 1), replace=TRUE)

[1] "e" "b" "o" "o" "n" "a" "a" "c"

2.2 Subvektory

K výpisu určité podmnožiny prvk̊u vektoru můžeme použ́ıt hranatých závorek, [ ].
Obecně má pro vektor x tento př́ıkaz tvar x[index], kde index je vektor jednoho
z následuj́ıćıch tvar̊u:

1. Vektor přirozených č́ısel. Jedná se o vektor index̊u, který nabývá hodnot
z množiny {1, 2, . . . , length(x)}.
> x <- 2:16

> x[7] vyṕı̌se 7. složku vektoru x

[1] 8

> x[4:12] vyṕı̌se 4.–12. složku vektoru x

[1] 5 6 7 8 9 10 11 12 13

Hodnota NA je vrácena v př́ıpadě, že vektor index obsahuje přirozené č́ıslo větš́ı
než je délka vektoru. Podobně R vraćı prázdný vektor numeric(0) v př́ıpadě, že
vektor index obsahuje nulu:

> x[13:18] vyṕı̌se 13.–18. složku vektoru x

[1] 14 15 16 NA NA NA

> x[c(7, 0, 5, 12)] index 0 se ignoruje
[1] 8 6 13

> x[0]

[1] integer(0)

Vektor index můžeme definovat rovněž použit́ım funkćı ke konstrukci nume-
rických vektor̊u, např. c(), :, rep(), sample(), seq()

> x[c(3, 8, 10, 4, 7)]

[1] 4 9 11 5 8

> x[c(rep(4, 2), rep(7, 3))]

[1] 5 5 8 8 8
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> x[sample(x, 5, replace=TRUE)]

[1] 6 10 11 4 6

> x[seq(from=4, to=20, by=3)]

[1] 5 8 11 14 NA NA

Můžeme rovněž použ́ıt funkćı head() a tail(), které vraćı prvńıch/posledńıch
n prvk̊u vektoru (implicitńı nastaveńı n=6):

> head(x)

[1] 2 3 4 5 6 7

> tail(x, n=3)

[1] 14 15 16

2. Vektor záporných celých č́ısel. Vektorem záporných celých č́ısel index vyme-
zujeme ty indexy vektoru x, jejichž odpov́ıdaj́ıćı hodnoty nemaj́ı být vytǐstěny.
Všechny prvky vektoru x, kromě těch specifikovaných vektorem index, jsou do
výsledné podoby vypsány v jejich p̊uvodńım pořad́ı. Délka výsledného vektoru je
length(x) - length(index).

> x[-c(1:10)] vynechá prvńıch deset prvk̊u vektoru
[1] 12 13 14 15 16

> x[-tail(x, 10)]

[1] 2 3 4 5 6 7

3. Logický vektor. Prvky odpov́ıdaj́ıćı hodnotám TRUE vektoru index jsou vypi-
sovány, zat́ımco prvky odpov́ıdaj́ıćı hodnotám FALSE jsou vynechány. Výsledný
vektor je stejné délky jako počet hodnot TRUE vektoru index.

> x[c(TRUE, FALSE, TRUE, TRUE, FALSE, rep(c(TRUE, FALSE), 5))]

vektor index může být zadán vektorem hodnot TRUE a FALSE

[1] 2 4 5 7 9 11 13 15

Poznámka. V př́ıpadě, že je logický vektor kratš́ı než je počet prvk̊u vektoru, ze
kterého prvky vyb́ıráme (vektoru x), je uplatněno pravidlo recycling rule. Pravi-
dlo spoč́ıvá v opakováńı složek logického vektoru tak dlouho, dokud jeho délka
nedosáhne délky vektoru:

> x[c(TRUE, FALSE, TRUE, FALSE)]

[1] 2 4 6 8 10 12 14 16

> x[x>7 & x<=12] vektor index může být dán omezuj́ıćımi podmı́nkami –
použit́ım porovnávaćıch a logických operátor̊u (porovnávaćı a logické operátory
viz odstavec 5.2)
[1] 8 9 10 11 12

V př́ıpadě, že vektor x obsahuje hodnoty NA, potřebujeme pomoćı funkce is.na()
zajistit, aby byly správně vynechány:
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> (y <- c(7, 3, NA, 5, NA, NA, 9))

[1] 7 3 NA 5 NA NA 9

> y[y<6]

[1] 3 NA 5 NA NA

> y[y<6 & !is.na(y)] vyṕı̌se ty hodnoty vektoru y, které jsou menš́ı než 6

a jsou r̊uzné od hodnoty NA

[1] 3 5

Alternativou v této situaci může být funkce subset(). Jej́ım prvńım argumen-
tem je vektor, ze kterého chceme źıskat jeho podmnožinu, druhým argumentem
je vektor omezuj́ıćıch podmı́nek. Výhodou této funkce je, že hodnoty NA jsou au-
tomaticky považovány za FALSE, takže nemuśı být odstraňovány pomoćı funkce
is.na().

> subset(y, y<6)

[1] 3 5

> subset(y, c(TRUE, TRUE, FALSE, FALSE, FALSE, TRUE, TRUE))

[1] 7 3 NA 9

> subset(y, c(TRUE, FALSE, FALSE)) použit́ı pravidla recycling rule
[1] 7 5 9

4. Vektor znakových řetězc̊u. Tento zp̊usob může být použit pouze v př́ıpadě,
kdy prvky vektoru maj́ı názvy. V tom př́ıpadě může být vektor index použit
stejným zp̊usobem jako v př́ıpadě přirozených č́ısel v odrážce 1, řetězce ve vek-
toru index odpov́ıdaj́ı názv̊um prvk̊u vektoru x.

> (ovoce <- c(banan=3, broskev=8, jablko=7, pomeranc=5)) přǐrazeńı
názvu jednotlivým prvk̊um vektoru
banan broskev jablko pomeranc

3 8 7 5
> names(ovoce) každý prvek vektoru má opravdu sv̊uj název
[1] "banan" "broskev" "jablko" "pomeranc"

Jiný zp̊usob definice přǐrazeńı názvu jednotlivým prvk̊um vektoru:
> ovoce <- c(3, 8, 7, 5)

> names(ovoce) <- c("banan", "broskev", "jablko", "pomeranc")

> ovoce[c("broskev", "jablko")]
broskev jablko

8 7

MATLAB použ́ıvá pro výpis subvektor̊u kulatých závorek, pro nekladné argu-
menty vraćı chybové hlášeńı.
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2.3 Délka a změna délky vektoru

Každý vektor má svou délku, což je počet jeho prvk̊u. Ke zjǐstěńı délky definovaného
vektoru slouž́ı funkce length().

Každý prázdný objekt je nějakého datového typu. Např. př́ıkazem

> numeric()

[1] numeric(0)

vytvoř́ıme prázdný numerický vektor, analogicky př́ıkazem character() vytvoř́ıme
prázdný textový vektor, atd. K již existuj́ıćımu objektu libovolné délky můžeme přidávat
nové složky, a to jednoduše umı́stěńım indexu hodnoty do hranaté závorky. Tak př́ıkazem
u[2] <- 5 vytvoř́ıme nový vektor u délky 2 (1. složka neńı známa, má tedy hodnotu
NA, 2. složka má hodnotu 5). Tento př́ıkaz můžeme použ́ıt pro jakoukoliv strukturu za
předpokladu, že datový typ přidávaných prvk̊u je shodný s datovým typem objektu.

Naopak, ke zkráceńı délky objektu je třeba jen operátor přǐrazeńı <-, kde za název
proměnné umı́st́ıme do hranatých závorek ty indexy prvk̊u, které nás zaj́ımaj́ı. Symbol
záporného znaménka před vektorem index̊u v hranatých závorkách určuje ty hodnoty,
které nemaj́ı být vypsány na výstupu.

> u <- 5:12

[1] 5 6 7 8 9 10 11 12

> length(u)

[1] 8

> u[c(1, 3, 5)] vyṕı̌se 1., 3. a 5. prvek vektoru u.
[1] 5 7 9

> u[-c(1, 3, 5)] vynechá 1., 3. a 5. prvek vektoru u.
[1] 6 8 10 11 12

V př́ıpadě, že chceme źıskat prvńıch n složek vektoru, použijeme př́ıkaz length(v)

<- n. Stejným zp̊usobem můžeme i prodlužovat vektory, přidané pozice budou mı́t
hodnotu NA.

> length(u) <- 3 analogické př́ıkazy: u[c(1,2,3)], u[1:3], head(u,3)

> u přesvědč́ıme se, že vektor u opravdu obsahuje jen p̊uvodńı 3 složky
[1] 5 6 7

> length(u) <- 5

> u

[1] 5 6 7 NA NA
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2.4 Faktory

Faktory jsou speciálńım př́ıpadem vektor̊u s nominálńımi nebo ordinálńımi daty. Jedná
se o datovou strukturu, která umožňuje přǐradit smysluplné názvy jednotlivým ka-
tegoríım. Na prvńı pohled vypadaj́ı faktory podobně jako numerické a textové vek-
tory, ale neńı tomu tak. Faktory v sobě nav́ıc obsahuj́ı informaci Levels – jedná se
o konečnou množinu hodnot, kterých kategorická proměnná může nabývat. Jednotlivé
prvky Levels jsou uspořádány podle jejich typu (numericky nebo abecedně), hodnoty
NA zde ovšem nejsou zahrnuty.

> factor(c("kocka", "kun", NA, "pes", "kocka", "pes", "pes"))

[1] kocka kun <NA> pes kocka pes pes

Levels: kocka kun pes

Poznámka. Je d̊uležité si uvědomit, že prvky numerického faktoru nejsou interpre-
továny jako numerické hodnoty:

> mean(factor(1:5)) funkce mean slouž́ı k výpočtu pr̊uměru
[1] NA

Warning message:

In mean.default(factor(1:5)) :

argument is not numeric or logical: returning NA

Funkce factor() má několik volitelných argument̊u (levels, exclude, ordered).
Argument levels může být použit k definováńı úrovńı (Levels) faktoru. Např. můžeme
vytvořit faktor i s úrovńı, která se mezi daty nevyskytuje:

> factor(c(2, 3, 1, NA, 3, 2), levels=1:4) hodnoty NA nejsou do Levels vy-
pisovány
[1] 2 3 1 <NA> 3 2

Levels: 1 2 3 4

Argument levels rovněž může sloužit ke změně pořad́ı prvk̊u úrovńı:

> factor(c(2, 3, 1, NA, 3, 2), levels=c(1, 3, 2, 4))

[1] 2 3 1 NA 3 2

Levels: 1 3 2 4

Argument labels se použ́ıvá k definici popisk̊u:

> factor(c(0, 1, 1, 0, 1), labels=c("nepritomen", "pritomen"))

[1] nepritomen pritomen pritomen nepritomen pritomen

Levels: nepritomen pritomen

> factor(c(0, 1, 1, 0, 1), labels=c("nepritomen", "pritomen"),

+ levels=c(1,0))

[1] pritomen nepritomen nepritomen pritomen nepritomen

Levels: nepritomen pritomen
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Argument exclude ignoruje vybrané prvky, tyto prvky jsou nahrazeny hodnotami NA
> factor(c(2, 3, 1, NA, 3, 2), exclude=3)

[1] 2 <NA> 1 <NA> <NA> 2

Levels: 1 2 <NA>

> factor(c(2, 3, 1, NA, 3, 2), exclude=NULL) argument exclude=NULL

slouž́ı pro zobrazeńı hodnoty NA v Levels

[1] 2 3 1 <NA> 3 2

Levels: 1 2 3 <NA>

Argument ordered=TRUE slouž́ı k seřazeńı úrovńı faktoru. Jediným rozd́ılem na výstupu
je zobrazeńı porovnávaćıho operátoru < mezi jednotlivými úrovněmi faktoru. Tuto
vlastnost můžeme použ́ıt např. při porovnáváńı jednotlivých prvk̊u.

> (velikost <- factor(c(3, 1, 5, 4, 3, 2, 4), labels=c("mravenec",

+ "hlemyzd", "koza", "slon", "zirafa")))

[1] koza mravenec zirafa slon koza hlemyzd slon

Levels: mravenec hlemyzd koza slon zirafa

> (velikost <- factor(c(3, 1, 5, 4, 3, 2, 4), labels=c("mravenec",

+ "hlemyzd", "koza", "slon", "zirafa"), ordered=TRUE))

[1] koza mravenec zirafa slon koza hlemyzd slon

Levels: mravenec < hlemyzd < koza < slon < zirafa

> velikost >= "koza" vraćı vektor logických hodnot, na pozićıch splňuj́ıćıch pod-
mı́nku jsou hodnoty TRUE, na ostatńıch pozićıch FALSE

[1] TRUE FALSE TRUE TRUE TRUE FALSE TRUE

Př́ıklady k procvičeńı

1. V cementárně byla měřena hmotnost pytl̊u cementu, k dispozici jsou naměřené
hodnoty:
50.3, 50.7, 49.2, 50.1, 49.9, 51.1, 49.8, 48.9 a 50.3.
Poskládejte tyto hodnoty do vektoru cement a vyřešte následuj́ıćı úkoly:
a) Pomoćı vhodné funkce zjistěte délku vektoru cement.
b) Vytvořte vektor cement1, který bude obsahovat hodnoty na sudých pozićıch
vektoru cement a dále pak jeho posledńı tři hodnoty.
c) Vytvořte vektor cement2, který bude náhodnou kombinaćı pěti hodnot vek-
toru cement s pravděpodobnost́ı 0.4 pro prvńı čtyři hodnoty vektoru cement a
s pravděpodobnost́ı 0.2 pro ostatńı hodnoty, hodnoty se mohou opakovat.
d) Vypǐste ty složky vektoru cement, které jsou větš́ı než 50.

2. Náhodně vygenerujte vektor v délky 15 s hodnotami 0 a 1. Dále z něj vytvořte
faktor pohlavi, ve kterém se hodnota 0 bude vypisovat jako ”muž”a hodnota 1
jako ”žena”.
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3. Změňte minulé zadáńı tak, aby se hodnota 0 vypisovala jako ”žena”a hodnota 1
jako ”muž”.

4. Vytvořte vektor hodnot v1 od -10 do 0 s krokem 0.5.

5. Vytvořte vektor hodnot v2 obsahuj́ıćı sudé hodnoty posloupnosti -12, -11, . . . ,
11, 12.
a) Hodnoty vektoru v2 zdvojte tak, aby nově vzniklý vektor obsahoval hodnoty
-12, . . . , 12, -12, . . . , 12.
b) Hodnoty vektoru v2 zdvojte tak, aby nově vzniklý vektor obsahoval hodnoty
-12, -12, . . . , 12, 12.

6. Proved’te losováńı tahu sportky, tzn. vyberte 7 č́ısel od 1 do 49 tak, aby se
neopakovala.

7. Náhodně vygenerujte 10 hodnot z normálńıho rozložeńı se středńı hodnotou 5 a
rozptylem 2.

Řešeńı.

1. cement <- c(50.3, 50.7, 49.2, 50.1, 49.9, 51.1, 49.8, 48.9, 50.3)

a) length(cement)
b) cement1 <- c(cement[seq(from=2, to=length(cement), by=2)],

tail(cement, 3))

c) cement2 <- sample(cement, size=5, prob=c(rep(0.4, times=4),

rep(0.2, times=length(cement)-4)), replace=TRUE)

d) cement[cement > 50]

2. v <- sample(c(0, 1), size=15, replace=TRUE) nebo v <- round(runif(

min=0, max=1, n=15))

pohlavi <- factor(v, levels=c(0, 1), labels=c("muz", "zena"))

3. pohlavi <- factor(v, levels=c(1, 0), labels=c("muz", "zena"))

4. v1 <- seq(from=-10, to=0, by=0.5)

5. v2 <- seq(from=-12, to=12, by=2)

a) rep(v2, times=2)

b) rep(v2, each=2)

6. sample(1:49, size=7)

7. rnorm(n=10, mean=5, sd=sqrt(2))

23



KAPITOLA 3. MATICE A POLE 24

Kapitola 3

Matice a pole

Základńı informace

Matice maj́ı širokou škálu využit́ı nejen v matematice, ale i v technických a ekono-
mických vědách a statistice. Jejich uplatněńı můžeme hledat např. v řešeńı systémů
lineárńıch rovnic či v aplikaci maticových operaćı. Tato kapitola seznamuje s možnostmi,
jak definovat matice či pole, uvád́ı množstv́ı postup̊u a funkćı, jak s nimi jednoduše
pracovat, v neposledńı řadě uvád́ı př́ıkazy pro řešeńı systémů lineárńıch rovnic.

Výstupy z výuky

Studenti

• ovládaj́ı př́ıkazy pro vytvářeńı matic a poĺı,

• umı́ pracovat se submaticemi,

• dokáž́ı použ́ıt funkce pro manipulaci s maticemi,

• rozlǐsuj́ı maticové násobeńı a násobeńı po složkách, umı́ řešit systémy lineárńıch
rovnic.

3.1 Základńı př́ıkazy, tvorba matic a poĺı

Matice je 2-dimenzionálńı datová struktura, která se skládá z řádk̊u a sloupc̊u. Stejně
jako vektory, všechny prvky matice muśı být stejného datového typu (numerický, kom-
plexńı, logický nebo textový), mohou rovněž obsahovat prvky s hodnotami NA, NaN,
NULL nebo Inf. Pole je k-dimenzionálńı struktura, matice je jej́ım speciálńım typem
pro k = 2.
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Základńım zp̊usobem k vytvořeńı matice je použit́ı př́ıkazu matrix():
matrix(data, nrow, ncol, byrow, dimnames) funkce pro tvorbu matice
data vektor hodnot, které maj́ı být uspořádány do matice
nrow počet řádk̊u matice, implicitńı nastaveńı nrow=1
ncol počet sloupc̊u matice, implicitńı nastaveńı ncol=1
byrow implicitńı nastaveńı byrow=FALSE znač́ı plněńı matice po sloupćıch, na-

staveńı byrow=TRUE plńı matici po řádćıch
dimnames argument typu ”seznam”(viz Kapitola 4) pro pojmenováńı řádk̊u a

sloupc̊u matice

> matrix(data=u, nrow=4, ncol=5) vytvoř́ı matici o 4 řádćıch a 5 sloupćıch,
prvky jsou skládány po sloupćıch

[,1] [,2] [,3] [,4] [,5]

[1,] 1 5 9 13 17

[2,] 2 6 10 14 18

[3,] 3 7 11 15 19

[4,] 4 8 12 16 20
> matrix(data=u, nrow=4, ncol=5, byrow=TRUE) vytvoř́ı matici 4 x 5, argument
byrow=TRUE zajist́ı, aby prvky byly do matice seskládány po řádćıch

[,1] [,2] [,3] [,4] [,5]

[1,] 1 2 3 4 5

[2,] 6 7 8 9 10

[3,] 11 12 13 14 15

[4,] 16 17 18 19 20

Názvy řádk̊u a sloupc̊u mohou být specifikovány argumentem dimnames. Jedná se
o argument typu seznam (pro v́ıce podrobnost́ı viz Kapitola 4) o dvou složkách – tex-
tových vektorech obsahuj́ıćıch názvy jednotlivých řádk̊u a sloupc̊u.

> matrix(u, ncol=5, dimnames=list(c("r1", "r2", "r3", "r4"), c("sl1",

+ "sl2", "sl3", "sl4", "sl5")))
sl1 sl2 sl3 sl4 sl5

r1 1 4 9 13 17

r2 2 5 10 14 18

r3 3 6 11 15 19

r4 4 8 12 16 20

Při definováńı matice je možné jeden z argument̊u jej́ıch rozměr̊u vynechat - jazyk
R si chyběj́ıćı rozměry sám dopoč́ıtá. Rovněž neńı potřeba uvádět názvy argument̊u,
pokud zachováme přesné pořad́ı, které je uvedeno v nápovědńım systému. Př́ıkazy

matrix(u, ncol=5)

matrix(u, nrow=4)

matrix(u, 4)

matrix(u, c(4, 5))
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vraćı stejné výstupy jako výše uvedený př́ıkaz matrix(data=u, nrow=4, ncol=5),
všechny př́ıkazy seskládaj́ı vektor u po sloupćıch do pěti sloupc̊u a čtyř řádk̊u.

Poznámka. V př́ıpadě, že je vektor u kratš́ı než je počet prvk̊u matice, při vytvářeńı
matice je uplatněno pravidlo recycling rule. Pravidlo spoč́ıvá v opakováńı složek vektoru
u tak dlouho, dokud jeho délka nedosáhne počtu prvk̊u matice.

Pro definováńı poĺı slouž́ı př́ıkaz array(), s ńımž je práce analogická:
array(data, dim, dimnames) funkce pro tvorbu pole
data vektor hodnot, které maj́ı být uspořádány do pole
dim numerický vektor rozměr̊u pole, implicitńı nastaveńı dim=length(data)
dimnames argument typu ”seznam”pro pojmenováńı jednotlivých dimenźı pole

> (ar <- array(u, c(2, 5, 2))) vytvoř́ı pole o rozměrech 2 x 5 x 2
, , 1

[,1] [,2] [,3] [,4] [,5]

[1,] 1 3 5 7 9

[2,] 2 4 6 8 10

, , 2

[,1] [,2] [,3] [,4] [,5]

[1,] 11 13 15 17 19

[2,] 12 14 16 18 20

Daľśım zp̊usobem, jak vytvořit matice, popř. pole je př́ıkaz dim(), který vektor
ve svém argumentu uspořádá po sloupćıch do pole požadované dimenze.

> u <- 1:20

> dim(u) <- c(4, 5) vektoru u stanov́ı dimenzi – 4 řádky, 5 sloupc̊u
> u

[,1] [,2] [,3] [,4] [,5]

[1,] 1 5 9 13 17

[2,] 2 6 10 14 18

[3,] 3 7 11 15 19

[4,] 4 8 12 16 20

Pro zjǐstěńı velikosti matice či pole slouž́ı funkce dim(). Výstupem je vektor, jehož
prvńı složka udává počet řádk̊u, druhá udává počet sloupc̊u a v př́ıpadě poĺı odkazuj́ı
daľśı složky na př́ıslušné dimenze. Pro zjǐstěńı počtu řádk̊u či sloupc̊u matic i poĺı slouž́ı
rovněž funkce nrow() či ncol().

> dim(u)

[1] 4 5
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> dim(ar)

[1] 2 5 2

> nrow(ar)

[1] 2

> ncol(ar)

[1] 5

V systému MATLAB lze funkćı size() źıskat rozměry matice, pole i vektoru.
Analogickou funkćı pro size() je v jazyce R funkce dim(), tu ovšem nemůžeme
použ́ıt pro zjǐstěńı délky vektoru. Funkćım nrow(x) a ncol(x) odpov́ıdaj́ı
v MATLABu funkce size(x,1) a size(x,2).

Daľśımi př́ıkazy pro tvorbu matic mohou být cbind() nebo rbind(), které své
argumenty skládaj́ı vertikálně (po sloupćıch) nebo horizontálně (po řádćıch). Argu-
menty mohou být vektory libovolných délek a/nebo matice s odpov́ıdaj́ıćım počtem
řádk̊u nebo sloupc̊u.

> cbind(1:3, 4:6)
[,1] [,2]

[1,] 1 4

[2,] 2 5

[3,] 3 6
> cbind(matrix(1:4, c(2, 2)), matrix(c(8, 11), c(2, 1)))

[,1] [,2] [,3]

[1,] 1 3 8

[2,] 2 4 11
> rbind(1:8, 1:5) v př́ıpadě, že vektory nejsou stejné délky, složky kratš́ıho vek-
toru se opakuj́ı tak dlouho, dokud nedosáhne rozměru deľśıho vektoru

[,1] [,2] [,3] [,4] [,5] [,6] [,7] [,8]

[1,] 1 2 3 4 5 6 7 8

[2,] 1 2 3 4 5 1 2 3
Warning message:

In rbind(1:8 1:5) :

number of columns of result is not a multiple of vector length

(arg 2)

Funkce rbind() a cbind() mohou obsahovat volitelný argument tvaru

nazev.vektoru=vektor,

který slouž́ı k pojmenováńı jednotlivých řádk̊u (v př́ıpadě funkce rbind) a sloupc̊u
(v př́ıpadě cbind). Tento zp̊usob pojmenováńı dimenźı funguje pouze pro vstupńı vek-
tory, v př́ıpadě vstupńıch matic se název ignoruje.
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> cbind(sl1=1:3, sl2=4:6)
sl1 sl2

[1,] 1 4

[2,] 2 5

[3,] 3 6
> rbind(u=1:3, A=matrix(1:6, nrow=2))

[,1] [,2] [,3]

u 1 2 3

1 3 5

2 4 6

Na rozd́ıl od MATLABu nelze v jazyce R matici o jednom sloupci źıskat trans-
pozićı vektoru (funkce t()), je třeba použ́ıt jeden z př́ıkaz̊u matrix(), dim()
nebo rbind().

3.2 Submatice

K výpisu určité podmnožiny prvk̊u matice či pole můžeme použ́ıt hranatých závorek
[ ]. Obecně má pro n-rozměrné pole A tento př́ıkaz tvar A[index 1, index 2, ...,

index n], kde index 1, odkazuje na řádky, index 2 na sloupce a na ostatńı dimenze
odkazuj́ı index 3, ..., index n. Odkaz na každou dimenzi může být jedńım ze čtyř
tvar̊u uvedených v podkapitole 2.2. V př́ıpadě, že některý z index̊u neńı specifikován,
v úvahu je brána celá délka př́ıslušné dimenze.

> (A <- matrix(1:20, 4))
[,1] [,2] [,3] [,4] [,5]

[1,] 1 5 9 13 17

[2,] 2 6 10 14 18

[3,] 3 7 11 15 19

[4,] 4 8 12 16 20
> A[-c(1, 2), c(3, 4, 5)]

[,1] [,2] [,3]

[1,] 11 15 19

[2,] 12 16 20

Jazyk R se vždy snaž́ı vracet objekty s nejnižš́ı možnou dimenźı. Např. chceme-
li vypsat jediný sloupec matice, R jej zobraźı jako řádkový vektor. To ovšem může
být v některých př́ıpadech nežádoućı – toto chováńı můžeme vypnout argumentem
drop=FALSE:
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> A[, 2]

[1] 5 6 7 8

> A[, 2, drop=FALSE]
[,1]

[1,] 5

[2,] 6

[3,] 7

[4,] 8

3.3 Funkce pro manipulaci s maticemi

nrow(), ncol() počet řádk̊u a sloupc̊u pole
dim() dimenze pole
t() transpozice matice
diag(A) vyṕı̌se diagonálu matice A

diag(v) vytvoř́ı diagonálńı matici se složkami vektoru v na diagonále
diag(k) pro každé přirozené č́ıslo k vygeneruje jednotkovou matici

rozměr̊u k × k
lower.tri(), výstupem je matice logických hodnot stejných rozměr̊u jako ma-
upper.tri() tice v argumentu. Hodnoty TRUE odpov́ıdaj́ı prvk̊um

v dolńı/horńı trojúhelńıkové matici. Implicitńı nastaveńı
diag=FALSE nezahrnuje diagonálu.

det() determinant matice
eigen() výstupem je seznam o dvou položkách - values (vlastńı č́ısla)

a vectors (vlastńı vektory). V př́ıpadě, že nás zaj́ımaj́ı pouze
vlastńı č́ısla, popř. pouze vlastńı vektory matice, použijeme
operátoru $: eigen()$values, popř. eigen()$vectors.

qr() QR rozklad. Jedńım z výstup̊u je i hodnost matice, chceme-li
zjistit pouze hodnost matice, můžeme použ́ıt př́ıkaz qr()$rank

svd() singulárńı rozklad trojúhelńıkové matice
norm() norma matice. Je potřeba nainstalovat a nač́ıst podp̊urný

baĺıček Matrix pomoćı př́ıkaz̊u install.packages("Matrix")

a library(Matrix). Volitelnými argumenty můžeme zvolit typ
normy:
"O", "o" nebo "1" pro maximálńı součty ve sloupćıch, implicitńı
nastaveńı,
"I" nebo "i" pro maximálńı součty v řádćıch,
"F" nebo "f" pro Frobeniovu normu (euklidovská norma vektor,
když je na vstupńı matici nahĺıženo jako na vektor)

sum(diag()) stopa matice
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> (A <- matrix(c(3, 2, -1, 0), 2))
[,1] [,2]

[1,] 3 -1

[2,] 2 0
> (v <- diag(A))

[1] 3 0

> diag(v)
[,1] [,2]

[1,] 3 0

[2,] 0 0
> diag(2)

[,1] [,2]

[1,] 1 0

[2,] 0 1
> lower.tri(A)

[,1] [,2]

[1,] FALSE FALSE

[2,] TRUE FALSE
> A[lower.tri(A)] <- 0 horńı trojúhelńıková matice

[,1] [,2]

[1,] 3 -1

[2,] 0 0
> eigen(A)

$values

[1] 2 1

$vectors
[,1] [,2]

[1,] 0.7071068 0.4472136

[2,] 0.7071068 0.8944272
> eigen(A)$values

[1] 2 1

> qr(A)$rank

[1] 2

> norm(A, "1"); norm(A, "i"); norm(A, "f")

[1] 5

[1] 4

[1] 3.741657

> sum(diag(A))

[1] 3
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Násobeńı matic
Pro násobeńı matic po složkách se použ́ıvá operátor *, nav́ıc muśı mı́t násobené matice
souhlasné rozměry. Pro součin matice a vektoru (v libovolném pořad́ı) se uplatňuje pra-
vidlo recycling rule, tzn. jednotlivé složky matice jsou po sloupćıch postupně násobeny
složkami vektoru.

> u <- c(1, 0, 0)

> v <- c(1, 0, 0, 0, 1)

> A <- matrix(c(1, 0, 0, 1, 0, 1, 1, 1, 0, 0, 1, 1), ncol=3)

> A
[,1] [,2] [,3]

[1,] 1 0 0

[2,] 0 1 0

[3,] 0 1 1

[4,] 1 1 1
> u * A použit́ı pravidla recycling rule

[,1] [,2] [,3]

[1,] 1 0 0

[2,] 0 0 0

[3,] 0 1 0

[4,] 1 0 0
> v * A použit́ı pravidla recycling rule. Výstup nav́ıc obsahuje varovné hlášeńı, ne-
bot’ počet prvk̊u matice A neńı dělitelný délkou vektoru v

[,1] [,2] [,3]

[1,] 1 0 0

[2,] 0 1 0

[3,] 0 0 1

[4,] 0 0 0
Warning message:

In v * A : longer object length is not a multiple of shorter object

length

Poznámka. Jazyk R nerozlǐsuje při násobeńı pomoćı operátoru * pořad́ı matice a vek-
toru. Na následuj́ıćıch př́ıkladech se můžeme přesvědčit, že operace A * u dává stejný
výstup jako u * A a operace A * v dává stejný výstup jako v * A.

> A * u použit́ı pravidla recycling rule
[,1] [,2] [,3]

[1,] 1 0 0

[2,] 0 0 0

[3,] 0 1 0

[4,] 1 0 0
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> A * v použit́ı pravidla recycling rule. Výstup nav́ıc obsahuje varovné hlášeńı, ne-
bot’ počet prvk̊u matice A neńı dělitelný délkou vektoru v

[,1] [,2] [,3]

[1,] 1 0 0

[2,] 0 1 0

[3,] 0 0 1

[4,] 0 0 0
Warning message:

In A * v : longer object length is not a multiple of shorter object

length

Pro maticové násobeńı se použ́ıvá operátor %*%, oba činitelé muśı být odpov́ıdaj́ıćıch
rozměr̊u (vnitřńı rozměry obou činitel̊u muśı být shodné).

> A %*% u
[,1]

[1,] 1

[2,] 0

[3,] 0

[4,] 1
> B <- matrix(c(0, 1, 1, 1, 0, 1, 0, 1), ncol=4)

[,1] [,2] [,3] [,4]

[1,] 0 1 0 0

[2,] 1 1 1 1
> A %*% B nesouhlasné rozměry matic
Error in A %*% B : non-conformable arguments

> B %*% A
[,1] [,2] [,3]

[1,] 0 1 0

[2,] 2 3 2

Zat́ımco v systému MATLAB operaci násobeńı po složkách zajǐst’uje operátor
.*, v jazyce R je to *. Operátor * v systému MATLAB označuje maticové
násobeńı, v jazyce R je to operátor %*%.

Řešeńı lineárńıch rovnic a inverze
Řešeńı lineárńıch rovnic je inverzńı operaćı k maticovému násobeńı

> b <- A %*% x
A znač́ı čtvercovou matici koeficient̊u pro lineárńı systém, b je vektor nebo matice pravé
strany. Vektor/matice x je řešeńım systému lineárńıch rovnic Ax = b, které źıskáme
př́ıkazem solve(A, b). V lineárńı algebře řešeńı formálně dostaneme x = A−1b, kde
A−1 znač́ı matici inverzńı k matici A. Matici inverzńı můžeme v R spoč́ıtat pomoćı
solve(A).
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> (A <- matrix(c(1, 3, 1, -1), 2))
[,1] [,2]

[1,] 1 1

[2,] 3 -1
> (b <- matrix(c(3, 1), 2))

[,1]

[1,] 3

[2,] 1
> solve(A, b)

[,1]

[1,] 1

[2,] 2
> solve(A) %*% b

[,1]

[1,] 1

[2,] 2

K řešeńı systémů lineárńıch rovnic slouž́ı i funkce backsolve():
backsolve(A, b, k, upper.tri, transpose) funkce pro řešeńı systémů lineárńıch
rovnic s trojúhelńıkovou matićı soustavy
A matice soustavy
b vektor/matice pravé strany
k počet sloupc̊u matice A a řádk̊u b, který má být při výpočtu použit
upper.tri systém s horńı trojúhelńıkovou matićı soustavy odpov́ıdá impli-

citńımu nastaveńı upper.tri=TRUE, nastaveńı upper.tri=FALSE

odpov́ıdá systému s dolńı trojúhelńıkovou matićı
transpose nastaveńım transpose=TRUE řeš́ıme systém A′x = b, implicitńı na-

staveńı transpose=FALSE

> backsolve(A, b, upper.tri=TRUE) řeš́ı systém lineárńıch rovnic

(
1 1 3
0 −1 1

)
[,1]

[1,] 4

[2,] -1

Poznámka. Stejně jako u maticového násobeńı, ani u funkćı solve a backsolve neńı ne-
zbytně nutné zadávat vektory pravé strany jako sloupcové vektory. Pro vstupńı řádkový
vektor bude výstupem řádkový vektor.
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Př́ıklady k procvičeńı

1. Vytvořte matici A1 s rozměry 3 x 5, jej́ıž prvńı řádek bude tvořen posloupnost́ı
-1, 1, 3, . . . , druhý řádek budou tvořit hodnoty 3 a posledńı řádek ekvidistantńı
posloupnost s minimálńı hodnotou -2 a maximálńı hodnotou 2.

2. Vytvořte matici A2 s rozměry 3 x 5, jej́ıž prvńı sloupec bude tvořen náhodnými
č́ısly z rovnoměrného rozložeńı na intervalu [0, 5], druhý a třet́ı sloupec bude tvořit
posloupnost s maximálńı hodnotou 3.5 a krokem 0.2 a posledńı dva sloupce budou
obsahovat hodnotu NA.

3. Vypǐste čtvrtý sloupec matice A1 jako řádkový i sloupcový vektor.

4. Vypǐste prvky prvńıho a druhého řádku a všech lichých sloupc̊u matice A1. Uložte
je do matice A3 a vhodným př́ıkazem zjistěte jej́ı rozměry, použijte i funkci pro
zjǐstěńı počtu řádk̊u a sloupc̊u zvlášt’.

5. Pomoćı funkćı rbind nebo cbind vhodně doplňte hodnotami 1 matici A3 na
čtvercovou matici a spoč́ıtejte jej́ı determinant, stopu a hodnost.

6. Byla pozorována kvalita ř́ıčńı vody. Z údaj̊u v následuj́ıćı tabulce

tvrdost vodivost koncentrace drasĺıku

lokalita 1
měřeńı 1 19.4 0.832 1.9
měřeńı 2 18.9 0.84 2.4

lokalita 2
měřeńı 1 21.2 0.826 2.1
měřeńı 2 17 0.479 1.6

vytvořte pole kvalita s rozměry 2 x 3 x 2, dimenze, řádky i sloupce pojmenujte.

7. Vytvořte matici A, vektory c a d:

A =

 1 0 1
−1 1 1

0 −1 1

, c =

 1
2
3

, d =

(
1
2

)
a matici B o rozměrech 3 x 6 s hodnotami rovnými 1.
a) Řešte systém lineárńıch rovnic Ax = c.
b) Vysvětlete výstupy př́ıkaz̊u A * B, A %*% B, A * c, A * d, c * A, d * A A

%*% c and A %*% d

c) Vhodnými př́ıkazy vytvořte k matici A dolńı trojúhelńıkovou matici C a pro

vektor pravé strany e =

 3
0
1

 řešte soustavu lineárńıch rovnic Cx = e s dolńı

trojúhelńıkovou matićı C.
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Řešeńı.

1. A1 <- matrix(c(seq(from=-1, by=2, length=5), rep(3,5), seq(from=-2,

to=2, length=5)), nrow=3, byrow=T)

2. A2 <- matrix(c(runif(n=3, min=0, max=5), seq(to=3.5, by=0.2,

length=6), rep(NA, 6)), nrow=3)

3. A1[,4]

A1[,4, drop=FALSE]

4. A3 <- A1[c(1,2), seq(from=1, by=2, to=ncol(A1))]

dim(A3), nrow(A3), ncol(A3)

5. A3 <- rbind(A3, rep(1, ncol(A3)))

det(A3), sum(diag(A3)), qr(A3)$rank

6. kvalita <- array(c(19.4, 18.9, 0.832, 0.84, 1.9, 2.4, 21.2, 17,

0.826, 0.479, 2.1, 1.6), dim=c(2, 3, 2), dimnames=list(c("mereni1",

"mereni2"), c("tvrdost", "vodivost", "koncentraceK"),

c("lokalita1", "lokalita2")))

7. A <- matrix(c(1, -1, 0, 0, 1, -1, 1, 1, 1), 3), B <- matrix(1,

nrow=3, ncol=6), c <- matrix(1:3, ncol=1), d <- matrix(1:2, ncol=1)

a) x <- solve(A, c)

b) A * B, A * c, A * d . . . násobeńı po složkách (neodpov́ıdaj́ıćı rozměry),
c * A, d * A . . . násobeńı po složkách, uplatněno pravidlo recycling rule
A %*% B, A %*% c, A %*% d . . . maticové násobeńı,
c) e <- matrix(c(3, 0, 1), nrow=3), backsolve(A, e, upper.tri=FALSE)

nebo pomoćı konstrukce dolńı trojúhelńıkové matice C:
C <- A, C[!lower.tri(A,1)] <- 0, solve(C, e)
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Kapitola 4

Datové tabulky a seznamy

Základńı informace

Datové tabulky jsou datové struktury slouž́ıćı k uchováńı souboru dat, které nacháźı
své uplatněńı předevš́ım při statistickém zpracováńı dat. Jedná se tabulku dat, jej́ıž
sloupce představuj́ı proměnné (pozorované znaky) často r̊uzných datových typ̊u a řádky
představuj́ı jednotlivá pozorováńı.
Daľśımi využ́ıvanými datovými strukturami jsou seznamy. Jedná se o objekty, které
dokáž́ı uchovávat množstv́ı informaćı r̊uzných datových struktur. Jejich využit́ı spoč́ıvá
ve smysluplném uspořádáńı např. vstupńıch a výstupńıch informaćı provedené statis-
tické analýzy do jediného objektu.
V této kapitole se nauč́ıme vytvářet datové tabulky a seznamy a pracovat s nimi.

Výstupy z výuky

Studenti

• se seznámı́ s datovými tabulkami a seznamy, znaj́ı rozd́ıly mezi nimi a umı́ je
vytvářet,

• umı́ několika zp̊usoby vytvářet podmnožiny datových tabulek a seznamů,

• dokáž́ı použ́ıvat funkce pro manipulaci s datovými tabulkami a seznamy.

4.1 Základńı př́ıkazy, tvorba datových tabulek a se-

znamů

Datová tabulka je 2-dimenzionálńı struktura, která slouž́ı k uchováńı souboru dat. Sou-
bor dat se skládá z množiny proměnných (sloupce), které jsou pozorovány na množstv́ı
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př́ıpad̊u (řádky). Jednotlivé sloupce mohou být r̊uzných datových typ̊u, ale prvky
každého sloupce muśı být stejného datového typu. Počet př́ıpad̊u muśı být pro každou
proměnnou stejný.

Seznam je nejobecněǰśı datová struktura v R, která seskupuje několik (r̊uzných) ob-
jekt̊u do objektu větš́ıho rozsahu. Jedná se o datovou strukturu skládaj́ıćı se z posloup-
nosti objekt̊u, kterým se ř́ıká složky. Každá složka může obsahovat objekt jakéhokoliv
datového typu. Seznam tedy může obsahovat vektory r̊uzných datových typ̊u a délek,
matice, pole, datové tabulky, funkce a/nebo jiné seznamy. Proto jsou seznamy vhodnými
výstupy nejr̊uzněǰśıch výpočt̊u.

Rovněž je d̊uležité si uvědomit, že datová tabulka je speciálńım př́ıpadem seznamu.
Nejedná se o nic jiného, než seznam, jehož složky jsou vektory stejné délky a od-
pov́ıdaj́ıćı pozice vyjadřuj́ı stejné př́ıpady (např. výskyt aut červené a modré barvy
během středy).

Datovou tabulku vytvoř́ıme př́ıkazem data.frame(). Pomoćı přǐrazeńı názv̊u vek-
tor̊um v seznamu argument̊u nazev 1=vektor 1, nazev 2=vektor 2, ... můžeme spe-
cifikovat názvy sloupc̊u (proměnných) a jejich hodnoty. Názvy sloupc̊u jsou nepovinné,
stač́ı zadat pouze hodnoty - v tomto př́ıpadě jsou názvy proměnných zvoleny implicitně
na základě pravidel stanovených jazykem R. Argument row.names (implicitńı nastaveńı
NULL př́ıpady č́ısluje) specifikuje názvy př́ıpad̊u. Argument check.names s implicitńım
nastaveńım TRUE kontroluje, zda jsou názvy proměnných syntakticky správné a zda se
neopakuj́ı, v př́ıpadě duplikaćı se stará o jejich přejmenováńı.

> data.frame(obor=factor(c(1, 0, 0, 1, 1), labels=c("OM", "MAEK")),

+ body=c(18, 13, 15, 20, 15))
obor body

1 MAEK 18

2 OM 13

3 OM 15

4 MAEK 20

5 MAEK 15
> data.frame(obor=factor(c(1, 0, 0, 1, 1), labels=c("OM", "MAEK")),

+ body=c(18, 13, 15, 20, 15), row.names=c("Petr", "Pavel", "Jirina",

+ "Adela", "Matej"))
obor body

Petr MAEK 18

Pavel OM 13

Jirina OM 15

Adela MAEK 20

Matej MAEK 15
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> data.frame(a=c(1,2), a=c(T,F), check.names=T)
a a.1

1 1 TRUE

2 2 FALSE
> data.frame(a=c(1,2), a=c(T,F), check.names=F)

a a

1 1 TRUE

2 2 FALSE

Funkce list() slouž́ı k vytvořeńı seznamu. Stejně jako u funkce data.frame()

mohou být i složky seznamu pojmenovány pomoćı argument̊u nazev 1=slozka 1,

nazev 2=slozka 2, ....

> (l <- list(barva=c("cervena", "modra", "bila"), data.frame(Petr=

+ sample(5, replace=T), Pavel=1:5, row.names=c("po","ut", "st", "ct",

+ "pa"))))

$barva

[1] "cervena" "modra" "bila"

[[3]]
Petr Pavel

po 1 1

ut 3 2

st 3 3

ct 5 4

pa 3 5

Funkce dim(), names() a contents() slouž́ı k výpisu vlastnost́ı datové tabulky.
Funkce dim() vypisuje rozměry datové tabulky, funkce names() zobrazuje názvy pro-
měnných. Funkce contents() vraćı vnitřńı strukturu datové tabulky. Funkce je obsa-
žena v baĺıčku Hmisc, který neńı ve standardńı distribuci, je třeba jej proto doinstalovat
př́ıkazem install.packages("Hmisc") a nač́ıst př́ıkazem library(Hmisc).

K výpisu vlastnost́ı seznamu můžeme použ́ıt funkci names(), která vraćı názvy
složek seznamu. Funkce dim() a contents() u seznamu použ́ıt nemůžeme, můžeme je
ovšem nahradit funkcemi length(), která vraćı počet složek seznamu, a str(), která
vypisuje vnitřńı strukturu seznamu.

4.2 Podmnožiny datových tabulek a seznamů

K vypsáńı podmnožiny seznamu můžeme použ́ıt jednoduchých [ ] nebo dvojitých [[ ]]

hranatých závorek. Jednoduchými závorkami uvád́ıme, které složky seznamu chceme
źıskat. Jestliže jednotlivé složky seznamu nejsou pojmenovány, požadovanou složku spe-
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cifikujeme jej́ım č́ıslem. K výpisu v́ıce složek můžeme použ́ıt operátoru : nebo funkce
c(). Jestliže jsou složky seznamu pojmenovány, požadované prvky specifikujeme jejich
názvy v uvozovkách. Podmnožina seznamu vytvořená pomoćı jednoduchých hranatých
závorek je opět typu seznam.

Naopak, př́ıkaz pro vytvářeńı podmnožiny pomoćı dvojitých hranatých závorek
vraćı objekt takového typu, jakým byl při definováńı seznamu. V tomto př́ıpadě je na
každou složku odkazováno jednotlivě, nepouž́ıvá se proto operátor : ani funkce c().
Stejně jako u jednoduchých hranatých závorek, na každou složku je odkazováno jej́ım
č́ıslem, má-li požadovaná složka název, můžeme na ni odkazovat jej́ım názvem v uvo-
zovkách nebo můžeme použ́ıt operátoru $.

> l <- list(barva=c("cervena", "modra", "bila"), matrix(1:4, 2),

+ data.frame(Petr=sample(5, replace=T), Pavel=1:5, row.names=c("po",

+ "ut", "st", "ct", "pa")))

> l["barva"]

$barva

[1] "cervena" "modra" "bila"

> typeof(l["barva"]) př́ıkaz typeof() urč́ı typ svého argumentu
[1] "list"

> l[[2]]
[,1] [,2]

[1,] 1 3

[2,] 2 4
> typeof(l[[2]])

[1] "integer"

> typeof(l$barva)

[1] "character"

Protože datové tabulky jsou speciálńım př́ıpadem seznamů, řádky a/nebo sloupce
tabulky dat mohou být źıskány pomoćı [ ], [[ ]] a/nebo operátoru $. Datové tabulky
mohou být považovány i za zobecněné matice, k vytvořeńı podmnožiny můžeme proto
použ́ıt [,].

> tab <- data.frame(cervena=c(1,2,3), modra=c(3,6,0), bila=c(2,5,1),

+ row.names=c("pondeli", "utery", "streda"))

> tab[1]
cervena

pondeli 1

utery 2

streda 3
> typeof(tab[1])

[1] "list"
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> tab[[1]] ekvivalentńı př́ıkaz př́ıkaz̊um tab[["cervena"]] a tab$cervena

[1] 1 2 3

> typeof(tab[[1]]); typeof(tab[["cervena"]]; typeof(tab$cervena))

[1] "double"

[1] "double"

[1] "double"

> tab["utery", "bila"]

[1] 5

K výběru podmnožiny datové tabulky slouž́ı i př́ıkaz subset(x, ). Argument x

specifikuje název datové tabulky, z ńıž podmnožinu vyb́ıráme. Argument subset spe-
cifikuje řádky vyhovuj́ıćı dané podmı́nce, přičemž hodnoty NA jsou brány jako FALSE.
Argument select specifikuje sloupce, které chceme vypsat, můžeme použ́ıt funkce c(),
operátoru : i operátoru - pro vynecháńı složek.

> subset(tab, subset=cervena==3, select=c(modra, bila))
modra bila

streda 0 1

Funkce subset() vždy vraćı tabulku dat, i když má jen jeden řádek nebo sloupec.
K tomu, aby vrátila jen jednoduchý vektor, muśıme za vlastńı definici podmnožiny
datové tabulky použ́ıt operátor $, za ńımž následuje název sloupce:

> tab["pondeli", "cervena"]

[1] 1

> subset(tab, subset=cervena==1, select=cervena)
cervena

pondeli 1
> subset(tab, subset=cervena==1, select=cervena)$cervena

[1] 1

4.3 Funkce pro manipulaci s datovými tabulkami a

seznamy

Přidáńı daľśıch sloupc̊u
Prvńım zp̊usobem, jak do datové tabulky přidat nový sloupec s hodnotami, je př́ıkaz

tvaru

datová tabulka$nazev noveho sloupce <- hodnoty.

Druhým zp̊usobem je provést přǐrazeńı pomoćı funkce data.frame() (bez přǐrazeńı
zobrazuje nové hodnoty pouze dočasně).
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> (knihy <- data.frame(nazev=c("Dekameron", "Maj", "Temno", "Bidnici",

+ "Babicka"), autor=c("Boccaccio", "Macha", "Jirasek", "Hugo",

+ "Nemcova")))
nazev autor

1 Dekameron Boccaccio

2 Maj Macha

3 Temno Jirasek

4 Bidnici Hugo

5 Babicka Nemcova
> knihy$pocet <- c(3, 6, 4, 3, 5)

> knihy
nazev autor pocet

1 Dekameron Boccaccio 3

2 Maj Macha 6

3 Temno Jirasek 4

4 Bidnici Hugo 3

5 Babicka Nemcova 5
> (knihy <- data.frame(knihy, k dispozici=c(F, F, T, F, T)))

nazev autor pocet k dispozici

1 Dekameron Boccaccio 3 FALSE

2 Maj Macha 6 FALSE

3 Temno Jirasek 4 TRUE

4 Bidnici Hugo 3 FALSE

5 Babicka Nemcova 5 TRUE

Funkce transform() pouze tiskne aktuálńı datovou tabulku, nepřidává nastálo no-
vou proměnnou (v opačném př́ıpadě muśıme provést přǐrazeńı).

> transform(knihy, rok=c(1971, 1997, 1983, 2003, 1992)) přidá sloupec
rok s danými hodnotami, proměnná knihy ovšem z̊ustane nezměněna

nazev autor pocet k dispozici rok

1 Dekameron Boccaccio 3 FALSE 1971

2 Maj Macha 6 FALSE 1997

3 Temno Jirasek 4 TRUE 1983

4 Bidnici Hugo 3 FALSE 2003

5 Babicka Nemcova 5 TRUE 1992

Pro přidáńı daľśıch složek do seznamu lze pomoćı operátoru přǐrazeńı, a to jednou
z možnost́ı

seznam$nova slozka <- objekt

seznam[["nova slozka"]] <- objekt

seznam["nova slozka"] <- objekt.
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> (vyzkum <- list(n=28, lokalita="Brno"))

$n

[1] 28

$lokalita

[1] "Brno"

> vyzkum$obdobi <- 2004:2012

> vyzkum[["jakost"]] <- factor(c(0, 1, 1, 1, 0, 0, 1, 0, 1, 1), labels=

+ c("1", "2"))

> vyzkum

$n

[1] 28

$lokalita

[1] "Brno"

$obdobi

[1] 2004 2005 2006 2007 2008 2009 2010 2011 2012

$jakost

[1] 1 2 2 2 1 1 2 1 2 2

Levels: 1 2

Odstraňováńı řádk̊u a sloupc̊u
Každý sloupec můžeme z datové tabulky odstranit použit́ım operátoru $ nebo [ ]

nastaveńım na hodnotu NULL. Daľśım zp̊usobem je použit́ı operátoru [ , ] k výběru
podmnožiny datové tabulky a přepsáńı p̊uvodńı proměnné.

> knihy
nazev autor pocet k dispozici

1 Dekameron Boccaccio 3 FALSE

2 Maj Macha 6 FALSE

3 Temno Jirasek 4 TRUE

4 Bidnici Hugo 3 FALSE

5 Babicka Nemcova 5 TRUE
> knihy$pocet <- NULL analogický př́ıkaz: knihy["pocet"] <- NULL. O tom, že
sloupce byly opravdu odstraněny, se můžeme přesvědčit výpisem názv̊u sloupc̊u (funkce
names())
> names(knihy)

[1] "nazev" "autor" "k dispozici"
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> (knihy <- knihy[1:3, c("nazev", "k dispozici")])

nazev k dispozici

1 Dekameron FALSE

2 Maj FALSE

3 Temno TRUE

Slučováńı
Ke sloučeńı datových tabulek můžeme použ́ıt funkce cbind() nebo rbind(), které

je slouč́ı po sloupćıch nebo řádćıch. Při použit́ı funkce cbind() muśı mı́t přidávané
sloupce stejný počet řádk̊u jako v již existuj́ıćı datové tabulce. Rovněž je vhodné se
přesvědčit, že přidávané sloupce maj́ı stejné pořad́ı řádk̊u. Při použit́ı funkce rbind()

je třeba dodržovat stejný počet sloupc̊u a jejich shodné názvy.

Poznámka. Při spojováńı datové tabulky a vektoru s r̊uznými rozměry docháźı k chy-
bovému hlášeńı, ovšem při spojováńı matice a vektoru o r̊uzných rozměrech je operace
provedena použit́ım pravidla recycling rule a doplněna o varovné hlášeńı.

> zbozi1 <- data.frame(ID=c("X1", "X2", "X3"), cena=c(99, 109, 99),

+ sklad=c(T, T, F))
ID cena sklad

1 X1 99 TRUE

2 X2 109 TRUE

3 X3 99 FALSE
> zbozi2 <- data.frame(ID=c("X4", "X5"), cena=c(99, 89), sklad=c(F, T))

ID cena sklad

1 X4 99 FALSE

2 X5 89 TRUE
> rbind(zbozi1, zbozi2)

ID cena sklad

1 X1 99 TRUE

2 X2 109 TRUE

3 X3 99 FALSE

4 X4 99 FALSE

5 X5 89 TRUE
> zbozi3 <- data.frame(ID=c("X4", "X5"), sklad=c(F, T), cena=c(99, 89))

ID sklad cena

1 X4 FALSE 99

2 X5 TRUE 89
> rbind(zbozi1, zbozi3) tabulky maj́ı odlǐsné názvy sloupc̊u, nelze je spojit
Error in match.names(clabs, names(xi)) :

names do not match previous names
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> zbozi4 <- data.frame(ID=c("X1", "X2", "X4"), barva=c("cerna", "bila",

+ "bila"))
ID barva

1 X1 cerna

2 X2 bila

3 X4 bila
> cbind(zbozi1, zbozi4) tabulky maj́ı stejný počet řádk̊u, dojde proto k jejich
spojeńı (ovšem bez ohledu na to, že je v každé z nich uveden sloupec ID s r̊uznými
hodnotami. Pokud bychom chtěli tomu chováńı předej́ıt, muśıme použ́ıt funkci
merge().)

ID cena sklad ID barva

1 X1 99 TRUE X1 cerna

2 X2 109 TRUE X2 bila

3 X3 99 FALSE X4 bila

Alternativou k funkćım cbind() a rbind() může být již zmı́něná funkce merge().
merge(x, y, by, by.x, by.y, all, all.x, all.y) slouč́ı datové tabulky x a y

by, by.x, by.y specifikuj́ı ty názvy sloupc̊u, podle kterých maj́ı být tabulky
sloučeny. V př́ıpadě stejného názvu sloupc̊u použijeme argument by. Jsou-li názvy
sloupc̊u ke sloučeńı r̊uzné, specifikujeme je pomoćı argument̊u by.x a by.y. V př́ıpadě
v́ıce podmı́nek na spojeńı podmı́nky uvád́ıme ve formě vektoru typu řetězec.

all, all.x a all.y specifikace těch řádk̊u, které se maj́ı objevit na výstupu.
Implicitńı nastaveńı all=FALSE vraćı pouze řádky z pr̊uniku obou tabulek, all=TRUE
vraćı řádky ze sjednoceńı obou tabulek. all.x=TRUE vraćı všechny řádky tabulky x,
analogicky je tomu u all.y=TRUE

Poznámka. Při použit́ı některého z argument̊u all=TRUE, all.x=TRUE nebo all.y=TRUE
maj́ı

”
volná“ mı́sta, která vznikla spojeńım, hodnotu NA.

> (tab1 <- data.frame(auto=c("fiat", "opel", "skoda", "bmw"), barva=

+ c("seda", "cervena", "cerna", "modra"), rok=c(2003, 1999, 2008,

+ 2004)))
auto barva rok

1 fiat seda 2003

2 opel cervena 1999

3 skoda cerna 2008

4 bmw modra 2004
> (tab2 <- data.frame(znacka=c("saab", "bmw", "audi"), majitel=c("muz",

+ "zena", "zena")))
znacka majitel

1 saab muz

2 bmw zena

3 audi zena
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> merge(tab1, tab2) protože tabulky neobsahuj́ı stejný název sloupce, podle
kterého by se sloučeńı mělo ř́ıdit, R vytvoř́ı kartézský součin obou tabulek (tzn. ke
každému řádku tab1 se připoj́ı každý řádek tab2)

auto barva rok znacka majitel

1 fiat seda 2003 saab muz

2 opel cervena 1999 saab muz

3 skoda cerna 2008 saab muz

4 bmw modra 2004 saab muz

5 fiat seda 2003 bmw zena

6 opel cervena 1999 bmw zena

7 skoda cerna 2008 bmw zena

8 bmw modra 2004 bmw zena

9 fiat seda 2003 audi zena

10 opel cervena 1999 audi zena

11 skoda cerna 2008 audi zena

12 bmw modra 2004 audi zena
> merge(tab1, tab2, by.x="auto", by.y="znacka") spojeńı na základě výskytu
bmw v obou sloupćıch auto i znacka

auto barva rok majitel

1 bmw modra 2004 zena
> merge(tab1, tab2, by.x="auto", by.y="znacka", all.x=T) argument
all.x=T zajistil, aby výstup obsahoval všechny hodnoty z tab1

auto barva rok majitel

1 bmw modra 2004 zena

2 fiat seda 2003 <NA>

3 opel cervena 1999 <NA>

4 skoda cerna 2008 <NA>

Řazeńı
K seřazeńı dat v datové tabulce se použ́ıvá funkce order(), která vraćı vektor in-

dex̊u vzestupně (implicitńı nastaveńı decrerasing=FALSE) nebo sestupně (nastaveńı
decreasing=TRUE) uspořádaných prvk̊u. Vı́ce informaćı o funkci order je uvedeno
v odstavci 5.4.

> knihy
nazev autor pocet k dispozici

1 Dekameron Boccaccio 3 FALSE

2 Maj Macha 6 FALSE

3 Temno Jirasek 4 TRUE

4 Bidnici Hugo 3 FALSE

5 Babicka Nemcova 5 TRUE
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> knihy[order(knihy$k dispozici, knihy$nazev),] seřazeńı podle sloupce
k dispozici, v př́ıpadě v́ıce stejných hodnot řazeńı podle sloupce nazev

nazev autor pocet k dispozici

4 Bidnici Hugo 3 FALSE

1 Dekameron Boccaccio 3 FALSE

2 Maj Macha 6 FALSE

5 Babicka Nemcova 5 TRUE

3 Temno Jirasek 4 TRUE

Pokud některý ze sloupc̊u tabulky tvoř́ı numerický vektor, pro sestupné uspořádáńı
této proměnné můžeme na mı́sto argumentu decreasing=TRUE použ́ıt operátoru -.
V př́ıpadě nejednoznačných podmı́nek na seřazeńı (řádky se stejnými hodnotami pro
seřazeńı) dostává na výpisu přednost řádek s nižš́ım pořadovým č́ıslem, u názv̊u řádk̊u
se postupuje podle abecedńıho uspořádáńı.

> knihy[order(knihy$k dispozici, -knihy$pocet),] vzestupné seřazeńı pro-
měnné k dispozici a sestupné seřazeńı proměnné knihy

nazev autor pocet k dispozici

2 Maj Macha 6 FALSE

1 Dekameron Boccaccio 3 FALSE

4 Bidnici Hugo 3 FALSE

5 Babicka Nemcova 5 TRUE

3 Temno Jirasek 4 TRUE

Př́ıklady k procvičeńı

1. Následuj́ıćı tabulka popisuje 10 pacient̊u s podezřeńım na krátkozrakost (myo-
pii). Tabulku přepǐste do systému R jako datovou tabulku myopie1, hodnoty pro
pohlav́ı a myopii rodič̊u zadávejte jako faktor.

ID pohlav́ı délka studie myopie rodič̊u
101 muž 3 ano
102 žena 5 ne
103 žena 2 ne
104 muž 4 ano
105 žena 4 ano
106 muž 3 ano
107 muž 2 ne
108 muž 1 ano
109 žena 7 ano
110 muž 5 ano
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2. Přidáńım nového sloupce pro délku očńı bulvy delka s hodnotami 20.4, 22.7,
21.3, 24.56, 20.9, 21.8, 23.5, 23.9, 19.9, 22.6 vytvořte z tabulky myopie1 tabulku
myopie.
a) Z tabulky myopie odstraňte všechny sudé řádky.
b) Z tabulky myopie odstraňte sloupec ”myopie rodič̊u”. Zjistěte rozměry nově
vzniklé tabulky.
c) Vypǐste ”ID”a ”pohlav́ı”pacient̊u z tabulky myopie1 s délkou studie větš́ı než
čtyři roky.
d) Vypǐste tabulku myopie seřazenou podle délky studie pacient̊u, popř. dle délky
očńı bulvy.

3. Následuj́ıćı tabulku definujte jako datovou tabulku myopie2:

ID barva oč́ı věk
101 modrá 8
102 zelená 11
103 hnědá 9
104 hnědá 14
105 modrá 9
106 šedá 13
107 zelená 9
108 modrá 8
109 modrá 12
110 hnědá 13

Poté slučte tabulky myopie1 a myopie2 na základě ”ID”. Vyzkoušejte sloučeńı
i pomoćı funkce cbind.

4. Vytvořte seznam CR se složkami
”země”: Čechy, Morava, Slezsko,
”města”: Praha, Brno, Ostrava, Plzeň, Olomouc,
”pohoř́ı”:

pohoř́ı vrchol nadmořská výška
Krkonoše Sněžka 1602
Jeseńıky Praděd 1492
Šumava Plechý 1378
Beskydy Lysá hora 1323

Krušné hory Kĺınovec 1244

a) Vypǐste druhou složku seznamu CR ve formě seznamu. Rovněž zjistěte, jakého
je tato složka datového typu.
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b) Přidejte novou složku ”sousedé”: Německo, Rakousko, Slovensko, Polsko.
c) Smažte složku ”země”a pomoćı vhodné funkce zjistěte počet složek seznamu
CR.
d) Spoč́ıtejte pr̊uměrnou nadmořskou výšku pro uvedené vrcholy. (Pro výpočet
pr̊uměru použijte funkci mean()).

Řešeńı.

1. myopie1 <- data.frame(ID=101:110, pohlavi=factor(c(0, 1, 1, 0, 1,

0, 0, 0, 1, 0), labels=c("muz", "zena"), levels=c(0, 1)),

delka.studie=c(3, 5, 2, 4, 4, 3, 2, 1, 7, 5),

myopie.rodic=factor(c(1, 0, 0, 1, 1, 1, 0, 1, 1, 1),

labels=c("ne", "ano"), levels=c(0, 1)))

2. myopie <- data.frame(myopie1, delka=c(20.4, 22.7, 21.3, 24.56,

20.9, 21.8, 23.5, 23.9, 19.9, 22.6))

a) myopie <- myopie[-seq(from=2, by=2, to=nrow(myopie)),]

b) myopie[,"myopie.rodic"] <- NULL, dim(myopie)
c) subset(myopie1, select=c(ID, pohlavi), subset=delka.studie>4)

d) myopie[order(myopie$delka.studie, myopie$delka),]

3. myopie2 <- data.frame(ID=101:110, barva.oci=c("modra", "zelena",

"hneda", "hneda", "modra", "seda", "zelena", "modra", "modra",

"hneda"), vek=c(8, 11, 9, 14, 9, 13, 9, 8, 12, 13))

merge(myopie1, myopie2, by="ID")

cbind(myopie1, myopie2)

4. CR <- list(zeme=c("Cechy", "Morava", "Slezsko"), mesta=c("Praha",

"Brno", "Ostrava", "Plzen", "Olomouc"), pohori=data.frame(pohori=

c("Krkonose", "Jeseniky", "Sumava", "Beskydy", "Krusne hory"),

vrchol=c("Snezka", "Praded", "Plechy", "Lysa hora", "Klinovec"),

nadm.vyska=c(1602, 1492, 1378, 1323, 1244)))

a) CR[2] nebo CR["mesta"], typeof(CR[2])
CR[[2]] nebo CR[["mesta"]] nebo CR$mesta, typeof(CR[[2]])
b) CR$sousede <- c("Nemecko", "Rakousko", "Slovensko", "Polsko") nebo
CR[["sousede"]] <- c("Nemecko", "Rakousko", "Slovensko", "Polsko")

c) CR$zeme <- NULL nebo CR["zeme"] <- NULL

length(CR)

d) mean((CR$pohori))[,3]
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Kapitola 5

Konstanty, operátory a
matematické výpočty

Základńı informace

Kapitola je věnována aritmetickým, porovnávaćım, logickým a množinovým operátor̊um,
jejichž znalost je základńım předpokladem programovaćıch schopnost́ı. Dále jsou uve-
deny matematické funkce, základńı statistické funkce a funkce pro zaokrouhlováńı.
Někdy je pro zjednodušeńı práce velmi výhodné pracovat s vestavěnými konstantami,
které jsou uvedeny na konci kapitoly.

Výstupy z výuky

Studenti

• ovládaj́ı aritmetické operátory, zopakuj́ı si rozd́ıly mezi maticovým násobeńım a
násobeńım po složkách,

• použ́ıvaj́ı porovnávaćı a logické operátory,

• se seznámı́ s množinovými operátory,

• znaj́ı a umı́ vhodně použ́ıt matematické funkce,

• ovládaj́ı funkce pro zaokrouhlováńı a dokáž́ı využ́ıvat zabudovaných konstant.



KAPITOLA 5. KONSTANTY, OPERÁTORY A MATEMATICKÉ VÝPOČTY

5.1 Aritmetické operátory

+ sč́ıtáńı
- odč́ıtáńı
* násobeńı
/ děleńı
^ umocňováńı
%*% maticové násobeńı
%% zbytek po celoč́ıselném děleńı (modulo)
%/% celá část z celoč́ıselného děleńı
t() transpozice matice nebo datové tabulky

Transpozićı (řádkového) vektoru je v jazyce R stále (řádkový) vektor. Trans-
pozićı řádkového vektoru je v systému MATLAB sloupcový vektor.

> a <- c(3, 5, 7, 8); b <- c(1, 2, 3); c <- c(4, 1, 8)

> a + b

[1] 4 7 10 9

Warning message:

In a + b : longer object length is not a multiple of shorter object

length

Protože vektor b je menš́ı délky než vektor a, je potřeba jeho délku zvětšit o jednu po-
zici. (Pravidlo pro postupné opakováńı složek do požadované délky se nazývá recycling
rule.) Posledńı složka výstupńıho vektoru je tedy součtem 4. složky vektoru a a 1.
složky vektoru b. Na stejném principu funguj́ı i všechny ostatńı aritmetické operátory.

MATLAB by v tomto př́ıpadě hlásil chybu a výpočet by neprovedl, protože
sč́ıtance nejsou stejné dimenze.

> "a"+ "b"

Error in "a"+ "b": non-numeric argument to binary operator

Binárńı operátory můžeme použ́ıt pouze na numerické argumenty. Na rozd́ıl od
R, v MATLABu je můžeme použ́ıt i na textové řetězce, které jsou převedeny
na odpov́ıdaj́ıćı kód v ASCII tabulce a následně provedena př́ıslušná operace.
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> b <- 1:3

> c <- c(4, 1, 8)

> b / c

[1] 0.250 2.000 0.375

> b %/% c

[1] 0 2 0

> b %% c

[1] 1 0 3

5.2 Porovnávaćı a logické operátory

Porovnávaćı operátory slouž́ı k porovnáváńı odpov́ıdaj́ıćıch si složek vektor̊u. Na výstupu
dostáváme vektor logických hodnot TRUE a FALSE délky nejdeľśıho vektoru na vstupu.
Hodnoty TRUE obsazuj́ı ty pozice, které splňuj́ı danou podmı́nku, ostatńı pozice jsou
vyplněny hodnotami FALSE.

== rovno
!= neńı rovno

<, <= menš́ı, menš́ı nebo rovno
>, >= větš́ı, větš́ı nebo rovno

& logické a
| logické nebo
! negace

> a <- c(3, 5, 7)

> b <- c(1, 2, 3)

> c <- 1:4

> a <= b

[1] FALSE FALSE FALSE

> a >= 3 & b <= 2

[1] TRUE TRUE FALSE

> !(a == 5 | a == b)

[1] TRUE FALSE TRUE

Při porovnáńı vektor̊u o r̊uzných délkách je uplatněno pravidlo recycling rule:

> b == c

[1] TRUE TRUE TRUE FALSE

Warning message:

In b == c : longer object length is not a multiple of shorter object

length
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5.3 Množinové operátory

all(relace) testuje, zda jsou všechny složky relace pravdivé
any(relace) testuje, zda je alespoň jedna složka relace pravdivá
which(relace) vraćı pořad́ı těch složek relace, které jsou pravdivé

(popř. které splňuj́ı danou podmı́nku). V př́ıpadě
poĺı můžeme použ́ıt argument arr.ind=T pro výpis
hodnot v podobě č́ısel řádk̊u a sloupc̊u, popř.
daľśıch dimenźı

x %in% y, is.element(x, y) testuje, zda je x podmnožinou množiny y, vraćı lo-
gické hodnoty

intersect(x, y) pr̊unik množin x a y

union(x, y) sjednoceńı množin x a y

setdiff(x, y) rozd́ıl množin, vraćı ty prvky vektoru x, které
nejsou obsaženy v y

> x <- 1:10

> y <- 2:9

> z <- -5:5

> all(z) testuje, zda nabývaj́ı všechny prvky vektoru z hodnoty TRUE, v př́ıpadě
numerických vektor̊u odpov́ıdaj́ı hodnotě TRUE nenulové hodnoty
[1] FALSE

> all(z > -10) testuje, zda jsou všechny prvky vektoru z větš́ı než −10
[1] TRUE

> any(z)

[1] TRUE

> all(y) >= x[5]

[1] FALSE

> any(x) == any(y)

[1] TRUE

> m <- matrix(2:10, c(3, 3))
[,1] [,2] [,3]

[1,] 2 5 8

[2,] 3 6 9

[3,] 4 7 10
> which(m > 8 | m == 3)

[1] 2 8 9

> which(m > 8 | m == 3, arr.ind=T)
row col

[1,] 2 1

[2,] 2 3

[3,] 3 3
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> x %in% y

[1] FALSE TRUE TRUE TRUE TRUE TRUE TRUE TRUE TRUE

[10] FALSE

> is.element(y, x)

[1] TRUE TRUE TRUE TRUE TRUE TRUE TRUE TRUE

> union(x[1:5], y[c(7, 8)])

[1] 1 2 3 4 5 8 9

> intersect(x[1:5], y[c(1, 2, 3)])

[1] 2 3 4

> setdiff(x, y)

[1] 1 10

> setdiff(y, x)

integer(0)

5.4 Matematické funkce

Předpokládejme, že objekt x je numerický, komplexńı, logický vektor nebo pole, ope-
race jsou prováděny po složkách.

abs(x), sqrt(x) absolutńı hodnota a druhá odmocnina objektu x

sign(x) signum objektu x

Logaritmické a exponenciálńı funkce:
log(x), log10(x), log2(x) přirozený logaritmus, logaritmus se základem 10 a 2
log(x, base) logaritmus se základem base

exp(x) exponenciálńı funkce x

Trigonometrické a hyperbolické funkce:
cos(x), sin(x), tan(x), cosh(x), sinh(x), tanh(x)

Inverzńı trigonometrické a hyperbolické funkce:
acos(x), asin(x), atan(x), acosh(x), asinh(x), atanh(x)

gamma(x) gamma funkce pro kladná reálná č́ısla x

choose(n, k) kombinačńı č́ıslo
(
n
k

)
pro každé reálné n a přirozené č́ıslo k, n≥k

factorial(x) faktoriál x

max(x), min(x), sum(x), prod(x) vraćı maximálńı a minimálńı prvek, součet a
součin prvk̊u argumentu x. Pro objekty typu matice nebo pole uvedené funkce vraćı na
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výstup jedinou hodnotu ze všech prvk̊u. Pokud budeme požadovat provedeńı operaćı
po složkách, je potřeba použ́ıt některou z funkćı skupiny apply(), v́ıce o nich naleznete
v odstavci 8.5.

MATLAB aplikuje funkce max(), min(), sum() a prod() na matice nikoliv po
prvćıch, ale po sloupćıch.

cummax(x), cummin(x), cumsum(x), cumprod(x) vraćı vektor, jehož složkami jsou
maximum, minimum, kumulativńı součet a součin prvk̊u argumentu x

> a <- c(1, 2, 3, 5, 8, 2, 4, 1, 2, 2)

> cumsum(a)

[1] 1 3 6 11 19 21 25 26 28 30

> cummin(a) vždy nerostoućı posloupnost prvk̊u
[1] 1 1 1 1 1 1 1 1 1 1

> cummax(a) vždy neklesaj́ıćı posloupnost prvk̊u
[1] 1 2 3 5 8 8 8 8 8 8

range(x) vektor obsahuj́ıćı minimum a maximum objektu x, range(x) je ekviva-
lentńı př́ıkazu c(min(x), max(x))

mean(x), median(x) pr̊uměr a medián objektu x

sd(x) směrodatná odchylka objektu x, v př́ıpadě, že x je matice, sd(x) vraćı smě-
rodatnou odchylku jej́ıch sloupc̊u
var(x), cov(x, y), cor(x, y) rozptyl x, kovariance a korelace vektor̊u x, y, v př́ı-
padě, že x, y jsou matice, kovariance a korelace jsou poč́ıtány mezi sloupci x a y

quantile(x) generická funkce, vraćı minimum, dolńı kvartil, medián, horńı kvartil
a maximum objektu x

> c(min(a), max(a)); range(a)

[1] 1 8

[1] 1 8

> mean(a)

[1] 3

> var(a)

[1] 4.666667

> quantile(a)
0 % 25 % 50 % 75 % 100 %

1.00 2.00 2.00 3.75 8.00

pmax(x, y, z, ...), pmin(x, y, z, ...) objekt maximálńıch/minimálńıch prvk̊u
na odpov́ıdaj́ıćıch si pozićıch

> b <- 1:10

> pmin(a, b)

[1] 1 2 3 4 5 2 4 1 2 2
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Pro pole o 2 a v́ıce dimenźıch s numerickými, komplexńımi nebo logickými hodno-
tami nebo pro datové tabulky můžeme použ́ıt následuj́ıćı funkce, které vraćı pr̊uměry,
součty a rozptyly po sloupćıch či řádćıch:
colMeans(x), colSums(x), colVars(x)

rowMeans(x), rowSums(x), rowVars(x)

> (e <- matrix(a,5))
[,1] [,2]

[1,] 1 2

[2,] 2 4

[3,] 3 1

[4,] 5 2

[5,] 8 2
> rowSums(e)

[1] 3 6 4 7 10

sort(x, decreasing, na.last, index.return) seřazeńı objektu x

decreasing=F vzestupné pořad́ı (implicitńı nastaveńı), decreasing=T sestupné
pořad́ı,

na.last=NA zajǐst’uje vynecháńı hodnot NA (implicitńı nastaveńı), na.last=T za-
jǐst’uje, aby hodnoty NA byly řazeny na konec, na.last=F řad́ı hodnoty NA na začátek

index.return=T vyṕı̌se i p̊uvodńı pořad́ı hodnot

order(x, decreasing, na.last) vyṕı̌se indexy seřazených hodnot
na.last=T řad́ı hodnoty NA na konec (implicitńı nastaveńı), na.last=F řad́ı hod-

noty NA na začátek, na.last=NA hodnoty NA vynechává

rank(x, na.last, ties.method) vyṕı̌se pořad́ı jednotlivých hodnot odpov́ıdaj́ıćıch
vzestupně seřazenému vektoru x

na.last stejně jako u funkce order

ties.method nabývá jedné z hodnot c("first", "random", "average", "max",

"min") a použ́ıvá se pro specifikaci řazeńı shodných hodnot. "first" řad́ı vzestupně
podle pozice v řadě, "random" řad́ı náhodně, "average" podle pr̊uměrného pořad́ı (im-
plicitńı nastaveńı) a "min"/"max" podle hodnoty minimálńıho/maximálńıho pořad́ı

rev(x) převráceńı pořad́ı hodnot vektoru

> a <- c(1, 2, 3, 5, 8, NA, 2, 4, 1, 2, 2)

> sort(a) hodnoty NA automaticky vynechává
[1] 1 1 2 2 2 2 3 4 5 8

> sort(a, na.last=F)

[1] NA 1 1 2 2 2 2 3 4 5 8
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> order(a)

[1] 1 9 2 7 10 11 3 8 4 5 6

> rank(a, ties.method="average")

[1] 1.5 4.5 7.0 9.0 10.0 11.0 4.5 8.0 1.5 4.5 4.5

> rev(a)

[1] 2 2 1 4 2 NA 8 5 3 2 1

5.5 Zaokrouhlováńı

Pro zaokrouhlováńı se použ́ıvaj́ı následuj́ıćı funkce:
ceiling() zaokrouhleńı k nejbližš́ımu větš́ımu celému č́ıslu
floor() zaokrouhleńı k nejbližš́ımu menš́ımu celému č́ıslu
trunc() zaokrouhleńı směrem k 0, celá část daného č́ısla
round() zaokrouhleńı k nejbližš́ımu celému č́ıslu, parametrem digits=pocet

voĺıme počet desetinných mı́st, na jaký má být zaokrouhleńı provedeno
(implicitně digits=0)

signif() zaokrouhleńı na určitý počet platných cifer (parametr digits, zbytek
doplńı nulami)

> ceiling(c(3.468575, -3.468575))

[1] 4 -3

> floor(c(3.468575, -3.468575))

[1] 3 -4

> trunc(c(3.468575, -3.468575))

[1] 3 -3

> round(c(3.468575, -3.468575), digits=3)

[1] 3.469 -3.469

> signif(c(3.468575,-3.468575), digits=3)

[1] 3.47 -3.47

Poznámka. Zaokrouhlováńı č́ısla 5: pokud následuj́ı za č́ıslićı 5 jen nuly, č́ıslo je zao-
krouhleno směrem dol̊u, pokud následuje jakákoliv jiná č́ıslice, č́ıslo je zaokrouhleno
nahoru.

> round(7.125, digits=2)

[1] 7.12

> round(7.12501, digits=2)

[1] 7.13
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5.6 Konstanty

Jazyk R má zabudovány konstanty, z nichž nejpouž́ıvaněǰśı jsou:
pi . . . π, Ludolfovo č́ıslo
exp(1) . . . e, základ přirozeného logaritmu, Eulerovo č́ıslo
i . . . i, komplexńı jednotka
.Last.value . . . proměnná obsahuj́ıćı posledńı hodnotu, jež nebyla přǐrazena do žádné
proměnné explicitně
letters . . . malá ṕısmena abecedy
LETTERS . . . velká ṕısmena abecedy
month.name . . . anglické názvy měśıc̊u
month.abb . . . zkratky anglických názv̊u měśıc̊u

> 3

[1] 3

> .Last.value

[1] 3

> LETTERS[9:14]

[1] "I" "J" "K" "L" "M" "N"

> month.name[c(7, 10)]

[1] "July" "October"

Př́ıklady k procvičeńı

1. Definujte vektory v1 s hodnotami 1, 3, 4, v2 jako posloupnost délky 5 s počátečńı
hodnotou -6 a krokem 2 a v3 s prvńımi třemi složkami vektoru v2.
a) Proved’te součet, rozd́ıl, součin a pod́ıl vektor̊u v1 a v3.
b) Vysvětlete výsledky, pokud operace z předchoźıho zadáńı použijete na vektory
v1 a v2.
c) Uved’te celou část a zbytek po děleńı vektoru v1 vektorem v3.
d) Uved’te pozice vektoru v1, jejichž hodnoty jsou r̊uzné od hodnot vektoru v3

na odpov́ıdaj́ıćıch si pozićıch.
e) Uved’te počet prvk̊u vektoru v2, jehož hodnoty jsou menš́ı než -3 nebo rovny
1.
f) Spoč́ıtejte součin nenulových hodnot vektoru v2.
g) Zjistěte, zda je alespoň jeden prvek vektoru v1 nulový.

2. Ve třech laboratoř́ıch byly analyzovány r̊uzné vlastnosti kávy: obsah vody (x1),
hmotnost zrn (x2), pH (x3), tuky (x4), kofein (x5), obsah minerál̊u (x6) a extrakt
(x7). V prvńı laboratoři lab1 byly pozorovány vlastnosti x1, x2, x3, x6, ve druhé
laboratoři lab2 vlastnosti x1, x3, x4, x5 a ve třet́ı laboratoři lab3 vlastnosti x1,
x2 a x5. Zjistěte, které vlastnosti

57



KAPITOLA 5. KONSTANTY, OPERÁTORY A MATEMATICKÉ VÝPOČTY

a) byly analyzovány ve všech třech laboratoř́ıch,
b) byly analyzovány v prvńı i druhé laboratoři, ale ne ve třet́ı,
c) nebyly analyzovány ani jednou z laboratoř́ı,
d) byly analyzovány alespoň jednou z laboratoř́ı.

3. Je dána matice A =

 2 1 3
1 −1 1
8 −27 1

. Spoč́ıtejte jej́ı spektrálńı poloměr, tj.

největš́ı vlastńı č́ıslo v absolutńı hodnotě.

4. Kolika zp̊usoby můžeme z krabičky 20 kuliček vybrat právě 5? Kolika zp̊usoby
bychom mohli vybrat 5 kuliček, záleželo by-li na jejich pořad́ı?

5. Spoč́ıtejte směrnici tečny ke grafu funkce, v́ıte-li, že daná tečna sv́ırá s kladnou
poloosou x úhel 60 ◦.

6. Náhodně vygenerujte vektor 10 celých č́ısel z intervalu [−2, 3].

7. Náhodně vygenerujte vektor v4 šesti hodnot z intervalu [1, 4] a zaokrouhlete jej
na:
a) 3 desetinná mı́sta,
b) 3 platné cifry,
c) směrem k nule.

8. Vypǐste posledńıch 5 velkých ṕısmen abecedy.

9. Vypǐste anglické názvy měśıc̊u, jejichž pořad́ı odpov́ıdá násobk̊um č́ısla 3.

Řešeńı.

1. v1 <- c(1, 3, 4), v2 <- seq(length=4, from=-2, by=2), v3 <- v2[1:3]

nebo v3 <- head(v2, 3)

a) v1 + v3, v1 - v3, v1 * v3, v1 / v3

b) v1 + v2, v1 - v2, v1 * v2, v1 / v2 . . . na kratš́ı vektor použito pravidlo
recycling rule
c) v1 %/% v3, v1 %% v3

d) which(v1 != v3)

e) sum(v2 < -3 | v2 == 1)

f) prod(v2[v2 != 0])

g) any(v1 == 0)

2. lab1 <- c("x1", "x2", "x3", "x6"),
lab2 <- c("x1", "x3", "x4", "x5"),
lab3 <- c("x1", "x2", "x5")
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a) intersect(intersect(lab1, lab2), lab3)

b) setdiff(intersect(lab1, lab2), lab3)

c) setdiff(c("x1", "x2", "x3", "x4", "x5", "x6"),
union(union(lab1, lab2), lab3))

d) union(union(lab1, lab2), lab3))

3. A <- matrix(c(2, 1, 8, 1, -1, -27, 3, 1, 1), 3)

max(abs(eigen(A)$values))

4. choose(20, 5), factorial(20)/factorial(15)

5. tan(pi/3)

6. round(runif(n=10, min=-2, max=3)) nebo
sample(x=-2:3, size=10, rep=T)

7. v4 <- runif(n=6, min=1, max=4)

a) round(v4, 3)

b) signif(v4, 3)

c) trunc(v4)

8. tail(LETTERS, 5)

9. month.name[seq(from=3, by=3, to=12)]
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Kapitola 6

Daľśı př́ıkazy v R

Základńı informace

Jazyk R obsahuje velké množstv́ı funkćı, některé z nich jsou součást́ı standardńı dis-
tribuce, mnohé jsou součást́ı podp̊urných baĺıčk̊u. Pro využit́ı i těchto funkćı je velmi
d̊uležité umět pracovat s baĺıčky – umět je nainstalovat a nač́ıst.
Pro statistickou analýzu dat je rovněž d̊uležité umět pracovat nejen s vestavěnými
datovými soubory, ale rovněž s vlastńımi (exterńımi) datovými soubory. Pro práci
s takovými soubory je potřeba je umět nač́ıst, součást́ı této kapitoly jsou funkce pro
ukládáńı dat a nač́ıtáńı exterńıch datových soubor̊u.
Posledńı část kapitoly tvoř́ı seznam funkćı, který uživatel̊um usnadňuje jednoduše a
přehledně z datových struktur čerpat základńı informace.

Výstupy z výuky

Studenti

• ovládaj́ı práci s knihovnami, umı́ je nainstalovat a nač́ıst,

• dokáž́ı použ́ıt r̊uzné funkce pro nač́ıtáńı dat,

• umı́ ukládat objekty do souboru,

• znaj́ı funkce pro výpis vlastnost́ı objekt̊u.

6.1 Práce s knihovnami

Ne všechny funkce jsou př́ıstupné ze základńıch knihoven, jsou umı́stěny v dodatečných
baĺıčćıch. Výpis aktuálně nainstalovaných knihoven můžeme źıskat př́ıkazem library().
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Př́ıkaz search() vyhledá přiinstalované knihovny.

> search()
[1] ".GlobalEnv" "package:stats" "package:graphics"

[4] "package:grDevices" "package:utils" "package:datasets"

[7] "package:methods" "Autoloads" "package:base"

Mnohdy je zapotřeb́ı přiinstalovat daľśı baĺıčky: záložka Packages → Install Pac-
kage(s) . . . nebo př́ıkazem install.packages("nazev balicku"). Před zahájeńım
práce s přiinstalovanými baĺıčky je třeba je nač́ıst př́ıkazem library(nazev balicku),
až teprve v tomto okamžiku je baĺıček připraven k použ́ıváńı. O tom se znovu můžeme
přesvědčit:

> library(Matrix)

Loading required package : lattice

> search()
[1] ".GlobalEnv" "package:Matrix" "package:lattice"

[4] "package:stats" "package:graphics" "package:grDevices"

[7] "package:utils" "package:datasets" "package:methods"

[10] "Autoloads" "package:base"

6.2 Práce s daty

Funkce pro ukládáńı dat
V prostřed́ı R existuje několik funkćı pro ukládáńı dat. Uživatel by si měl nejdř́ıve roz-
myslet, k jakému účelu bude dále data použ́ıvat - od toho se totiž bude odv́ıjet výběr
správné funkce pro uložeńı dat.

Univerzálńı funkćı pro ukládáńı dat je funkce save(). Funkce se použ́ıvá pro uložeńı
libovolného objektu (nebo v́ıce objekt̊u) do souboru nejčastěji s koncovkou .RData a
.dat (interńı formáty pro uchováńı dat v R), resp. do binárńıho souboru s př́ıponou
.txt. Takto uložené soubory mohou být následně načteny pomoćı funkce load().

save(..., file) funkce pro ukládáńı dat
... názvy ukládaných objekt̊u
file textový řetězec specifikuj́ıćı název souboru pro uložeńı dat

61



KAPITOLA 6. DALŠÍ PŘÍKAZY V R

> v <- 1:5

> mat <- matrix(2:7, 3)

> save(v, mat, file="seznam1.Rdata") uložeńı objekt̊u v a mat

> l <- list(v=1:5, mat=matrix(2:7, 3)) pro ukládáńı v́ıce objekt̊u současně je
mnohdy užitečné seskupit tyto objekty do seznamu a uložit je jako jeden objekt
> save(l, file="seznam2.RData")

> save(v, file="v.txt") uložeńı objektu v do binárńıho souboru v.txt

Daľśı využ́ıvanou funkćı pro ukládáńı dat je funkce write.table(), která slouž́ı
předevš́ım k ukládáńı matic a datových tabulek. Nejtypičtěǰśımi formáty pro ukládáńı
jsou .txt a .csv, soubory obou formát̊u jsou jednoduše zobrazitelné v libovolném tex-
tovém editoru. Takto uložená data mohou být v prostřed́ı R načtena pomoćı funkce
read.table().

write.table(x, file, sep, eol, dec, row.names, col.names) funkce pro ulo-
žeńı matice nebo datové tabulky
x název ukládaného objektu
file textový řetězec specifikuj́ıćı název souboru pro uložeńı dat
sep oddělovač sloupc̊u, implicitńı nastaveńı sep=""
eol znak pro zalomeńı řádk̊u, implicitńı nastaveńı eol="\n"
dec znak pro desetinnou čárku, implicitńı nastaveńı dec="."
row.names logická hodnota indikuj́ıćı, zda maj́ı být uloženy i názvy řádk̊u, resp.

vektor názv̊u př́ıpad̊u
col.names vektor názv̊u proměnných

> krajeCR <- data.frame(nazev=c("Hlavni mesto Praha", "Stredocesky",

+ "Jihocesky", "Plzensky", "Karlovarsky", "Ustecky", "Liberecky",

+ "Kralovehradecky", "Pardubicky", "Olomoucky", "Moravskoslezsky",

+ "Jihomoravsky", "Zlinsky", "Vysocina"),

+ mesto=c("Praha", "Praha", "Ceske Budejovice", "Plzen", "Karlovy "

+ "Vary", "Usti nad Labem", "Liberec", "Hradec Kralove", "Pardubice"

+ "Olomouc", "Ostrava", "Brno", "Zlin", "Jihlava"),

+ SPZ = c("A", "S", "C", "P", "K", "U", "L", "H", "E", "M", "T", "B",

+ "Z", "J"))
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> krajeCR
nazev mesto SPZ

1 Hlavni mesto Praha Praha A

2 Stredocesky Praha S

3 Jihocesky Ceske Budejovice C

4 Plzensky Plzen P

5 Karlovarsky Karlovy Vary K

6 Ustecky Usti nad Labem U

7 Liberecky Liberec L

8 Kralovehradecky Hradec Kralove H

9 Pardubicky Pardubice E

10 Olomoucky Olomouc M

11 Moravskoslezsky Ostrava T

12 Jihomoravsky Brno B

13 Zlinsky Zlin Z

14 Vysocina Jihlava J
> write.table(x=krajeCR, file="krajeCR.csv") uložeńı objektu krajeCR do
souboru krajeCR.csv

> write.table(x=krajeCR, file="krajeCR.txt") uložeńı objektu krajeCR do
souboru krajeCR.txt

Posloupnost jednotlivých př́ıkaz̊u i s jejich výstupy můžeme uložit v menu File →
Save to File. . . . Historii př́ıkaz̊u lze uložit v menu File → Save History nebo př́ıkazem
savehistory(file=".RHistory"), př́ıkazem loadhistory(file=".RHistory") ji mů-
žeme následně nač́ıst. V př́ıpadě, že otev́ıráme dř́ıve uložený soubor, historie př́ıkaz̊u
je načtena automaticky s ńım.

Funkce pro nač́ıtáńı dat
V jazyce R existuje několik funkćı pro nač́ıtáńı dat. Rozlǐsujeme funkce pro nač́ıtáńı dat
ze schránky, exterńıch datových soubor̊u či objekt̊u vytvořených (a uložených) př́ımo
v prostřed́ı R. Zaměř́ıme se na nejpouž́ıvaněǰśı funkce a uvedeme jejich použit́ı.

K nač́ıtáńı objekt̊u vytvořených v prostřed́ı R (soubory s př́ıponou .Rdata a .dat),
resp. soubor̊u s př́ıponou .txt slouž́ı funkce load().

load(file, verbose) pro nač́ıtáńı dat
file textový řetězec specifikuj́ıćı název souboru pro načteńı dat
verbose nastaveńı TRUE na obrazovku vytiskne názvy nač́ıtaných objekt̊u, impli-

citńı nastaveńı verbose=FALSE

> data1 <- load(file="v.txt", verbose=TRUE) načteńı souboru v.txt

Loading objects:

v
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> data1

[1] "v"

> v

[1] 1 2 3 4 5

> data2 <- load(file="seznam1.RData", verbose=TRUE) načteńı datového sou-
boru seznam1.RData, který obsahuje proměnné v a mat

Loading objects:

v

mat

> data2

[1] "v" "mat"

> v

[1] 1 2 3 4 5

> mat
[,1] [,2]

[1,] 2 5

[2,] 3 6

[3,] 4 7

> load(file="dunaj.dat") načteńı dat ze souboru dunaj.dat (data znázorňuj́ıćı
koĺısáńı [m3/s] Dunaje během roku, [8])
> dunaj

[1] 1987 1728 1862 2083 2143 2187 2588 2224 2001

[10] 1767 1460 1444

Pro nač́ıtáńı tabulek (předevš́ım s př́ıponou .txt) slouž́ı funkce read.table().
K nač́ıtáńı datových tabulek ze soubor̊u s př́ıponou .csv lze použ́ıt i výše zmı́něná
funkce read.table(), pro pohodlněǰśı nač́ıtáńı jsou však v prostřed́ı R implemen-
továny funkce read.csv() a read.csv2(). Obě tyto funkce se jen nepatrně lǐśı ve
svých vstupńıch argumentech, pro všechny tři funkce si ukážeme syntaxi a rozd́ıly v je-
jich použit́ı. Podstatné je rovněž zmı́nit, že data načtená těmito funkcemi jsou ukládána
jako objekty v podobě datové tabulky.
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read.table(file, header, sep, dec, row.names, col.names, nrows, skip,

check.names, ...) funkce pro nač́ıtáńı datových tabulek
file textový řetězec uváděj́ıćı cestu k souboru pro načteńı
header logická hodnota pro názvy proměnných v prvńım řádku, implicitńı

nastaveńı header=FALSE
sep oddělovač sloupc̊u
dec znak pro desetinnou čárku
row.names vektor názv̊u řádk̊u
col.names vektor názv̊u sloupc̊u
nrows maximálńı počet řádk̊u, který má být načten
skip počet řádk̊u, který má být přeskočen před samotným načteńım
check.names implicitńı nastaveńı chcek.names=TRUE zajǐst’uje syntaktickou

správnost proměnných

> tab1 <- read.table(file="krajeCR.txt", header=TRUE)

> head(tab1, n=5) pro zkráceńı výpisu zobraźıme pouze prvńıch pět řádk̊u
tabulky

nazev mesto SPZ

1 Hlavni mesto Praha Praha A

2 Stredocesky Praha S

3 Jihocesky Ceske Budejovice C

4 Plzensky Plzen P

5 Karlovarsky Karlovy Vary K

> tab2 <- read.table(file="krajeCR.csv", header=TRUE, sep="")

> head(tab2, n=5)
nazev mesto SPZ

1 Hlavni mesto Praha Praha A

2 Stredocesky Praha S

3 Jihocesky Ceske Budejovice C

4 Plzensky Plzen P

5 Karlovarsky Karlovy Vary K

read.csv(file, header, sep, dec, ...) funkce pro nač́ıtáńı datových tabulek
z .csv souboru
file textový řetězec uváděj́ıćı cestu k souboru pro načteńı
header logická hodnota pro názvy proměnných v prvńım řádku, implicitńı nasta-

veńı header=TRUE
sep oddělovač sloupc̊u, implicitńı nastaveńı sep=","
dec znak pro desetinnou čárku, implicitńı nastaveńı dec="."
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read.csv2(file, header, sep, dec, ...) funkce pro nač́ıtáńı datových tabulek
z .csv souboru
file textový řetězec uváděj́ıćı cestu k souboru pro načteńı
header logická hodnota pro názvy proměnných v prvńım řádku, implicitńı nasta-

veńı header=TRUE
sep oddělovač sloupc̊u, implicitńı nastaveńı sep=";"
dec znak pro desetinnou čárku, implicitńı nastaveńı dec=","

> tab3 <- read.csv(file="krajeCR.csv", sep="")

> head(tab3, n=5)
nazev mesto SPZ

1 Hlavni mesto Praha Praha A

2 Stredocesky Praha S

3 Jihocesky Ceske Budejovice C

4 Plzensky Plzen P

5 Karlovarsky Karlovy Vary K
> lab1 <- read.csv2(file="laborator.csv") soubor laborator.csv obsahuje
údaje o procentuálńım zastoupeńı měřené látky ve dvou odlǐsných laboratoř́ıch
> lab1

laborator obsah.latky

1 1 69.2

2 1 57.1

3 1 62.8

4 2 63.5

5 2 59.7

6 2 60.2
> lab2 <- read.csv(file="laborator.csv", sep=";", dec=",")

> lab2
laborator obsah.latky

1 1 69.2

2 1 57.1

3 1 62.8

4 2 63.5

5 2 59.7

6 2 60.2
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Pro nač́ıtáńı dat ze schránky lze použ́ıt funkce scan(), pro nač́ıtáńı datových tabulek
ze schránky funkce read.table() s argumentam file="clipboard".

scan(file, what, sep, dec, nmax) je funkce pro načteńı vektoru nebo seznamu
z konzole nebo souboru. Popis argument̊u:
file textový řetězec uváděj́ıćı cestu k souboru, při nač́ıtáńı ze schránky

file="clipboard"

what typ nač́ıtané hodnoty (numerické, komplexńı, . . . )
sep znak, kterým jsou odděleny jednotlivé nač́ıtané položky, např. sep=","
dec znak pro desetinnou čárku
nmax maximálńı počet hodnot, který má být načten

Postup pro zobrazeńı hodnot uložených ve schránce:
1. zkoṕırovat př́ıslušná data, např. 2; 4; 6; 1; 3; 5
2. zavolat funkci scan()

> x <- scan(file="clipboard", sep=";")

Po jej́ım zavoláńı se objev́ı oznámeńı:

Read 6 items

> x

[1] 2 4 6 1 3 5

> x <- scan(file="clipboard", sep=";", what=character())

Read 6 items

> x

[1] "2" "4" "6" "1" "3" "5"

1, 2, 3, 4, 5
3, 2, 1, 1, 2

> read.table(file="clipboard", sep=",")
V1 V2 V3 V4 V5

1 1 2 3 4 5

2 3 2 1 1 2

1 2 3 4 5 r1
3 2 1 1 2 r2

> read.table(file="clipboard", row.names=6, col.names=c("sl1", "sl2",

+ "sl3", "sl4", "sl5", "sl6")) přestože posledńı sloupec obsahuje názvy
řádk̊u, argument col.names muśı obsahovat jeho název i tohoto sloupce ("sl6"), i
když nebude vytǐstěn

sl1 sl2 sl3 sl4 sl5

r1 1 2 3 4 5

r2 3 2 1 1 2
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sl1 sl2 sl3 sl4 sl5 sl6
1 2 3 4 5 r1
3 2 1 1 2 r2

> read.table(file="clipboard", row.names=6, header=T)
sl1 sl2 sl3 sl4 sl5

r1 1 2 3 4 5

r2 3 2 1 1 2

V praxi se často setkáváme s datovými formáty ve formátu .xls či .xlsx, o nichž
v textu zat́ım nebyla žádná zmı́nka. Pro nač́ıtáńı dat těchto formát̊u sice existuj́ı funkce
v daľśıch baĺıčćıch, práce s nimi je ovšem natolik obt́ıžná, že je doporučováno nejprve
data převést do .csv souboru a ten poté nač́ıst.

Poznámka. Pro nač́ıtáńı .txt soubor̊u je doporučován následuj́ıćı postup:

1. zobrazeńı souboru v libovolném prohĺıžeči textových dokument̊u,

2. pokud je soubor čitelný, pro načteńı dat je vhodné použit́ı funkce scan(), př́ıp.
read.table() při nač́ıtáńı datových tabulek.

Alternativou rovněž může být zobrazeńı .txt souboru př́ımo v R pomoćı funkce
readLines(). Pokud je soubor v

”
čitelném“ formátu, výpis bude čitelný i v R a

k načteńı dat je možno použ́ıt funkci read.table(). Pokud je soubor v binárńım
formátu, výpis je nečitelný (nedává smysl) a k načteńı dat je třeba použ́ıt funkci
load().

> readLines("v.txt") v (binárńım) souboru je uložen vektor v, k uložeńı byl použit
př́ıkaz save(v, file="v.txt")

[1] "RDX2""X" "" ""

Warning messages:

1: In readLines("v.txt") : line 3 appears to contain an embedded nul

2: In readLines("v.txt") : line 4 appears to contain an embedded nul

3: In readLines("v.txt") : incomplete final line found on ’v.txt’

> load("v.txt")

> v

[1] 1 2 3 4 5
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> readLines("krajeCR.txt") v souboru je uložena datová tabulka krajeCR,
k uložeńı byl použit př́ıkaz write.table(krajeCR, file="krajeCR.txt"), výpis je
čitelný (dává smysl)
[1] "\"nazev\"\"mesto\"\"SPZ \""

[2] "\"1\"\"Hlavni mesto Praha\"\"Praha\"\"A\""

[3] "\"2\"\"Stredocesky\"\"Praha\"\"S\""

[4] "\"3\"\"Jihocesky\"\"Ceske Budejovice\"\"C\""

[5] "\"4\"\"Plzensky\"\"Plzen\"\"P\""

[6] "\"5\"\"Karlovarsky\"\"Karlovy Vary\"\"K\""

[7] "\"6\"\"Ustecky\"\"Usti nad Labem\"\"U\""

[8] "\"7\"\"Liberecky\"\"Liberec\"\"L\""

[9] "\"8\"\"Kralovehradecky\"\"Hradec Kralove\"\"H\""

[10] "\"9\"\"Pardubicky\"\"Pardubice\"\"E\""

[11] "\"10\"\"Olomoucky\"\"Olomouc\"\"M\""

[12] "\"11\"\"Moravskoslezsky\"\"Ostrava\"\"T\""

[13] "\"12\"\"Jihomoravsky\"\"Brno\"\"B\""

[14] "\"13\"\"Zlinsky\"\"Zlin\"\"Z\""

[15] "\"14\"\"Vysocina\"\"Jihlava\"\"J\""

> krajeCR <- read.table("krajeCR.txt")

> krajeCR

> head(krajeCR, n=5)
nazev mesto SPZ

1 Hlavni mesto Praha Praha A

2 Stredocesky Praha S

3 Jihocesky Ceske Budejovice C

4 Plzensky Plzen P

5 Karlovarsky Karlovy Vary K

6 Ustecky Usti nad Labem U

7 Liberecky Liberec L

8 Kralovehradecky Hradec Kralove H

9 Pardubicky Pardubice E

10 Olomoucky Olomouc M

11 Moravskoslezsky Ostrava T

12 Jihomoravsky Brno B

13 Zlinsky Zlin Z

14 Vysocina Jihlava J
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Pro usnadněńı práce s daty jazyk R obsahuje okolo sta vestavěných datových sou-
bor̊u (v baĺıčku datasets). Funkce data() zobraźı seznam dostupných datových sou-
bor̊u. K zobrazeńı vybraných soubor̊u slouž́ı př́ıkaz data(nazev, package)1, argument
package slouž́ı ke specifikaci baĺıčku, ve kterém se data nacháźı.

Daľśımi užitečnými funkcemi jsou attach() a detach().
Funkce attach() má použit́ı zejména u seznamů a datových tabulek, kde umožňuje
vypisováńı jejich složek př́ımo, tzn. bez uvedeńı názvu objektu. Argumentem funkce je
název objektu, u kterého chceme výše uvedené provést.

> tabulka <- data.frame(id=c(1:6), skupina=c(1, 2, 2, 1, 2, 1),

+ hodnota=runif(6, 2, 4))

> id

Error : object ’id’ not found

> attach(tabulka)

> id

[1] 1 2 3 4 5 6

Opakem k funkci attach je funkce detach, která naopak znemožńı, aby byly složky
volány pouze svým názvem, nikoliv uvedeńım i názvu objektu.

> detach(tabulka)

> id

Error : object ’id’ not found

> tabulka$id

[1] 1 2 3 4 5 6

6.3 Vlastnosti objekt̊u

Se základńımi vlastnostmi objekt̊u jsme se již seznámili v předešlých kapitolách. Zde si
uvedeme některé daľśı funkce, které nám o vnitřńı struktuře objekt̊u vypov́ı mnohem
v́ıce.

summary(object) jedná se o tzv. generickou funkci (funkce, která si nejprve zjist́ı,
jakého typu je jej́ı parametr, podle něj pak vypisuje celkový přehled: pro vektory vraćı
základńı charakteristiky polohy, pro faktory vraćı četnosti jednotlivých složek)

1Od verze 2.0.0 jsou všechny datové soubory př́ıstupné př́ımo zavoláńım jejich názvu. Mnohé baĺıčky
ovšem stále použ́ıvaj́ı dř́ıvěǰśı zp̊usob voláńı pomoćı data(nazev), jenž může být stále využ́ıván i dnes.
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> (a <- c(1, 2, 3, 5, 8, 2, 4, 1, 2, 2))

[1] 1 2 3 5 8 2 4 1 2 2

> summary(a) v př́ıpadě č́ıselných vektor̊u funkce summary() vraćı minimum, 1.
kvartil, medián, pr̊uměr, 3. kvartil a maximum
Min. 1st Qu. Median Mean 3rd Qu. Max.

1.00 2.00 2.00 3.00 3.75 8.00
> (b <- c(1+3i, 7-1i, NA))

[1] 1+3i 7-1i NA

> summary(b)
Length Class Mode

3 complex complex
> (c <- c(T, T, F, T, F))

[1] TRUE TRUE FALSE TRUE FALSE

> summary(c)
Mode FALSE TRUE NA’s

logical 2 3 0
> (d <- c("k", "l", "l", "m"))

[1] "k" "l" "l" "m"

> summary(d)
Length Class Mode

4 character character
> (e <- matrix(a, c(5, 2)))

[,1] [,2]

[1,] 1 2

[2,] 2 4

[3,] 3 1

[4,] 5 2

[5,] 8 2
> summary(e) vyṕı̌se přehled pro každý sloupec

V1 V2

Min. :1.0 Min. :1.0

1st Qu.:2.0 1st Qu.:2.0

Median :3.0 Median :2.0

Mean :3.8 Mean :2.2

3rd Qu.:5.0 3rd Qu.:2.0

Max. :8.0 Max. :4.0
> (f <- factor(a))

[1] 1 2 3 5 8 2 4 1 2 2

Levels: 1 2 3 4 5 8

> summary(f) vypisuje četnosti jednotlivých úrovńı faktoru (Levels)
1 2 3 4 5 8

2 4 1 1 1 1
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> (tab <- data.frame(cervena=c(15, 14, 12, 12), seda=c(13, 17, 10, 9),

+ zelena=c(7, 9, 8, 6)))
cervena seda zelena

1 15 13 7

2 14 17 9

3 12 10 8

4 12 9 6

> summary(tab) opět vypisuje přehled pro každý sloupec zvlášt’

cervena seda zelena

Min. :12.00 Min. : 9.00 Min. :6.00

1st Qu.:12.00 1st Qu.: 9.75 1st Qu.:6.75

Median :13.00 Median :11.50 Median :7.50

Mean :13.25 Mean :12.25 Mean :7.50

3rd Qu.:14.25 3rd Qu.:14.00 3rd Qu.:8.25

Max. :15.00 Max. :17.77 Max. :9.00

str(object) přehledně vyṕı̌se podrobnou vnitřńı strukturu objektu, je alternati-
vou k funkci summary() s t́ım rozd́ılem, že výpis provád́ı do řádku

> str(a)

num [1:10] 1 2 3 5 8 2 4 1 2 2

> str(b)

cplx [1:3] 1+3i 7-1i NA

> str(c)

logi [1:5] TRUE TRUE FALSE TRUE FALSE

> str(d)

chr [1:4] "k" "l" "l" "m"

> str(e)

num [1:5, 1:2] 1 2 3 5 8 2 4 1 2 2

> str(f)

Factor w/ 6 levels "1" "2" "3" "4",..: 1 2 3 5 8 2

4 1 2 2

> str(tab)

’data.frame’: 4 obs. of 3 variables
$ cervena: num 15 14 12 12

$ seda : num 13 17 10 9

$ zelena : num 7 9 8 6

comment(object) nastav́ı nebo vyṕı̌se komentář k danému objektu

> comment(tab) <- "Pocty aut jednotlivych barev behem 4 casovych

+ obdobi." nastaveńı komentáře k objektu tab
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> comment(tab) zobrazeńı komentáře
[1] "Pocty aut jednotlivych barev behem 4 casovych obdobi."

attributes(object) vypisuje všechny atributy objektu. K výpisu nebo nastaveńı
konkrétńı vlastnosti objektu slouž́ı př́ıkaz attr(object, name), kde parametr name

udává název zjǐst’ované vlastnosti.

> (ar <- array(1:8, c(2, 2, 2)))

, , 1
[,1] [,2]

[1,] 1 2

[2,] 2 4
, , 2

[,1] [,2]

[1,] 5 7

[2,] 6 8
> attributes(ar)

$dim

[1] 2 2 2

> attributes(f)

$levels

[1] "1" "2" "3" "4" "5" "8"

$class

[1] "factor"

> attributes(tab)

$names

[1] "cervena" "seda" "zelena"

$row.names

[1] 1 2 3 4

$class

[1] "data.frame"

$comment

[1] "Pocty aut jednotlivych barev behem 4 casovych obdobi."

> attr(tab, "names")

[1] "cervena" "seda" "zelena"

73



KAPITOLA 6. DALŠÍ PŘÍKAZY V R

Funkce as.something() umožňuje změny datových typ̊u všude, kde je to smyslu-
plné.

> u <- 1:10

[1] 1 2 3 4 5 6 7 8 9 10

> v <- as.character(u) převede numerický vektor na vektor textových hodnot
[1] "1" "2" "3" "4" "5" "6" "7" "8" "9" "10"

> w <- as.integer(v) převede vektor textových hodnot na numerický vektor, vek-
tory u a w jsou stejného typu
[1] 1 2 3 4 5 6 7 8 9 10

K převodu objekt̊u z jednoho datového typu na druhý je k dispozici velké množstv́ı
funkćı typu as.something(). Jejich seznam můžeme naj́ıt př́ıkazem methods(as).

Př́ıklady k procvičeńı

1. Do pracovńıho adresáře načtěte soubor strom.dat. Součást́ı tohoto souboru je
objekt strom.
a) Vhodným př́ıkazem zjistěte informace o vnitřńı struktuře tohoto objektu.
b) Zjistěte, zda je pro tento objekt vytvořen komentář. V př́ıpadě že neńı, stručný
komentář pro něj vytvořte.
c) Převed’te tento objekt na textovou matici strom1.

2. Nainstalujte a načtěte knihovnu Hmisc. Na objektu strom porovnejte výstup
funkce describe() z této knihovny s funkcemi str() a attributes(). Výstup
funkce describe() uložte do proměnné descr.

3. Do proměnné mereni1 načtěte soubor mereni.txt i s názvy řádk̊u a sloupc̊u.

4. Umožněte, aby na jednotlivé sloupce proměnné mereni1 mohlo být odkazováno
př́ımo.

5. Spojte proměnné strom, strom1, descr a metoda2 do seznamu seznam, ten uložte
do souboru seznam.dat. Výpisem soubor̊u pracovńıho adresáře se přesvědčte, že
jste tak opravdu učinili.

Řešeńı.

1. load("strom.dat")

a) summary(strom)
b) comment(strom) <- "Metody mereni vysky stromu"

c) strom1 <- as.matrix(strom)

2. install.packages("Hmisc"), library(Hmisc)
descr <- describe(strom), str(strom), attributes(strom)
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3. mereni1 <- read.table(file="mereni.txt")

4. attach(mereni1)

5. seznam <- list(strom=strom, strom1=strom1, descr=descr,

metoda2=metoda2)

save(seznam, file="seznam.dat"), dir()
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Kapitola 7

Grafika v R

Základńı informace

Grafika jazyka R patř́ı k jedné z nejv́ıce propracovaných část́ı, nab́ıźı nepřeberné
množstv́ı funkćı pro tvorbu kompletńıch graf̊u včetně popisk̊u (high-level grafika) stejně
jako funkćı k přidáváńı nových část́ı či změně již existuj́ıćıho vzhledu grafu (low-level
grafika).
Ćılem kapitoly je uvést nejv́ıce použ́ıvané argumenty grafických funkćı, seznámit se
s funkćı par, jej́ıž argumenty dokáž́ı zastoupit mnohé low-level funkce, a daľśımi funk-
cemi k tvorbě grafických výstup̊u.

Výstupy z výuky

Studenti

• znaj́ı rozd́ıly mezi high-level a low-level grafikou,

• se seznámı́ s několika př́ıkazy pro tvorbu high-level grafiky a umı́ použ́ıvat jejich
argumenty,

• ovládaj́ı funkce pro vykresleńı základńıch typ̊u graf̊u,

• dokáž́ı vytvářet 3D grafy,

• umı́ použ́ıt funkce pro tvorbu low-level grafiky,

• umı́ využ́ıvat vlastnost́ı funkce par,

• znaj́ı př́ıkazy pro ukládáńı grafu do souboru, umı́ pracovat s podgrafy.

Systém R umožňuje zobrazovat širokou škálu graf̊u. Př́ıkazy k vykreslováńı graf̊u
jsou rozděleny do tř́ı základńıch skupin:
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• High-level funkce vytvář́ı kompletńı nový graf s osami, popisky, názvem atd.

• Low-level funkce přidávaj́ı do již existuj́ıćıho grafu daľśı informace, např. daľśı
body, čáry, popisky.

• Interaktivńı grafika umožňuje interaktivně pomoćı myši přidávat data do již
existuj́ıćıho grafu.

V př́ıpadě, že jsou tyto grafy nedostačuj́ıćı, můžeme použ́ıt daľśıch baĺıčk̊u - např. grid,
lattice, iplots, misc3D, rgl, scatterplot nebo baĺıček maps obsahuj́ıćı nejr̊uzněǰśı
mapy.

7.1 High-level funkce

Všechny grafy jsou nejprve vytvořeny pomoćı high-level funkćı, které vytvář́ı ”kom-
pletńı”graf. Kompletńı v tom smyslu, že jsou automaticky vygenerovány osy, popisky
a nadpis (pokud sami nenastav́ıme jinak). High-level funkce vždy vykresluj́ı nový graf,
v př́ıpadě, že již nějaký graf existuje, přeṕı̌śı jej. Je d̊uležité si uvědomit, že data
k vykresleńı mohou být r̊uzné objekty - podle druhu objektu grafické funkce následně
vykresluj́ı graf.

Argumenty k high-level funkćım:
axes implicitńı hodnota TRUE, nastaveńı na hodnotu FALSE potlačuje vy-

kreslováńı os
log nastaveńım na hodnoty log="x", log="y", log="xy" budou mı́t vy-

brané osy logaritmické měř́ıtko
main textový řetězec pro název grafu, je umı́stěn nad grafem
sub textový řetězec, je umı́stěn pod grafem a psán menš́ım fontem
type typ výstupńıho grafu

type="p" vykresluje samostatné body (implicitńı nastaveńı)
type="l" linie
type="b" přerušované linie s body
type="c" přerušované linie bez bod̊u
type="o" body navzájem spojené liniemi
type="h" vertikálńı linie
type="s" schodovitý graf s prvńı liníı horizontálńı
type="S" schodovitý graf s prvńı liníı vertikálńı
type="n" žádné vykreslováńı dat, vykresleny jsou pouze osy, rozsah
souřadného systému záviśı na datech
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xlab, ylab textové řetězce pro názvy os x a y, tyto argumenty měńı implicitně
zadané názvy os při voláńı high-level funkćı

xlim, ylim 2-prvkový vektor specifikuj́ıćı minimálńı a maximálńı hodnotu k vy-
kresleńı dané osy

Dále jsou uvedeny nejpouž́ıvaněǰśı typy graf̊u se svými argumenty. Nejedná se
o kompletńı výčet argument̊u, uvedeny jsou pouze ty nejd̊uležitěǰśı. Použitá data jsou
uvedena na přiloženém CD.

• plot(x) vzhled grafu záviśı na povaze vstupńıch dat. Pro numerický vektor vraćı
jednoduchý graf s indexy na ose x a hodnotami na ose y, pro matice vraćı graf
s hodnotami prvńıho sloupce na ose x a odpov́ıdaj́ıćımi hodnotami druhého sloupce
na ose y (ostatńı sloupce jsou ignorovány), pro faktory vykresluje sloupcový graf
četnost́ı jednotlivých kategoríı, pro datové tabulky vykresluje bodový graf závislosti
všech proměnných, pro funkce vykresluje hladkou čáru
• plot(x, y) jestliže x a y jsou vektory téže délky, funkce vykresĺı bodový graf
hodnot y na pozićıch x. Stejného výsledku můžeme doćılit nahrazeńım argument̊u x

a y bud’ seznamem, obsahuj́ıćım dvě složky x a y, nebo matićı o dvou sloupćıch (viz
př́ıkaz plot(x)).
Implicitńı vzhled grafu plot(x) a plot(x, y) můžeme upravit pomoćı široké škály
volitelných argument̊u:

main, sub, type

axes, xlim, ylim, xlab, ylab

ann, col, bg, pch, cex, lty, lwd parametry zadávaj́ıćı výpis názvu a po-
pisk̊u os, barvu, barvu pozad́ı grafu, znaky pro vykresleńı bod̊u a jejich velikost, typ a
tloušt’ku čar. Vı́ce informaćı v odstavci 7.3.

frame.plot logická hodnota implicitně nastavená na TRUE graf orámuje
asp poměr osy y/x

> plot(function(x) 2*x^3, xlim=c(-3, 3), ylab="f(x)", main="Graf funkce

+ f(x)=2*x^3")

> benzen <- c(3.34, 4.76, 4.87, 5.11, 3.89, 4.83, 5.02) sedm měřeńı pro
kontrolu obsahu benzenu v ovzduš́ı [mg/mˆ3], [8]
> plot(benzen, pch=8, xlab="cislo pozorovani", ylab="obsah benzenu

+ [mg/m^3]", main="Obsah benzenu v ovzdusi")
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Obr. 7.1. Funkce plot()

> plot(benzen, type="p", main="type=’p’", ylab="benzen [mg/m^3]")

> plot(benzen, type="l", main="type=’l’", ylab="benzen [mg/m^3]")

> plot(benzen, type="b", main="type=’b’", ylab="benzen [mg/m^3]")

> plot(benzen, type="c", main="type=’c’", ylab="benzen [mg/m^3]")

> plot(benzen, type="o", main="type=’o’", ylab="benzen [mg/m^3]")

> plot(benzen, type="h", main="type=’h’", ylab="benzen [mg/m^3]")

> plot(benzen, type="s", main="type=’s’", ylab="benzen [mg/m^3]")

> plot(benzen, type="S", main="type=’S’", ylab="benzen [mg/m^3]")
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Obr. 7.2. Možné varianty argumentu type

• barplot() sloupcový graf
axes, main, sub, xlab, ylab, xlim, ylim

beside lze použ́ıt pouze v př́ıpadě vstupńıho argumentu typu matice. Implicitńı
hodnota beside=FALSE vykresĺı v́ıce obdélńık̊u nad sebou, nastaveńı na hodnotu TRUE

vedle sebe.
width vektor hodnot udávaj́ıćıch š́ı̌rku vykreslovaných obdélńık̊u na ose x. Jestliže

vektor wide nedosahuje délky rovné počtu složek argumentu, je použito pravidlo recyc-
ling rule.

space velikost mı́sta pro vynecháńı mezi jednotlivými sloupci (pod́ıl pr̊uměrné
š́ı̌rky sloupce), může se jednat o numerickou hodnotu nebo vektor hodnot. Pro vstupńı
matici a argument beside=TRUE může být argument space specifikován vektorem dvou
hodnot, prvńı vyjadřuje odestup sloupc̊u ve stejné skupině (ve stejném sloupci), druhý
vyjadřuje odestup mezi skupinami. Implicitńı nastaveńı je space=c(0,1) pro vstupńı
matici a argument beside=TRUE, pro ostatńı možnosti space=0.2.

names.arg vektor názv̊u ke každému sloupci nebo skupině sloupc̊u
legend.text vektor textových řetězc̊u uváděj́ıćı názvy v legendě, má smysl jen

pro vstupńı matice
horiz implicitńı hodnota horiz=FALSE vykresluje obdélńıky vertikálně, argu-

ment horiz=TRUE horizonatálně
density hodnota nebo numerický vektor nastavuj́ıćı hustotu šrafováńı sloupc̊u
angle úhel pro sklon šrafováńı
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> load(file="penicilin.dat") načteńı potřebného souboru dat, který muśı být
uložen v aktuálńım pracovńım adresáři. Data pro porovnáńı obsahu penicilinu [mg/l]
v krvi dvou pacient̊u, [8]
> barplot(penicilin, ylab="obsah penicilinu [mg/l]")

> barplot(penicilin, beside=T, ylab="obsah penicilinu [mg/l]")

> barplot(penicilin, beside=T, ylab="obsah penicilinu [mg/l]",

+ space=c(0.5,1.5), density=c(7,18), angle=c(60,105), col=gray(c(0,

+ 0.6))) funkce gray slouž́ı k vykresleńı r̊uzného stupně šedi (v́ıce v odstavci 7.3)
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Obr. 7.3. Porovnáńı obsahu penicilinu v krvi dvou pacient̊u [mg/l]

> load(file="dunaj.dat") načteńı datového souboru dunaj.dat (koĺısáńı pr̊utoku
Dunaje [m3/s] během roku, [8])
> barplot(dunaj, names.arg=c("I", "II", "III", "IV", "V", "VI", "VII",

+ "VIII", "IX", "X", "XI", "XII"), ylab="prutok [m^3/s]",

+ xlab="mesic")

> barplot(dunaj, horiz=T, names.arg=c("I", "II", "III", "IV", "V",

+ "VI", "VII", "VIII", "IX", "X", "XI", "XII"), ylab="prutok

+ [m^3/s]", xlab="mesic")

> barplot(dunaj, width=c(1, 2, 3), density=rep(c(5, 8, 13), times=4),

+ angle=seq(from=30, by=10, length=12), names.arg=c("I", "II", "III",

+ "IV", "V", "VI", "VII", "VIII", "IX", "X", "XI", "XII"), ylab="prutok

+ [m^3/s]", xlab="mesic")

> barplot(dunaj, col=gray(seq(from=0, to=1, length=12)), names.arg=

+ c("I", "II", "III", "IV", "V", "VI", "VII", "VIII", "IX", "X", "XI",

+ "XII"), ylab="prutok [m^3/s]", xlab="mesic")
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Obr. 7.4. Koĺısáńı pr̊utoku Dunaje během roku [mˆ3/s]

• hist() histogram pro numerický vektor
breaks argument š́ı̌rky interval̊u, implicitńı nastaveńı je breaks="Sturges", která

š́ı̌rku interval̊u poč́ıtá Sturgesovým pravidlem: log2 n+ 1, [18], daľśımi možnostmi jsou
breaks="Scott" (Scottovo pravidlo: 3.5·σ̂ ·n−1/3, [18]) nebo breaks="FD" (Freedman a
Diaconis: 2·IQR·n−1/3, [18]), n udává počet hodnot vektoru, σ̂ je odhadem směrodatné
odchylky a IQR znač́ı interkvantilové rozpět́ı

freq implicitńı nastaveńı freq=TRUE vykresluje absolutńı četnosti, nastaveńı na
hodnotu freq=FALSE vykresluje relativńı četnosti

right pro implicitńı hodnotu right=TRUE jsou intervaly zprava uzavřené, zleva
otevřené, pro hodnotu right=FALSE je tomu naopak

labels pro hodnotu labels=TRUE vypisuje nad sloupce absolutńı/relativńı četnosti
density, angle stejně jako u barplot()

axes, main, sub, xlim, ylim, xlab, ylab

Funkce hist() má k dispozici i výstupńı hodnoty:
breaks hodnoty hranic interval̊u
counts absolutńı četnosti pro každý interval
density hustota pravděpodobnosti pro jednotlivé intervaly
intensities shodné s density

mids středy interval̊u
xname název objektu v argumentu
equidist logická hodnota stejné délky všech interval̊u

> load(file="obili.dat") načteńı souboru dat (sklizňová ztráta obiĺı [g/m3], [8])
> hist(obili, breaks="Sturges", main="breaks=’Sturges’")

> hist(obili, breaks="Scott", main="breaks=’Scott’")

> hist(obili, breaks="FD", main="breaks=’FD’")
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Obr. 7.5. Sklizňová ztráta obiĺı [g/mˆ3], argumenty š́ı̌rky interval̊u

> hist(obili, main="")

> hist(obili, freq=F, main="")

> hist(obili, labels=T, main="")
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Obr. 7.6. Sklizňová ztráta obiĺı [g/mˆ3], zobrazeńı absolutńıch a relativńıch četnost́ı
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> (hist(obili)) výstupńı hodnoty
$breaks

[1] 3 4 5 6 7 8 9 10

$counts

[1] 2 0 5 8 2 2 1

$intensities

[1] 0.09999998 0.00000000 0.25000000 0.40000000 0.10000000

+ 0.10000000 0.05000000

$density

[1] 0.09999998 0.00000000 0.25000000 0.40000000 0.10000000

+ 0.10000000 0.05000000

$mids

[1] 3.5 4.5 5.5 6.5 7.5 8.5 9.5

$xname

[1] "obili"

$equidist

[1] TRUE

$attr(,"class")

[1] "histogram"

• pie() koláčový graf pro vektor nezáporných celých č́ısel
labels vektor textových hodnot vyjadřuj́ıćı názvy jednotlivých d́ıl̊u grafu
edges numerická hodnota udávaj́ıćı počet vrchol̊u polygonu
clockwise logická hodnota vykresleńı po (TRUE) nebo proti (FALSE, implicitńı

nastaveńı) směru hodinových ručiček
init.angle počátečńı úhel pro natočeńı grafu
density, angle

84



KAPITOLA 7. GRAFIKA V R

> kralici <- c(3, 4, 2, 5, 3)

> pie(kralici, angle=30, labels=c("lokalita

+ 1", "lokalita 2", "lokalita 3", "lokalita 4", "lokalita 5"),

+ col=gray(seq(from=0, to=1, length=5)))

> pie(kralici, edges=5, col=gray(seq(from=0, to=1, length=5)))

> pie(kralici, clockwise=F, init.angle=90, col=gray(seq(from=0, to=1,

+ length=5)))

lokalita 1

lokalita 2

lokalita 3

lokalita 4

lokalita 5

1

2

3

4

5

1

2

3

4

5

Obr. 7.7. Počet chycených kráĺık̊u v jednotlivých lokalitách lesa, [8]

• boxplot() krabicový graf
range vymezuje rozpět́ı ”fousk̊u”grafu, pro kladné range se ”fousky”rozṕınaj́ı

do vzdálenosti range ·IQR (interkvartilová odchylka), pro range=0 se rozṕınaj́ı od
minimálńı po maximálńı hodnotu, implicitńı nastaveńı range=1.5

notch implicitńı nastaveńı notch=FALSE, pro notch=TRUE zobrazuje výřezy po
stranách ”krabice”(výřezy odpov́ıdaj́ı hodnotám ±1.58·IQR√

n
)

outline implicitńı nastaveńı outline=TRUE zobrazuje odlehlé hodnoty, hodnota
FALSE odlehlé hodnoty nezobrazuje

names vektor textových řetězc̊u pro názvy jednotlivých krabicových graf̊u
horizontal pro hodnotu horizontal=TRUE vykresluje grafy horizontálně
pars seznam parametr̊u k volbě vzhledu krabicového grafu (velikosti ”krabic”,

hodnoty ”fousk̊u”a extrémů, typy, š́ı̌rky a barvy čar, velikosti bod̊u atd.), v́ıce pomoćı
př́ıkazu help(bxp)
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Př́ıkazem (boxplot()) źıskáme výstupńı hodnoty:
stats matice, jej́ıž sloupce obsahuj́ı informaci o hodnotách dolńıho ”fousu”, dolńı

části krabice, mediánu, horńı části krabice a horńım ”fousu”.1

n vektor počtu pozorováńı každé skupiny
conf matice, jej́ıž sloupce obsahuj́ı horńı a dolńı extrémy výřez̊u (notch)
out odlehlé hodnoty
group vektor stejné délky jako out, jehož prvky uváděj́ı, do které skupiny patř́ı

odlehlé hodnoty
names vektor názv̊u skupin

> load(file="dusicnany.dat") načteńı datového souboru (obsah dusičnan̊u ve
studničńı vodě, [8])
> boxplot(dusicnany)

> boxplot(dusicnany, range=0)

> boxplot(dusicnany, notch=TRUE, outline=FALSE)

> load(file="kyslik.dat") načteńı datového souboru (porovnáńı dvou me-
tod stanoveńı obsahu kysĺıku ve vodě [mg/l], [8])
> boxplot(kyslik, names=c("metoda A", "metoda B"), horizontal=TRUE,

+ las=1, xlab="obsah kysliku [mg/l]")
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Obr. 7.8. Obsah dusičnan̊u ve
studničńı vodě [mg/l]

Obr. 7.9. Porovnáńı dvou metod
stanoveńı obsahu kysĺıku ve vodě
[mg/l]

1Záměrně jsou uvedeny pojmy jako dolńı ”fous”, dolńı část krabice, horńı část krabice, horńı
”fous”, protože implicitńı nastaveńı (dolńı hradba, dolńı kvartil, horńı kvartil, horńı hradba) může
být uživatelem změněno pomoćı argument̊u range a pars na jiné hodnoty.
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> (boxplot(kyslik)) výstupńı hodnoty
$stats

[,1] [,2]

[1,] 6.4 6.5

[2,] 6.7 6.6

[3,] 6.9 6.9

[4,] 7.0 7.1

[5,] 7.3 7.4

$n

[1] 30 30

$conf
[,1] [,2]

[1,] 6.81346 6.755766

[2,] 6.98654 7.044234

$out

numeric(0)

$group

numeric(0)

$names

[1] "metodaA" "metodaB"

• stripchart() pro numerické vektory, seznamy a tabulky dat vykresluje diagram
rozptýleńı, použ́ıvá se pro jednoduché zobrazeńı dat

method zp̊usob zobrazeńı shodných dat, implicitńı nastaveńı method="overplot"
zp̊usobuje překrýváńı shodných dat, method="jitter" zobrazuje náhodně kolem osy
y a method="stack" skládá nad sebe

jitter v př́ıpadě volby method="jitter" můžeme argumentem jitter nastavit
š́ı̌rku vykreslováńı kolem osy y

offset v př́ıpadě volby method="stack" argument udává rozestup mezi jednot-
livými vykreslenými body

vertical pro hodnotu vertical=TRUE vykresluje vertikálně
group.names textový řetězec názv̊u skupin zobrazovaný po boćıch grafu (při vy-

kresleńı v́ıce graf̊u)
at numerický vektor udávaj́ıćı pozici pro vykresleńı bod̊u

87



KAPITOLA 7. GRAFIKA V R

> load(file="cekani.dat") načteńı datového souboru (doba čekáńı na zákazńıka
[min], [8])
> stripchart(cekani, method="overplot", main="method = ’overplot’",

+ cex=1)

> stripchart(cekani, method="jitter", main="method = ’jitter’", cex=1,

+ pch=1)

> stripchart(cekani, method="stack", main="method = ’stack’", cex=1.5,

+ pch=20, offset=0.4, at=0) argument cex udává velikost znak̊u, pch typ
znázorňovaných bod̊u, v́ıce viz odstavec 7.3
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Obr. 7.10. Doba čekáńı na zákazńıka [min]

• matplot() vykresleńı v́ıce datových řad do jednoho grafu. Vzhled grafu lze měnit
ńıže uvedenými argumenty, implicitńı vykresleńı je pomoćı č́ıslic
matplot(x) pro vstupńı matici x tvoř́ı každou datovou řadu jeden sloupec matice
matplot(x, y) pro dvě vstupńı matice stejných rozměr̊u udávaj́ı shodné pozice souřadnice
bod̊u, datové řady opět tvoř́ı sloupce matic. Lze vykreslit i pro vstupńı vektor x stejné
délky jako počet řádk̊u matice y

type, main, xlab, ylab, xlim, ylim

lty, lwd, pch, col, cex viz odstavec 7.3

> load(file="smes.dat") načteńı datového souboru (vliv krmné směsi na př́ır̊ustek
zv́ı̌rat, [8])
> matplot(smes, main="matplot(x)", ylab="prirustek [kg]", type=c("b",

+ "b"), lty=c(2,3), pch=c(15, 16), col=c(2,4))

> legend(7, 29, c("smes 1", "smes 2"), lty=c(2,3), pch=c(15, 16),

+ col=c(2,4)) funkce pro zobrazeńı legendy, v́ıce viz odstavec 7.2
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> time <- seq(from=1962, to=1978, length=17)

> load(file="chmel.dat") načteńı datového souboru (vývoz a sklizeň chmele
v ČSSR v letech 1962 až 1978, [8])
> matplot(time, chmel, main="matplot(x,y)", ylab="chmel [tis. tun]")

> legend(time[1], 12, c("vyvoz", "sklizen"), pch=c("1","2"), col=1:2)
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Obr. 7.11. Vliv krmné směsi na
př́ır̊ustek zv́ı̌rat [kg], [8]

Obr. 7.12. Vývoz a sklizeň chmele

v ČSSR v letech 1962 až 1978

• qqnorm(), qqline() grafy pro ověřováńı normality dat. qqnorm() vykresluje
normálńı kvantil-kvantilový graf (Q-Q plot), qqline() nav́ıc přidá do již existuj́ıćıho
grafu př́ımku odpov́ıdaj́ıćı normálńımu rozložeńı, jedná se o low-lewel funkci

> qqnorm(rnorm(70))

> qqnorm(rnorm(70))

> qqline(rnorm(70), col=gray(0.5)) funkce gray slouž́ı k vykresleńı r̊uzné
stupně šedi (v́ıce v odstavci 7.3)
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Obr. 7.13. Q-Q plot pro výběr z normálńıho rozložeńı

• curve() vykresĺı křivku
from, to interval pro vykresleńı funkce

> curve(sin(5*x), from=-30, to=30, main="curve()")
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Obr. 7.14. Funkce curve()
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• persp(x, y, z) slouž́ı k vykresleńı 3D grafu
xlim, ylim, zlim intervaly pro vykreslováńı hodnot na osách x, y a z
main, sub, col

theta úhel pro otočeńı grafu v horizontálńım smyslu
phi úhel pro otočeńı grafu ve vertikálńım smyslu
shade st́ınováńı
ticktype typ os, ticktype="simple" (implicitńı nastaveńı) vykresĺı pouze šipky

souběžné s osami grafu, šipky indikuj́ı směr nár̊ustu hodnot, ticktype="detailed"
zobrazuje i měř́ıtko os (počet značek na ose udává argument nticks)

border implicitńı nastaveńı NULL vykresluje křivky, barvu vykreslovaných křivek
můžeme měnit pomoćı argumentu col nebo funkce gray(), nastaveńı border=NA vy-
kresleńı křivek zabraňuje

> persp(x, y, z)

> persp(x, y, z, ticktype="detailed", nticks=5, phi=270, xlab="osa x",

+ ylab="osa y", zlab="osa z")

> persp(x, y, z, ticktype="detailed", nticks=5, phi=30, theta=55,

+ shade=0.5, xlab="osa x", ylab="osa y", zlab="osa z")

> persp(x, y, z, shade=0.5, phi=30, theta=55, border=NA, axes=F)
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Obr. 7.15. Funkce persp()
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• image() vytvoř́ı mř́ıžku s obdélńıky r̊uzného stupně šedi, slouž́ı k zobrazeńı 3-
dimenzionálńıch nebo prostorových dat

> x <- seq(-1.5*pi, 1.5*pi, length=50)

> y <- seq(-1.5*pi, 1.5*pi, length=50)

> z <- sin(x) %*% t(sin(y))

> image(x, y, z, col=gray(seq(from=0,to=1,length=80)), main="image()")
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Obr. 7.16. Funkce image()

Funkce contour() a filled.contour() slouž́ı k podobnému zobrazeńı jako funkce
image().

> contour(x, y, z, main="contour()")

> filled.contour(x, y, z, main="filled.contour()")
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Obr. 7.17. Funkce contour() Obr. 7.18. Funkce filled.contour()
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Velký výběr daľśıch 3D graf̊u nab́ıźı baĺıčky misc3d, scatterplot3d a lattice.

• symbols() na dané souřadnice vykresĺı symboly - kružnice, čtverce, trojúhelńıky,
hvězdičky, v́ıce informaćı v nápovědě: help(symbols)

7.2 Low-level funkce

Někdy se stává, že grafické funkce nevykresluj́ı přesný typ grafu, jaký bychom si přáli.
V těchto př́ıpadech je dobré použ́ıt tzv. low-level funkce. Pomoćı nich vytvář́ıme celý
graf po samostatných částech přidáńım daľśıch informaćı (body, čáry, text, . . . ) do již
existuj́ıćıho grafu.

Nejpouž́ıvaněǰśı funkce pro tvorbu low-level grafiky (pro význam argument̊u bg,
cex, col, lty, lwd a pch viz odstavec 7.3):
• points(x, y, type, pch, col, bg, cex, lwd, ...) dle nastaveńı argument̊u
vykresĺı body daných tvar̊u a barev na souřadnice x, y
• lines(x, y, type, lty, lwd, ...) vykresĺı lomenou čáru mezi body danými
souřadnicemi x a y

• segments(x0, y0, x1, y1, col, lty, lwd, ...) vykresĺı úsečky mezi dvěma
body o souřadnićıch [x0, y0], [x1, y1]
• abline(a, b, ...) vykresĺı př́ımku se směrnićı b a pr̊useč́ıkem s osou y a

• abline(h, ...) vykresĺı vodorovné úsečky přes celou š́ı̌rku grafu, h udává hodnoty
na ose y
• abline(v, ...) vykresĺı svislé úsečky, v udává hodnoty na ose x
• rect(xleft, ybottom, xright, ytop, col, ...) vykresĺı obdélńık, jehož vr-
choly jsou dány souřadnicemi xleft, ybottom, xright a ytop

• polygon(x, y, col, ...) vykresĺı mnohoúhelńık(y) s vrcholy danými body o sou-
řadnićıch x a y,
• arrows(x0, y0, x1, y1, length, angle, code, col, ...) vykresĺı šipky smě-
řuj́ıćı z bodu o souřadnićıch [x0, y0] do bodu o souřadnićıch [x1, y1], délku a úhel hlavy
šipky uvád́ı argumenty length a angle, styl vykresleńı šipky udává code (0 - bez šipky,
1 - šipka na začátku, 2 - šipka na konci, 3 - šipka na obou stranách)
• rug(x, ...) ”rohož”s rozestupem, slouž́ı k vykresleńı hustoty bod̊u
• legend(x, y, legend, ...) na souřadnice x a y vytiskne legendu (vektor tex-
tových řetězc̊u). Funkce má velké množstv́ı volitelných argument̊u (viz help(legend))
• title(main, sub, xlab, ylab, ...) vyṕı̌se název, podtitulek, popisky os
• grid(nx, ny) vykresĺı mř́ıžku, nx a ny udávaj́ı počet vertikálńıch a horizontálńıch
čar, implicitńı nastaveńı k vykreslováńı mř́ıžky (col="lightgray", lty="dotted",

lwd=par("lwd")) lze samozřejmě libovolně měnit
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• axis(side, at, labels, tick, lty, lwd, col, ...) vykresĺı osu, umožňuje
nastavit značky a popisky libovolně pro jednotlivé osy

side přirozené č́ıslo specifikuj́ıćı stranu grafu, na které má být osa vykres-
lena (1 - dole, 2 - vlevo, 3 - nahoře, 4 - vpravo)

at body, ve kterých maj́ı být vykreslovány značky pro měř́ıtko
labels názvy pro jednotlivé značky
tick logická hodnota pro vykreslováńı značek

• text(x, y, labels, ...) vyṕı̌se textový řetězec labels do grafu na pozici [x, y]
• mtext(text, side, ...) vyṕı̌se textový řetězec text na okraj grafu (side)

7.3 Funkce par()

Funkce par() slouž́ı k nastaveńı a změnám parametr̊u aktuálńıho grafu. Nastaveńı
parametr̊u pomoćı funkce par() měńı hodnoty parametr̊u nastálo – ve všech daľśıch
voláńıch libovolné grafické funkce až do doby zavřeńı grafického okna nebo nastaveńı pa-
rametr̊u na nové hodnoty. S otevřeńım nového grafického okna jsou všechna předchoźı
nastaveńı ignorována.

Text
adj zarovnáńı textu pro název grafu a popisky os, 0 - zarovnat vlevo, 1 - zarovnat

vpravo, 0.5 - zarovnat horizontálně na střed
ann implicitńı hodnota ann=TRUE vypisuje anotace (název a popisky os), hodnota

FALSE je potlačuje

cex relativńı velikost znak̊u (1 - normálńı velikost, 2 - dvojnásobná), cex.main

nastav́ı velikost znak̊u pro název grafu, cex.sub pro podtitulek, cex.axis,
cex.lab pro velikost ṕısma popisk̊u a názv̊u os

Barva
bg barva pozad́ı grafu
col barva bod̊u, obrys̊u bod̊u nebo spojnice. Barva může být vyjádřena přirozeným

č́ıslem nebo textovým řetězcem. Pro barvu os použijeme př́ıkaz col.axis,
pro popisky os col.lab, pro titulek a podtitulek grafu col.main a col.sub.
Základńı barvy jsou uvedeny v Tab. 7.1, podrobněǰśı seznam barev o 657
položkách dostaneme př́ıkazem colors(), funkćı gray() s argumenty od 0
do 1 źıskáme r̊uzné stupně šedi
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barva numerická hodnota textový řetězec

b́ılá 0 "white"

černá 1 "black"

červená 2 "red"

zelená 3 "green"

modrá 4 "blue"

modrozelená 5 "cyan"

fialová 6 "magenta"

žlutá 7 "yellow"

šedá 8 "gray"

Tab. 7.1. Barvy bod̊u

Graf
pty textový řetězec specifikuj́ıćı tvar grafické oblasti, "s" čtvercová, "m" ma-

ximálńı
mfcol 2-prvkový vektor tvaru c(pocet radku, pocet sloupcu) rozděluj́ıćı graf

na odpov́ıdaj́ıćı počet podgraf̊u, jednotlivé grafy jsou řazeny po sloupćıch
mfrow stejně jako mfcol, grafy jsou řazeny po řádćıch
new implicitńı nastaveńı FALSE, nastaveńı na hodnotu TRUE umožňuje přikresleńı

daľśıho grafu pomoćı high-level funkce do již existuj́ıćıho grafu

Osy
las numerická hodnota pro otočeńı popisk̊u os:

0 - x vodorovně, y svisle
1 - x i y vodorovně
2 - x svisle, y vodorovně
3 - x i y svisle

Body, čáry
lty numerická hodnota udávaj́ıćı typ čáry, jednotlivé typy s odpov́ıdaj́ıćı hodnotou

jsou uvedeny na Obr. 7.19
lwd numerická hodnota pro š́ı̌rku čáry, standardńı lwd=1
pch numerická hodnota pro znak vykreslovaných bod̊u, jednotlivé znaky s hodno-

tami 1 – 20 jsou uvedeny na Obr. 7.26. Pro hodnoty 21 – 25 jsou vykresleny
znaky s hodnotou 1, 0, 5, 2, 6 (v tomto pořad́ı) s volitelnou barvou výplně bg

a barvou hranice col. Hodnoty 26 – 31 nejsou definovány, hodnotám 32 – 255

odpov́ıdaj́ı znaky ASCII tabulky. Je možno použ́ıt i jakékoliv textové řetězce,
vypisuje se však vždy jen prvńı znak.
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'dotdash'

'longdash'
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Obr. 7.19. Typy čar (argument lty)

● ● ● ● ● ●

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20

Obr. 7.20. Typy bod̊u (argument pch)

7.4 Daľśı užitečné funkce

K otevřeńı daľśıho grafického okna slouž́ı př́ıkaz dev.new() nebo windows() (pouze
v systému Windows). Př́ıkaz dev.new() můžeme použ́ıt i s numerickým argumentem
which, prostřednictv́ım něhož lze př́ıkazy dev.set(which) a dev.off(which) dané
okno aktivovat, popř. zavř́ıt. Př́ıkaz graphics.off() zavře všechna grafická okna.
Ukládat grafy lze v menu File → Save as výběrem požadovaného formátu. Alternati-
vou je použ́ıt některého z př́ıkaz̊u:
pdf(file, width, height)

postscript(file, width, height)

png(file, width, height)

jpeg(file, width, height)

file textový řetězec pro název souboru
width š́ı̌rka grafu v palćıch
height výška grafu v palćıch
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> pdf(file="Nil.pdf")

> plot(Nile, main="Rocni prutoky reky Nil") vykresleńı objektu Nile (ve-
stavěná proměnná)
> dev.off()

null device

1

Př́ıkazem recordPlot() lze grafy ukládat i jako objekty. Zpětně lze takto uložený graf
zobrazit (a upravovat) př́ıkazem replayPlot() nebo zavoláńım názvu objektu.

> plot(Nile, main="Rocni prutoky reky Nil")

> Nil <- recordPlot() uložeńı grafu do proměnné Nil

> replayPlot(Nil) zobrazeńı grafu

Rocni prutoky reky Nil

Time

N
ile

1880 1900 1920 1940 1960

60
0

80
0

10
00

12
00

14
00

Obr. 7.21. Ročńı pr̊utoky řeky Nil

Funkce layout() umožňuje vytvářet složený graf obsahuj́ıćı několik graf̊u r̊uzných
rozměr̊u, přičemž mohou zab́ırat i v́ıce řádk̊u či sloupc̊u.

Jediným povinným argumentem funkce je matice, jej́ıž počet řádk̊u a sloupc̊u
a jejich č́ıselné hodnoty určuj́ı pořad́ı zaplňováńı jednotlivých ”box̊u”grafy. Př́ıkaz
layout(matrix(c(1, 0, 3, 2), 2, 2, byrow=TRUE)) vytvoř́ı graf se čtyřmi boxy,
přičemž pozice [1, 1] bude obsazena jako prvńı, dále budou obsazovány pozice [2, 2] a
[2, 1], pro nulovou hodnotu z̊ustává pozice prázdná (pozice [1, 2]).

Argumenty heights a widths jsou použ́ıvány ke specifikaci výšek a š́ı̌rek box̊u.
Šablonu s jednotlivými boxy si můžeme prohlédnout př́ıkazem layout.show(n) (Obr. 7.22),
kde n udává počet vykreslovaných graf̊u.
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> layout(matrix(c(1, 0, 3, 2), 2, byrow=T), widths=c(3, 1),

+ heights=c(1, 3))

> layout.show(3) (Obr. 7.22)
> load(file="pary.dat") načteńı datového souboru (závislost výšky 169
manželských pár̊u, [8]). Soubor obsahuje proměnnou pary typu seznam se složkami
muz, zena, muzhist a zenahist

> attach(pary)

> layout(matrix(c(1, 0, 3, 2), 2, byrow=T), widths=c(3, 1),

+ heights=c(1, 3))

> par(mar=c(0, 3.5, 1, 1)) funkce mar slouž́ı pro nastaveńı okraj̊u grafu
> barplot(muzhist, axes=F, space=0)

> par(mar=c(3.5, 0, 1, 1))

> barplot(zenahist, axes=F, space=0, horiz=T)

> par(mar=c(4.3, 4, 1, 1))

> plot(muz, zena, xlab="muz [mm]", ylab="zena [mm]")
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Obr. 7.22. Šablona s boxy Obr. 7.23. Závislost výšky 169 manželských
pár̊u
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Funkce split.screen() slouž́ı k děleńı grafického prostřed́ı na libovolný počet
část́ı. Např. př́ıkazem split.screen(c(2,2)) rozděĺıme prostřed́ı na čtyři části, na
něž můžeme odkazovat př́ıkazy screen(1), . . . , screen(4) a pomoćı těchto př́ıkaz̊u
dané podgrafy vytvářet nebo měnit. Každá část přitom může být znovu rozdělena po-
moćı funkce split.screen(c(,), screen).

Poznámka. Rozděleńı grafu na jednotlivé podgrafy můžeme dosáhnout i pomoćı argu-
ment̊u mfcol a mfrow funkce par() (viz odstavec 7.3).

MATLAB použ́ıvá k rozděleńı grafu na v́ıce část́ı funkci subplot.

> load(file="etnika.dat") načteńı datového souboru (počet souhlasných reakćı
na deset otázek zástupc̊um čtyř etnik, [8])
> popisx <- rownames(etnika)

> split.screen(c(1,3)) vytvoř́ı prázdné grafické okno, nav́ıc je výstupem i vektor
hodnot odkazuj́ıćı na jednotlivé podgrafy, šablona okna s boxy viz Obr. 7.24
[1] 1 2 3

screen 1 screen 2 screen 3

Obr. 7.24. Šablona okna s boxy pro př́ıkaz split.screen(c(1,3))

> screen(1) aktivace levého boxu pro vykresleńı podgrafu
> barplot(etnika[,1], main="etnikum 1", names.arg=popisx, las=3)

> screen(2)

> barplot(etnika[,2], main="etnikum 2", names.arg=popisx, las=3)

> split.screen(c(2,1), screen=3) rozděleńı pravého boxu na 2 daľśı boxy,
aktuálńı šablona s boxy viz Obr. 7.25
[1] 4 5
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screen 1 screen 2

screen 4

screen 5

Obr. 7.25. Šablona okna s boxy pro př́ıkaz split.screen(c(2,1), screen=3)

> screen(4)

> barplot(etnika[,3], main="etnikum 3", names.arg=popisx, las=3)

> screen(5)

> barplot(etnika[,4], main="etnikum 4", names.arg=popisx, las=3)
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Obr. 7.26. Počet souhlasných reakćı na deset otázek zástupc̊um čtyř etnik.

Interaktivńı funkce locator() umožňuje vybrat pozici pro umı́stěńı grafických
prvk̊u (např. legendy, popisk̊u os, . . . ). Funkce locator() čeká, než uživatel zvoĺı levým
tlač́ıtkem myši mı́sto, následně vyṕı̌se jeho souřadnice. Argument n udává počet bod̊u,
u kterých chceme t́ımto zp̊usobem zjistit souřadnice.
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Př́ıklady k procvičeńı

1. Do jednoho grafu zakreslete na intervalu [0, 3π] graf funkćı sinx (červeně) a cos x
(modře). Graf vhodně otitulkujte a pomoćı funkce locator() obě funkce popǐste.

2. Vestavěná proměnná InsectSprays popisuje účinnost sprej̊u proti hmyzu a za-
hrnuje dvě složky – count a spray. Vykreslete histogram absolutńıch četnost́ı
pro počet jedinc̊u hmyzu daného pozorováńı (složka count).

3. Pro stejnou proměnnou jako v úkolu 2 vykreslete boxplot. Dále zjistěte, zda se
data ř́ıd́ı normálńım rozložeńım. Svou odpověd’ podložte vhodným grafem.

4. Do dvou graf̊u vedle sebe zobrazte graf funkce sin(x) cos(x+y) pro x, y z intervalu
[0, 5]. Do levého grafu zobrazte prostorový graf, do pravého pouze jeho vrstevnice.
Grafy popǐste.

5. Načtěte soubor vyskomer.dat, ve kterém je uloženo 15 kontrolńıch měřeńı dvěma
r̊uznými výškoměry. Do jednoho grafu zakreslete pr̊uběh měřeńı pro oba výškoměry
následovně:

• pr̊uběh pro vyskomer1 modrými čtverečky,

• pr̊uběh pro vyskomer2 zelenými hvězdičkami,

• graf opatřete názvem, popisky os a legendou.

Graf uložte do souboru ”vyskomer.pdf”.

Řešeńı.

1. x <- seq(from=0, to=3*pi, length=100), y <- matrix(c(sin(x),cos(x)),

ncol=2)

matplot(x, y, col=c(2,4), type="l", main="Grafy funkci sin(x) a

cos(x)", xlab="osa x", ylab="osa y") nebo
plot(x, sin(x), col=2, type="l", main="Grafy funkci sin(x) a

cos(x)", xlab="osa x", ylab="osa y"), points(x, cos(x), col=4,

type="l") nebo
plot(x, sin(x), col=2, type="l", main="Grafy funkci sin(x) a

cos(x)", xlab="osa x", ylab="osa y"), lines(x, cos(x), col=4,

type="l")

souradnice <- locator(2)

text(souradnice, labels=c("sin(x)", "cos(x)"))

2. hist(InsectSprays$count)
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3. boxplot(InsectSprays$count)

qqnorm(InsectSprays$count), qqline(InsectSprays$count)

4. x <- seq(from=0, to=5, length=100), y <- x,
z <- sin(x) %*% t(cos(x+y))

layout(matrix(1:2, nrow=1))

persp(x, y, z, main="Funkce ’persp’")

contour(x, y, z, main="Graf ’countour’") nebo
split.screen(c(1,2))

screen(1), persp(x, y, z, main="Funkce ’persp’")

screen(2), contour(x, y, z, main="Graf ’countour’")

5. load(file="vyskomer.dat")

pdf(file="vyskomer.pdf")

matplot(1:15, vyskomer, col=c("blue", "green"), lty=c(1,2),

pch=c(15, 8))

legend(11, 34, c("vyskomer1", "vyskomer2"), col=c("blue","green"),

pch=c(15, 8))

dev.off()
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Kapitola 8

Programováńı v R

Základńı informace

Jazyk R je snadno rozšǐritelný o vlastńı funkce či dávkové soubory. Pro zvládnut́ı tvorby
vlastńıch funkćı je třeba porozumět rozd́ıl̊um mezi lokálńımi a globálńımi proměnnými
a ovládat podmı́něné př́ıkazy a př́ıkazy cykl̊u. Použit́ı těchto př́ıkaz̊u může ovšem být
u některých datových struktur zdlouhavé či výpočetně neefektivńı, těmo situaćım je
věnována posledńı část kapitoly popisuj́ıćı skupiny funkćı apply.

Výstupy z výuky

Studenti

• dokáž́ı vysvětlit rozd́ıl mezi funkcemi a dávkovými soubory,

• rozlǐsuj́ı lokálńı a globálńı proměnné,

• ovládaj́ı r̊uzné podmı́něné př́ıkazy,

• umı́ použ́ıt př́ıkazy cykl̊u,

• jsou schopni vhodně aplikovat funkci apply.

8.1 Funkce a dávkové soubory

Programy v jazyce R, které si uživatel může sám vytvořit, lze rozdělit do dvou skupin
- dávkové soubory a funkce. V následuj́ıćıch odstavćıch si uvedeme hlavńı rozd́ıly mezi
nimi a zp̊usoby, jak lze tyto programy vytvořit.
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Hlavńım rozd́ılem funkćı a dávkových soubor̊u je ten, že objekty definované uv-
nitř funkce nejsou k dispozici v pracovńım prostoru. U dávkových soubor̊u nezálež́ı
na tom, z jakého adresáře jsou volány, objekty definované uvnitř dávky jsou v pra-
covńım prostoru stále k dispozici. Daľśım rozd́ılem je ten, že funkce pracuj́ı se vstupńımi
proměnnými, dávkové soubory nikoliv.

Funkce
Každá funkce v R, at’ vestavěná nebo definovaná uživatelem, je tvaru

nazev <- function(argumenty){telo},

kde nazev udává název funkce, argumenty je čárkami oddělená posloupnost vstupńıch
argument̊u a telo obsahuje posloupnost př́ıkaz̊u, které muśı být uzavřeny ve složených
závorkách { } (pouze v př́ıpadě jediného př́ıkazu mohou být složené závorky vy-
nechány).

Funkce lze vytvářet př́ımo v př́ıkazové řádce, při tvorbě složitěǰśıch zdrojových kód̊u
je vhodněǰśı mı́sto př́ıkazové řádky použ́ıvat editory. Jazyk R má k dispozici zabudo-
vaný vlastńı editor, který najdeme v menu File→ New script. Možné je rovněž použ́ıvat
editory jako PSPad nebo WinEdt s č́ıslovanými řádky, kontrolou syntaxe apod. Takto
vytvořené funkce ukládáme do souboru s koncovkou .R.

V př́ıpadě, že je funkce vytvořena př́ımo v př́ıkazové řádce, spoušt́ı se zavoláńım
svého názvu nazev s argumenty uvedenými v kulatých závorkách. V př́ıpadě, že je
vytvořena v textovém editoru, je třeba nejdř́ıve funkćı source() nač́ıst soubor, ve
kterém je uložena. Argumentem funkce source() je textový řetězec obsahuj́ıćı celý
název souboru (i s koncovkou .R) nebo cestu k němu. Následně se spoušt́ı zavoláńım
názvu funkce nazev s argumenty uvedenými v kulatých závorkách.

Při voláńı funkce bez názv̊u argument̊u muśı být jednotlivé argumenty uvedeny
přesně v tom pořad́ı, v jakém byly definovány. V opačném př́ıpadě můžeme použ́ıt
přǐrazeńı nazev argumentu=hodnota, popř. názvy argument̊u můžeme zkracovat, jestliže
zkratka nemůže znamenat žádný jiný argument. Hodnoty argument̊u mohou mı́t defi-
novány své implicitńı hodnoty – ty lze př́ıkazem nazev argumentu=implicitni hodnota

nastavit v seznamu argument̊u při definováńı funkce. Při voláńı funkce pak tyto argu-
menty mohou být vynechány a bude jim přidělena hodnota implicitni hodnota.

Výstupńı hodnoty źıskáme pomoćı funkce return(), pouze k výpisu hodnot se
použ́ıvá funkce print(). V př́ıpadě jediného výstupńıho objektu je tento objekt uváděn
do argumentu funkce return(), v př́ıpadě v́ıce výstupńıch objekt̊u muśı být seskupeny
do seznamu.

Jazyk R rovněž umožňuje definováńı nových binárńıch operátor̊u (např. %in%).
K odlǐseńı od funkćı muśı být jejich název ve tvaru "%nazev%".
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> kvadr <- function(a, b, c){
+ obsah <- 2*(a*b + b*c + c*a)

+ objem <- a*b*c

+ return(list(obsah=obsah, objem=objem))}
> vystup <- kvadr(1, 2, 3)

> vystup

$obsah

[1] 22

$objem

[1] 6

Dávkové soubory
Jedná se o posloupnost př́ıkaz̊u, která může využ́ıvat již definovaných objekt̊u z pra-
covńıho prostoru. Zpravidla se vytvář́ı v libovolném textovém editoru, název souboru
muśı mı́t př́ıponu .R (např. davka.R). Dávkové soubory se spoušt́ı funkćı source

s názvem dávkového souboru (nebo cestou k němu) uvedeným jako textový řetězec
(např. source("davka.R")).

> a <- 1; b <- 2; c <- 3

> source("kvadr.R") spuštěńı dávky kvadr.R

> obsah

[1] 2

> objem

[1] 6

Násilné ukončeńı běž́ıćı dávky nebo funkce se provád́ı př́ıkazem Q.
V pr̊uběhu funkce nebo dávky se občas může stát, že se potřebujeme dostat zpět do

pracovńıho prostoru, např. vypracováńı zadaných úkol̊u (viz cvičeńı) a následně dále
pokračovat v běhu funkce či dávky. To lze př́ıkazem browser(), k odlǐseńı funkce či
dávky a prostřed́ı pracovńıho prostoru se prompt změńı na Browse[1]>. Od této chv́ıle
se nacháźıme v pracovńım prostoru, kde můžeme zadávat libovolné př́ıkazy. Zpět se do-
staneme př́ıkazem c nebo klávesou ENTER.

MATLAB mı́sto př́ıkazu browser() použ́ıvá keyboard, objevuje se prompt
K>> a k návratu zpět do dávkového souboru použ́ıvá př́ıkaz return.

8.2 Lokálńı a globálńı proměnné

V jazyce R neńı nezbytně nutné deklarovat proměnné uvnitř funkce. Při vyhodnocováńı
funkce R použ́ıvá pravidlo lexical scoping, které rozhodne, zda je objekt lokálńı nebo
globálńı proměnnou.
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> funkce1 <- function(){print(x)}
> x <- 3

> funkce1() Objekt x neńı definován uvnitř funkce funkce1(), proto R hledá
v uzavřeném1 prostřed́ı objekt s názvem x a vytiskne jeho hodnotu. V př́ıpadě, že
by objekt x nebyl nalezen ani v globálńım prostřed́ı, zobrazilo by se chybové hlášeńı
Error in print(x) : object ’x’ not found a vyhodnocováńı funkce by t́ımto bylo
u konce.
[1] 3

MATLAB by v př́ıpadě, kdy objekt x neńı definován uvnitř funkce funkce1(),
dával chybové hlášeńı, protože proměnná x je považována za lokálńı
v prostřed́ı, ve kterém byla definována (v tomto př́ıpadě ve workspace).

> funkce2 <- function(){x <- 1; print(x)}
> x <- 3

> funkce2()

[1] 1

> x Jestliže je x použito jako název objektu uvnitř funkce, hodnota x v globálńım
prostřed́ı nebude změněna.
[1] 3

Chceme-li mı́t k dispozici i v globálńım prostřed́ı přǐrazeńı provedená uvnitř funkce,
muśıme použ́ıt operátoru <<- nebo funkce assign s argumentem envir=.GlobalEnv.

> funkce3 <- function(){x <- 2; print(x)}
> x přesvědč́ıme se, že objekt x neńı definován
Error: object ’x’ not found

> funkce3()

[1] 2

> x objekt x opravdu neńı v globálńım prostřed́ı definován, je definován pouze
v prostřed́ı funkce funkce3

Error: object ’x’ not found

Rozd́ıl při použit́ı operátoru pro globálńı přǐrazeńı:

> funkce4 <- function(){assign("x", 2, envir=.GlobalEnv); print(x)}
> x

Error: object ’x’ not found

> funkce4()

[1] 2

> x

[1] 2
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8.3 Podmı́něné př́ıkazy

Do této chv́ıle jsme sestavovali programy, které vyhodnocovaly pouze jednoduché př́ıkazy
nebo jejich posloupnosti uzavřené ve složených závorkách. Často ovšem potřebujeme
provést sérii př́ıkaz̊u až na základě výsledku nějaké podmı́nky/nějakých podmı́nek.

if (podminka) {prikaz}
provede prikaz v př́ıpadě, že podminka je vyhodnocena jako TRUE. V př́ıpadě vyhod-
noceńı podmı́nky jako FALSE se žádné př́ıkazy neprovedou.

> x <- 5

> if (x > 3) {"Podminka splnena."}
[1] "Podminka splnena."

if (podminka) {prikaz1}
else {prikaz2}
V př́ıpadě vyhodnoceńı podmı́nky podminka jako TRUE je proveden prikaz1, v opačném
př́ıpadě je proveden prikaz2.

> if (x > 3) {"Podminka splnena."}
+ else {"Podminka nesplnena."}
[1] "Podminka splnena."

Podmı́nka vraćı bud’ hodnotu TRUE nebo FALSE. Jestliže podmı́nka vraćı logický vektor
o v́ıce než jednom prvku, jako výsledek vyhodnoceńı podmı́nky je ovšem brán pouze
jeho prvńı prvek. Součást́ı výstupu je i hlášeńı:

> x <- c(-2, 0, 3, 1)

> if (x > 0) {"vetsi nez 0"}
+ else {"mensi nebo rovno 0"}
[1] "mensi nebo rovno 0"

Warning message:

In if (x > 0) { :

the condition has length > 1 and only the first element will be used

MATLAB by v tomto př́ıpadě vyhodnotil podmı́nku vracej́ıćı vektor o hod-
notách TRUE jako TRUE, v př́ıpadě jediné hodnoty FALSE jako FALSE.

Alternativou k př́ıkazu if - else může být př́ıkaz
ifelse(podminka, prikaz1, prikaz2),
která v př́ıpadě podmı́nky vyhodnocené jako TRUE provede př́ıkaz prikaz1, v opačném
př́ıpadě provede prikaz2.
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Obr. 8.1. Diagram vysvětluj́ıćı př́ıkaz if - else if - else

> ifelse(x > 3, "Podminka splnena.", "Podminka nesplnena.")

[1] "Podminka splnena."

if (podminka1) {prikaz1}
else if (podminka2) {prikaz2}
else if (podminka3) {prikaz3}
else {prikaz4}
Vysvětleńı těchto podmı́něných př́ıkaz̊u je zachyceno na Obr. 8.1.

> x <- 3

> if (x == 1) {"cervena - stat!"}
+ else if (x == 2) {"oranzova - pripravit se"}
+ else if (x == 3) {"zelena - muzeme jet"}
+ else {"zadna jina barva na semaforu neexistuje"}
[1] "zelena - muzeme jet"

Př́ıkaz
switch(vyraz, prikazy, prikazy jine)

slouž́ı také k větveńı programu. Jestliže vyraz je celé č́ıslo, na výstupu je vrácena hod-
nota odpov́ıdaj́ıćıho prvku prikazy. Pokud nedojde ke spojeńı hodnoty vyraz s prvkem
prikazy, funkce vraćı hodnotu NULL.
Pro textový řetězec muśı být název vyraz použit ke spojeńı s př́ıslušným prvkem
posloupnosti prikazy. Pokud nedojde ke spojeńı s některým z prvk̊u posloupnosti
prikazy, můžeme definovat prikazy jine, které budou v tomto př́ıpadě provedeny.
prikazy jine můžeme definovat pouze pro vyraz typu textový řetězec.
Syntaxe př́ıkazu bude názorněǰśı z následuj́ıćıch př́ıklad̊u:
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> switch(2, "vyborne", "velmi dobre", "dobre", "uspokojive",

+ "dostatecne", "nedostatecne")

[1] "velmi dobre"

> switch(7, "vyborne", "velmi dobre", "dobre", "uspokojive",

+ "dostatecne", "nedostatecne")

[1] NULL

> switch("vyborne", vyborne="znamka A", velmi dobre="znamka

+ B", dobre="znamka C", uspokojive="znamka D", dostatecne="znamka E",

+ neuspokojive="znamka F", "znamka neexistuje")

[1] "znamka A"

> switch("chvalitebne", vyborne="znamka A",

+ velmi dobre="znamka B", dobre="znamka C", uspokojive="znamka D",

+ dostatecne="znamka E", neuspokojive="znamka F", "znamka neexistuje")

[1] "znamka neexistuje"

8.4 Př́ıkazy cykl̊u

Někdy potřebujeme opakovaně vyhodnocovat př́ıkaz nebo skupinu př́ıkaz̊u. Je třeba si
dát pozor na správnou definici konce cyklu, v opačném př́ıpadě může doj́ıt k zacykleńı.
Mezi nejznáměǰśı př́ıkazy cykl̊u patř́ı funkce for, while a repeat.

for (promenna in vyraz) {prikaz}
Provede sérii př́ıkaz̊u prikaz, promenna označuje indexačńı proměnnou, vyraz může
být vektor nebo seznam, pro jehož každou složku je prikaz vyhodnocen. Cyklus for

je vhodné použ́ıvat tehdy, když předem v́ıme, kolik opakováńı chceme provést.

> for (i in 1:5) {cat("pruchod cyklem", i, "\n")}2 funkce cat() zřetěźı a
vytiskne své argumenty
pruchod cyklem 1

pruchod cyklem 2

pruchod cyklem 3

pruchod cyklem 4

pruchod cyklem 5

Někdy ovšem předem nev́ıme, kolikrát bude třeba cyklus opakovat, a počet opakováńı
záviśı na splněńı určité podmı́nky. V těchto př́ıpadech použijeme cyklus while:
while (podminka) {prikaz}
Stejně jako u výrazu if, podminka je výraz, který po vyhodnoceńı vraćı logickou hod-
notu TRUE nebo FALSE. V př́ıpadě splněńı podmı́nky podminka cyklus provede prikaz.
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> i <- 1

> while (i %in% c(1:5)) {print(i); i <- i + 1}
[1] 1

[1] 2

[1] 3

[1] 4

[1] 5

Cyklus repeat opakuje vyhodnocováńı př́ıkaz̊u prikaz do té doby, dokud nedosáhne
konce. Pro ukončeńı se použ́ıvá př́ıkaz break, který je součást́ı posloupnosti př́ıkaz̊u
prikaz. Syntaxe vypadá následovně:
repeat {prikaz}
Poznámka. Př́ıkaz break lze použ́ıt i pro ukončeńı cykl̊u for a while.

> i <- 0

> repeat{
+ print(i)

+ i <- i + 1

+ if (i == 5) {break}}
[1] 0

[1] 1

[1] 2

[1] 3

[1] 4

8.5 Skupiny funkćı apply()

Do této skupiny patř́ı funkce apply(), lapply(), sapply() a tapply(). Společnou
vlastnost́ı všech těchto funkćı je schopnost aplikovat funkci na vybrané části struktury
bez použit́ı cyklu, což má výhody v přehlednosti i rychlosti výpočtu.

Funkce apply() se použ́ıvá pro vektory, matice a pole. Funkce požaduje tři argu-
menty: název pole a jeho dimenze, na kterých má být provedena požadovaná operace.
Jej́ı název je třet́ım argumentem funkce. Jestliže u matic druhý argument nabývá hod-
noty 1, operace se provád́ı po řádćıch, v př́ıpadě hodnoty 2 po sloupćıch, u poĺı vyšš́ı
hodnoty odkazuj́ı na daľśı dimenze.
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> ar <- array(1:8, c(2,2,2))

, , 1

[,1] [,2]

[1,] 1 3

[2,] 2 4

, , 2

[,1] [,2]

[1,] 5 7

[2,] 6 8
> apply(ar, 1, sum)

[1] 16 20

> apply(ar, 2, sum)

[1] 14 22

> apply(ar, 3, sum)

[1] 10 26

Obě funkce lapply() i sapply() provád́ı výpočet určité funkce v jednotlivých
složkách seznamu jako prvńıho argumentu. Druhým argumentem je název funkce, která
má být provedena. Tyto př́ıkazy se lǐśı pouze výstupem - zat́ımco lapply() vraćı se-
znam o stejném počtu složek jako vstupńı seznam, funkce sapply() se snaž́ı výsledek
zjednodušit do vektoru nebo matice.

> (l <- list(1:5, 5:14))

[[1]]

[1] 1 2 3 4 5

[[2]]

[1] 5 6 7 8 9 10 11 12 13 14

> lapply(l, range)

[[1]]

[1] 1 5

[[2]]

[1] 5 14

> sapply(l, range)
[,1] [,2]

[1,] 1 5

[2,] 5 14
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Funkce tapply() aplikuje požadovanou funkci na roztř́ıděná data v tabulce dat.
Argument INDEX specifikuje seznam položek pro roztř́ıděńı.

> (tabulka <- data.frame(id=c(1:6), skupina=c(1, 2, 2, 1, 2, 1),

+ hodnota=runif(6, 2, 4)))
id skupina hodnota

1 1 1 3.238305

2 2 2 2.502754

3 3 2 3.939131

4 4 1 3.524773

5 5 2 3.731300

6 6 1 3.836787
> tapply(tabulka$hodnota, INDEX=tabulka$skupina, mean)

1 2

3.533288 3.391061

Př́ıklady k procvičeńı

1. Vytvořte dávku odd.R, uvnitř ńı definujte vektor v s hodnotami 1, 3, 4, 5, 6, 7,
10 a výstupńı proměnnou pocet, která vrát́ı počet lichých č́ısel vektoru v.

2. Vytvořte funkci oddf.R, která pro libovolný vstupńı vektor či vrát́ı počet lichých
č́ısel. Zkontrolujte, zda vstupńı objekt obsahuje pouze numerické hodnoty a zda
jsou všechny tyto hodnoty celá č́ısla.

3. Vytvořte funkci mattovec.R, která pro vstupńı matici vyṕı̌se vektor jej́ıch po
sloupćıch seřazených prvk̊u. Zajistěte, aby pro diagonálńı matice byla vypisována
pouze diagonála a pro dolńı/horńı trojúhelńıkové matice pouze dolńı/horńı část.

4. Vytvořte funkci product.R, která pro dvě vstupńı celoč́ıselné hodnoty n a k vrát́ı
jejich součin, aniž by byla použita operace násobeńı. Povolena je pouze operace
sč́ıtáńı.

5. Pro usnadněńı práce rybář̊um vytvořte funkci ryby.R, která pro vstupńı vektor
představuj́ıćı hmotnosti postupně vylovených ryb rybáře upozorńı, kdy je třeba
dávat daľśı ryby do nové kádě. Nosnost každé kádě je 20 kg. Kolik kád́ı budou
rybáři pro sv̊uj úlovek potřebovat (výstupńı proměnná kad)? Ošetřete, aby váhy
vylovených ryb byla pouze kladná reálná č́ısla.
Funkci vyzkoušejte na náhodně vygenerovaném vektoru hmotnost́ı 25 ryb s hmot-
nostmi mezi 1–5 kg, hmotnosti zaokrouhlete na jedno desetinné mı́sto.

6. Soubor les.dat obsahuje informace o š́ı̌rce kmene 45 stromů ve dvou lokalitách
lesa. Použijte vhodné př́ıkazy pro zjǐstěńı pr̊uměrné, minimálńı a maximálńı š́ı̌rky
kmene pro každou z lokalit.
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Řešeńı.

1. v <- c(1, 3, 4, 5, 6, 7, 10)

sude <- v %% 2

pocet <- sum(sude)

cat(’Pocet lichych cisel: ’, pocet, ’\n’)
. . . dávku uložit s názvem odd.R, nač́ıtáńı a spouštěńı: source("odd.R")

2. oddf <- function(x){

if (is.numeric(x) & is.real(x)){
pocet <- sum(x %% 2)

}

return(pocet)

} . . . funkci uložit s názvem oddf.R,
nač́ıtáńı funkce: source("odd.R"),
spouštěńı funkce: pocet <- oddf(v)

3. mattovec <- function(A){

if (sum(A - diag(diag(A))) == 0){
vec <- diag(A)

}
else if (sum(A[!lower.tri(A, diag=T)]) == 0){
vec <- A[lower.tri(A, diag=T)]

}
else if (sum(A[!upper.tri(A, diag=T)]) == 0){
vec <- A[upper.tri(A, diag=T)]

}
else vec <- as.vector(A)

return(vec)

}
source("mattovec.R"), vec <- mattovec(matrix(1:4, 2))

4. product <- function(n, k){

if (round(n)-n != 0 | round(k)-k != 0){
stop(’Nejde o celociselne hodnoty!’)

}
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else if (n==0 | k==0){
soucin <- 0

}
else {soucin <- 0

for (i in 1:k){
soucin <- soucin + n

}}

return(soucin)

}
source("product.R"), soucin <- product(2, 3)

5. ryby <- function(x){

kad <- 0

if (all(is.real(x) & x>0)){
while (sum(x) >= 50){

index <- max(which(cumsum(x) <= 20))

x <- x[index:length(x)]

kad <- kad + 1

}
}
else stop("Nejedna se o vektor kladnych realnych cisel!")

return(kad)

}
source("ryby.R")

r <- round(runif(min=1, max=5, n=25), digits=1)

kad <- ryby(r)

6. load("les.dat")

tapply(les$sirka, INDEX=les$lokalita, mean)

tapply(les$sirka, INDEX=les$lokalita, min)

tapply(les$sirka, INDEX=les$lokalita, max)
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SEZNAM POUŽITÉ LITERATURY 115
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Dostupné z WWW: <http://www.karlin.mff.cuni.cz/~kulich/vyuka/Rdoc/
rdebuts_en.pdf>

<http://www.karlin.mff.cuni.cz/~komarek/Rko/Rmanual2.pdf>
<http://www.karlin.mff.cuni.cz/~komarek/Rko/Rmanual2.pdf>
<http://osiris.sunderland.ac.uk/~cs0her/Statistics/Crawley/R2Calculations.pdf>
<http://osiris.sunderland.ac.uk/~cs0her/Statistics/Crawley/R2Calculations.pdf>
<http://cran.r-project.org/doc/contrib/CviceniR1.pdf>
<http://mathesaurus.sourceforge.net/octave-r.html>
<http://www.math.umaine.edu/~hiebeler/comp/matlabR.pdf>
<http://www.math.muni.cz/~kolacek/vyuka/vypsyst/navod.pdf>
<http://www.math.muni.cz/~kolacek/vyuka/vypsyst/navod.pdf>
<http://www.karlin.mff.cuni.cz/~kulich/vyuka/Rdoc/rdebuts_en.pdf>
<http://www.karlin.mff.cuni.cz/~kulich/vyuka/Rdoc/rdebuts_en.pdf>
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z WWW: <http://cran.r-project.org/doc/manuals/R-intro.pdf>

[18] VENABLES, W. N., RIPLEY, B. D. Modern Applied Statistics with S-Plus. 2.
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